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Managing Your Projects (Project Management)
 Chapter

Introduction

Project Management enables organizations to streamline and standardize the 
management of project activities using a template-based, collaborative 
approach. Projects and initiatives are defined as a hierarchical structure of 
projects and subprojects that logically group and organize tasks or activities. 
Project Management defines the step-by-step processes required to complete 
specific project tasks and deliverables. Organizations can easily manage 
project activities within and across the technology chain because all project 
team members, whether internal or external, collaborate and interact through 
an intuitive interface. The underlying product framework guides users through 
a dynamic, self-documenting process to support activities such as the 
execution of standardized checklists or the collection of deliverables using 
document attachments.

For example, when creating a new and updated version of a business system, a 
company would classify its efforts into subprojects for each major functional 
area. Each of these functional subprojects could be further broken down into 
tasks directed to areas such as web content, application and database tasks. 
These tasks would be linked to Requests and Packages from Demand 
Management and Change Management, giving instant visibility to more 
detailed activities supporting an overall project. Project Management also 
supports standard integration with Microsoft Project so that functions such as 
task scheduling and resource management can be utilized at any point during a 
project.

About This Document
This guide describes how to navigate and use Project Management. Each 
chapter covers a specific topic on navigation or usage:
Introduction 1
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Key Concepts and 
Definitions

Provides key concepts and definitions used when 
creating, managing, and participating in Projects.

Setting Up Resources Discusses the Resource Management functionality 
provided by Project Management.

Setting Up a Project Describes how to create a Project and set up its Tasks, 
scheduling, and baselines.

Configuring Tasks Explains how to configure Tasks within a Project, 
including assigning Resources, setting up Notifications, 
and creating Milestones.

Managing a Project Discusses how to manage a Project from creation to 
completion, including viewing Task progress, updating 
the schedule, and printing the Gantt chart.

Updating Tasks: 
Project Participant 
Activities

Describes how participants in Projects can locate and 
update Tasks, including viewing and updating Notes 
and References.

Using Project 
Templates

Discusses the creation and use of Project Templates to 
speed Project creation.

Creating and Using 
Project Budgets

Explains how to create, modify, and compare Budgets 
for use in Project Management.

Project Costs Describes how to use Project Management’s Financial 
Management capabilities to track Project costs.

Project Management 
Reports

Provides information and instructions on running 
Project Management Reports.

Integrating Project 
Management with 
Microsoft Project

Discusses how to use Project Management in 
conjunction with Microsoft Project to various degrees, 
depending on the level of integration desired.

Integrating Requests 
and Projects

Explains how to use Project Management in 
conjunction with Demand Management to leverage the 
capabilities of both systems.
2 Introduction
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Intended Audience
The intended audience for this document include:

• Users of Project Management 

• Managers who create and manage Projects and Tasks 

• Managers who create and manage Calendars

• Business users responsible for reporting on Projects and Tasks 

Document Conventions
Table 1-1 lists the types of conventions used in this document.

Table 1-1. Document conventions

Convention Description Example

Button, menu, tabs Names of interface components that can be 
clicked (such as buttons, menus, and tabs) 
are shown in bold.

Apply button

Fields, Windows, Pages Names of windows, fields, and pages are 
shown as displayed.

New Request window

Code Code input and output are shown as 
displayed.

CauchoConfigFile 
C:/ITG_Home/conf/
resin.conf

Link Linked URLs, filenames, and cross references 
are shown as blue italicized text.

www.mercury.com

Variable Variables are shown as italicized text. ITG_Home/bin directory

Note Used to identify note boxes that contain 
additional information.

Caution Used to identify caution boxes that contain 
important information. Follow the instructions 
in all caution boxes, failure to do so can result 
in loss of data.
Introduction 3
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Additional Resources
Mercury Interactive provides the following additional resources to help you 
successfully use Mercury ITG Center:

• Related Documentation

• Customer Support

• Education Services

Related Documentation
The Library includes additional documents related to the topics discussed in 
this guide. Access the Library through the Mercury ITG Center online help.

Example Used to identify example boxes that contain 
examples of related procedure.

Table 1-1. Document conventions

Convention Description Example

Using the Dashboard This document provides details for defining 
and configuring the Dashboard and custom 
Portlets.

Processing Requests (Demand 
Management)

This document explains how to process 
Requests using Demand Management.

Processing Packages (Change 
Management)

This document explains how to process 
Packages using Change Management.

Using the Workbench This document explains how to navigate 
through the Workbench interface.

Security Model Guide and 
Reference

This document presents an overview of the 
data security model and provides instructions 
for controlling access to different entities.
4 Introduction
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Customer Support
Customer support and downloads for Mercury ITG Center and additional 
product information can be accessed from the Mercury Interactive Support 
Web site at http://support.mercuryinteractive.com.

Education Services
Mercury Interactive provides a complete training curriculum to help you 
achieve optimal results using Mercury IT Governance Center. For more 
information, visit the Education Services Web site at http://www.merc-
training.com/main/ITG.

Managing Your Resources 
(Resource Management)

This document provides instructions for 
managing your Resources. This includes 
modeling your Organizations, setting up 
Resource Categories and Calendars, creating 
Staffing Profiles and Resource Pools, and 
visualizing Resource load and capacity across 
the system.

Configuring Time 
Management

This document provides administrative 
information and processes for Time 
Management.

Tracking Your Time (Time 
Management)

This document provides instructions for using 
Time Management.
Introduction 5
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 Chaptery

Key Concepts and Definitions

This chapter defines the common concepts and terms used in Project 
Management. An understanding of these concepts and terms is necessary when 
using Project Management.

The following topics are covered:

• Projects

• Project Templates

• Project Team

• Resources

• Tasks

• Master Projects

• Subprojects

• Gantt Charts

• Milestones

• Critical Path

• Action Items

• Project States

• Exceptions

• Summary Conditions

• Notifications

• Scheduling Engine and Calendar

• Baseline
Key Concepts and Definitions 7
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• Financial Management

• Budget

• Requests

• Packages

• References

• Mercury ITG Dashboard (Project Management)

Projects
A Mercury ITG Project is a compilation of information -- Tasks, Action Items, 
Notes, Packages, Requests, and References -- which is used to define and 
process a specific business initiative within your company. Projects are active 
entities, gathering additional information as the Project moves through its life. 
Project Managers add or modify Tasks in the Project Plan as issues arise, and 
team members update their individual statuses as they complete assigned 
Tasks. Projects formalize the definition and processing of business initiatives 
and provide an easy-to-use interface for viewing key business activities. 
Projects can be used to define such initiatives as mergers and acquisitions, ISO 
9000 certification, eCommerce initiatives, new hire processing, or software 
development. 

Figure 2-1 Project window
8 Key Concepts and Definitions
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Project Templates
Project Templates are reusable collections of Project parameters and processes 
that can be applied to any Project in order to allow project managers to rapidly 
create customized project plans. The Mercury ITG Project Template Workbench 
captures basic Project Template information. This information helps to create 
reusable Project structures and hierarchies.

Using a Project Template to create a Master Project, Project Managers can 
choose to enable or disable fields, set Exception rules, determine which 
Indicators to display, determine scheduling settings, set up security 
restrictions, and edit custom fields. Project Templates can speed up the process 
of setting up a Master Project. A repeated set of Tasks can be bundled into a 
Project Template and applied to any Project while preserving its Notifications, 
Project Plan, and any custom fields it can have. Project Templates can also be 
used to add Subprojects to a Master Project.

Project Team
Project Managers can specify a pool of Project Management users and user 
groups to draw from when assigning Resources to a particular Project. These 
Project Teams can vary from Project to Project and are configured from the 
Project Settings window.

Figure 2-2 Project Settings window
Key Concepts and Definitions 9
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Resources
A Resource in Project Management is a Project Management user who 
performs work tracked by Project Management. In an IT department, 
Resources can include permanent employees, contractors, consultants, and 
outsourcing firms. Resources are assigned Tasks and are able to update their 
Task statuses in Project Management. They are chosen from the Project Team 
specified by a Manager. Resources can also have a Resource Rate that is useful 
in determining Project costs.

Tasks
Tasks are the actions within a Project that must be completed in order for the 
Project to complete successfully. As Project Managers need to gather data 
from Projects and make appropriate changes through the life of the Project, 
Tasks can be configured to deliver appropriate information. For example, 
Project Managers need to be notified when Tasks are completed or their state 
changes. Tasks also need to be modified as issues arise during the Project, such 
as extending their schedules or assigning additional resources to a Task to 
make a deadline. Team members update their individual statuses as they 
complete assigned Tasks.

Master Projects
Master Projects are groups of Tasks and Subprojects that define a business 
initiative. The Master Project allows Project Managers to determine which 
information they would like to track over the course of the Project. Using the 
Project Workbench to build a Master Project, Project Managers can choose to 
enable or disable fields, set Exception rules, determine which indicators to 
display, determine scheduling settings, and set up security restrictions.

Subprojects
Subprojects are Projects that create hierarchy within a Master Project by 
establishing logical groups of Tasks and Projects. These groups help to break 
up Master Projects into manageable pieces. By breaking up a Master Project, a 
10 Key Concepts and Definitions
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Project Manager can use Subprojects to define security for a smaller set of 
Tasks within a Master Project. This is important when a Master Project is large 
or has numerous components. Assigning managers to Subprojects creates 
better visibility and control for the Project Manager.

Gantt Charts
Gantt charts graph a Project’s Tasks in a form similar to a bar chart, plotted 
against a time axis that can be expanded or decreased for differing levels of 
detail. This provides Project Managers with visualizations of Projects that are 
easy to comprehend at a glance.

Figure 2-3 Gantt Chart

Milestones
A milestone is a significant event in a Project and often marks the completion 
of a deliverable. On Project Gantt charts, milestones appear as black diamonds. 
Since milestones are often markers, they generally do not have a duration 
associated with them, though they can be configured with durations if so 
desired.
Key Concepts and Definitions 11
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Critical Path
The critical path of a Project is the longest path through the Project. It is 
comprised of a series of activities that determine the Project's duration. A 
Project's critical path can be recalculated at any time.

Action Items
Action Items are used to capture important “to do” items that do not require the 
formal definition, tracking and hierarchical restrictions of a Task. Each Action 
Item contains information on the specified item’s priority and status. This 
information can be used to track and verify that all details related to the current 
Project are logged, tracked and eventually resolved. Action Items on Tasks can 
be made “required,” meaning a Task will not be allowed to be marked as 
Complete until the Action Item is taken care of.

Project States
Project states are used to reflect the various stages of a Project lifecycle. 
Project Managers can move a Project into different states to facilitate the work 
associated with that stage of the Project, such as On Hold, Active, or 
Completed. Project states also provide higher visibility to Project Managers by 
displaying which Projects can be updated or need their attention. Project 
Managers can change states at the Master Project, Subproject, or Task level at 
any time.

Exceptions 
Exception Rules provide specific criteria for evaluating risks and variables that 
can come up during the course of a Project lifecycle. When these identified 
risks occur, they are prominently displayed. This minimizes the impact that 
these risks might have on the overall Project completion date. 

Exceptions are triggered at the Task level. The Project Management Summary 
Condition Indicator summarizes the Task exceptions for each Project and 
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Subproject. Email Notifications can be sent to the proper user if a Task triggers 
an Exception.

The Master Project is equipped with the following Exception Rules:

The following Exception Rule parameters are configurable:

• Enabled
Users can decide whether or not the particular Exception Rule is enabled.

• Rule
Specifies the number of days the particular Exception Rule waits for or 
monitors.

• Include in Summary Condition
Decides whether or not the violations of the particular Exception Rule are 
included in Project Management’s Summary Condition view (see 
“Summary Conditions” on page 14).

Table 2-1. Exception Rules for Master Projects

Exception Name Rule

Unassigned Tasks No Resource is assigned, and the Scheduled Start 
Date occurs in X days.
(X is a user-configurable number)

Late Tasks Task is not yet “Complete”, and the current date is X 
days past the Scheduled Finish Date.
(X is a user-configurable number)

Tasks Starting Late Task is not yet “In Progress”, and the current date is X 
days past the Scheduled Start Date.
(X is a user-configurable number)

Late Estimated Finish Estimated Finish Date is more than X days past the 
Scheduled Finish Date. 
(X is a user-configurable number)

Not Enough Time Left Estimated Remaining Duration exceeds the time left 
between the current date and Scheduled Finish Date 
by X days. 
(X is a user-configurable number)

Predecessor Has 
Exception

Task directly preceding a milestone has triggered one 
of the above Exceptions.

Critical Path Running 
Late

Task preceding a milestone on the Project critical path 
has triggered one of the above Exceptions.
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Exception Rule behavior can be set on the Exception Rules tab of the Settings 
window, shown in Figure 2-4.

Figure 2-4 Setting the Exception Rules

Summary Conditions
Summary Conditions summarize the Task exceptions for each active Project 
and Subproject. The Summary Condition View is a simple graphical indicator 
which is located next to the Project or Subproject name in the following 
locations:

• Results tab of the Project Workbench

• Project Plan Panel

• Project Search Results page in standard interface

• Project Summary Portlet

• Project Details page

A Project’s Summary Condition color begins green and changes to yellow or 
red depending on the percentage of Tasks that have Exceptions within a 
Project. This percentage is configurable by the Project Manager.
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The values for triggering color change in the Summary Condition can be 
modified on the Exception Rules tab of the Settings window shown in 
Figure 2-5.

Figure 2-5 Modifying the Summary Condition

Notifications
Email Notifications can be automatically generated whenever a state change 
occurs for a Task. Notifications can also be sent when a Task triggers an 
Exception. The automated notification system ensures that Project Managers 
and Task owners are properly informed of all changes that affect their work. 
Notifications can also be sent to inform users of the start/finish dates of Tasks.

Project Management Notifications will typically instruct the user to review or 
act on a Task. Notifications for Tasks are configured in the Notifications tab of 
the Task window. Clicking New opens the Add Notification for Task window 
shown in Figure 2-6.

Table 2-2. Default Values for Triggering Color Change in Summary Condition 

Green 0%

Yellow 30%

Red 60%

A Project Manager sets the threshold value for yellow to 30%. Four Tasks 
trigger an exception in a Project consisting of ten Tasks total. The Summary 
Condition View indicator turns yellow, and will remain yellow until at least 
two Tasks are reworked so they no longer have Exceptions (this could be 
accomplished by changing a start date, or modifying resources). Once this 
occurs, the Summary Condition indicator turns green.
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Figure 2-6 Add Notification for Task Window

Figure 2-7 illustrates a sample Notification.

Figure 2-7 Sample Notification

Scheduling Engine and Calendar
Project Management features several pieces of functionality that are designed 
to enhance Project scheduling and planning. Project Managers have greater 
control over the Project planning phase. Features include Project Plan revision, 
duration-based scheduling, Resource Calendar, and enhanced Predecessor 
relationships.

http://mercury.com/00/1816/mercury.html

Date: Fri, 27 Feb 2004 13:49:20 PDT
From: release@mercury.com
To: JohnSmith@theshire.com
Subject: Mercury ITG Project Management Alert
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Project Plan revision allows Project Managers the ability to plan and revise 
portions of a Project while it is currently in progress. This makes Project 
management more accurate and up to date by emulating real life project 
development in which changes can occur during the project life cycle. By 
making project planning and tracking more accommodating, Project Plan 
revision gives the Project Manager complete control over the entire process 
from start to finish.

Duration-based scheduling allows Project Managers to schedule Projects and 
Subprojects more efficiently. Also, if Task or date changes occur, Project 
Management will prompt the Project Manager to revise the schedule to reflect 
those changes. This ensures that the Project Plan is always up to date and still 
manageable.

The Resource Calendar is used by Project Managers to record company 
working and non-working days. This information is then used by the 
scheduling engine to aid in determining Project start and finish dates.

Projects and Tasks can also use external Projects and Tasks as predecessors, 
eliminating the need to create giant Projects to preserve relationships.

Baseline
A baseline is the original approved Project plan for a Project. As scope changes 
happen, the baseline is updated to reflect those changes as part of the approved 
plan. A Project Manager uses baselines to continuously monitor the health of 
their Project in terms of schedule and cost by comparing the current Project 
plan to the baseline plan. Multiple baselines of a single Project can be taken by 
a Project Manager and reviewed at any time.

Financial Management
Project Management’s Financial Management capability allows users to 
capture and track Planned and Actual cost information for their Projects, 
giving visibility into Project performance from a financial standpoint. Basic 
cost information can be captured on Projects and Tasks in the following areas:

• Planned Labor Cost
The dollar cost of a work item (typically a Task) which is a measure of the 
amount of scheduled effort on a Task. This figure is Task-specific and is 
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rolled up to the Master Project.
Calculated as: Planned Labor Cost = Sum of (Allocation * Resource Rate) 
for each Resource assigned to the Task.

• Planned Non-Labor Cost
The dollar cost of miscellaneous items needed to complete a work item. 
This is not a direct measure of the effort to be spent on a work item. This 
figure is Task-specific and is rolled up to the Master Project.

• Planned Cost
The total planned dollar cost represented by a work item.
Calculated as: Planned Cost = Planned Labor Cost + Planned Non-Labor 
Cost.

• Baseline Labor Cost
The Labor Cost for a work item in the latest Baseline taken of a Project.

• Baseline Non-Labor Cost
The Non-Labor Cost for a work item in the latest Baseline taken of a 
Project.

• Baseline Cost
The total dollar cost represented by the latest Baseline taken of a work 
item.
Calculated as: Baseline Cost = Baseline Labor Cost + Baseline Non-Labor 
Cost.

• Actual Labor Cost
The dollar cost of the work performed on a work item.
Calculated as: Actual Labor Cost = Sum of Actual Effort * Resource Rate

• Actual Non-Labor Cost
The total of all miscellaneous costs accrued in completing a work item.

• Actual Cost
The total dollar cost incurred in completing a work item.
Calculated as: Actual Labor Cost + Actual Non-Labor Cost.

• Planned Value (PV)
The portion of the Baseline Cost planned to be spent between the Project’s 
start date and the current date.

• Earned Value (EV)
The portion of the Baseline Cost for the entire Project that has theoretically 
been spent by the current date, measured as a function of the amount of 
work performed thus far.
Calculated as: EV = Baseline Cost * % Complete
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• Cost Performance Index (CPI)
The cost efficiency ratio of Earned Value to Actual Cost. CPI is used to 
calculate Projected Actual Cost for a Project.
Calculated as: CPI = EV / Actual Cost

• Schedule Performance Index (SPI)
The ratio of Earned Value to Planned Value. SPI describes what portion of 
the Project plan has been accomplished in terms of its Cost.
Calculated as: SPI = EV / PV

Budget
A Budget indicates an allocation of money between specific start and finish 
dates. Between these dates, the Budget specifies the money available for each 
time period (usually a calendar month). Entries in a Budget can be set for labor 
or non-labor categories. Budgets can be associated with Projects or 
Organization Units.

Requests
Project Management can integrate with Demand Management to provide a 
comprehensive and powerful Project management and issue resolution system. 
Requests, the primary work unit of Demand Management, can be linked 
directly to Projects or Tasks. The Request contains all of the information that is 
typically required to bring the Request to closure. By associating Requests 
with the Project, Project Managers can track other company issues which can 
affect the ultimate Project success. Project Tasks can also be created from 
Requests in the Project Plan Panel.

Packages
Project Management can integrate with Change Management to combine the 
powerful Project management and change management tools featured in each 
Mercury ITG product. Packages, the primary work unit of Change 
Management, can be linked to Projects or Tasks. The Package contains all of 
the information that is required to deploy and audit software changes to 
mission critical applications. By associating Packages with a Project, Project 
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Managers can track other company issues related to software change 
management that could affect the outcome of the current Project.

References
Projects can include references to other entities or sources of information, 
allowing easy access and visibility to data related to the current Project. 
References can be linked to Projects or Tasks. Summary information for 
references is viewed as part of the Project. Each reference can be viewed in 
detail with a click of the mouse. There are several reference types available in 
Project Management: Attachments, Document URLs, Requests, Packages, 
Tasks, and Projects.

References can also have dependencies associated with them; for instance, a 
Task can be configured to wait for a referenced Request to finish before being 
marked Complete. In addition, new Requests can be created from a Task as 
References in both the standard and Workbench interfaces.

Figure 2-8 Adding an Existing Request as a Reference

Mercury ITG Dashboard (Project Management)
Project Management provides an additional level of Project efficiency when 
used in conjunction with Mercury ITG Dashboard. The Dashboard is a highly 
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configurable application that offers greater visibility and control over Projects 
and Tasks. The Dashboard seamlessly integrates with the core Mercury ITG 
products in a way that allows for the delivery of real-time status and exception 
information on IT initiatives and operational tasks.

Upon login to Project Management, users will see the Dashboard—a collection 
of windows, or Portlets, that comprise their Mercury ITG Home page. Users who 
do not have access to the Dashboard will only see one summary level Portlet 
for Project Management: the My Tasks Portlet. Users who have purchased the 
Dashboard will receive all of the following Project Management related 
Portlets:

• My Tasks Portlet (all users)
Displays all Project Tasks currently assigned to the user that have a 
scheduled finish date within two weeks of the current date.

• Project Budget and Staffing Profile vs. Actuals Portlet
Compares Budget and Staffing Profile plans to the actual cost and resource 
usage of running Projects.

• Project List Portlet
Displays general information about Projects, including overall status of the 
Project, start and end dates.

• Project List (Expanded) Portlet
Displays general information about Projects using a broader list of fields 
than the Project List Portlet.

• Project Summary Pie Chart
Displays Projects in the system according to their Summary Condition.

• Project Overview Page
Contains the following Portlets:

o Project Summary Portlet
Displays summary information about Projects, such as percentage 
complete and scheduled start and finish.

o Project Exception Summary Portlet
Displays summary information about the status of Exceptions for the 
Project, and how many Tasks fit into each Exception category.

o Project Exception Detail Portlet
Displays detail information about Exceptions for the Project, such as 
any Tasks that have violated Exceptions, the state of the Task and the 
Resource assigned to the Task.
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o Project Milestones Portlet
Lists the Milestones in a Project.

o Project Overview Gantt Portlet
Displays the Gantt chart for a Project.

o Project References Portlet
Displays detail information about entities referenced by the Project.

o Project Related Actions Portlet
Displays links to a Project’s Assignment visualizations and Staffing 
Profiles.

o Subproject & Tasks Summary Portlet
Displays summary information about a Project’s Subprojects and 
Tasks, such as percentage complete and scheduled start and finish.

• Resource Gantt
Displays information on a Resource’s workload including Project Tasks 
and assigned Requests.

Tabs in the Dashboard allow users to group Portlets according to their own 
needs. To save time in configuration, your application administrator can define 
a default Dashboard layout for all users. For further adaptability, your 
application administrator can also create custom Portlets to suit your particular 
business needs.
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 Chapter

Setting Up Resources

Resources in Project Management can be tracked to optimize their time and 
capabilities with Project Management’s Resource Management functionality. 
Using Resource Management, a Project Manager can:

• Configure a Global Calendar and set the number of hours in a working day

• Assign a Primary Skill and Cost Rate to a Resource

• Map Resources into an Organization Model and tie Organization Units to 
Security Groups

• Track the future supply of Resources using Resource Pools

• Project the allocation of Resources over time using Staffing Profiles

• Assign Resources to Work Items

• View Resource load by time period, Project, or individual

• Compare Project assignments to Staffing Profiles

See Managing Your Resources (Resource Management) for additional details.
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 Chapter

Setting Up a Project

This chapter describes the process of creating a Project. Projects allow 
organizations to define business initiatives as a hierarchical structure of Tasks 
and Subprojects that logically groups and organizes activities and deliverables. 
Using Projects, users can define, browse, edit, and manage complex business 
initiatives. 

The following sections provide a comprehensive set of instructions related to 
setting up a Project:

• Creating a Project

• Setting Up a Master Project

• Adding Tasks to a Project

• Setting Up Project Dependencies

• Creating a Master Project Schedule

• Establishing a Project Baseline

Creating a Project
Master Projects handle, link, and reference all of the variables vital to planning 
a successful endeavor. Master Projects consist of different subsets of 
information -- Tasks, Subprojects, Action Items, Cost data, Notes, Packages, 

Many Project activities are performed in the Workbench interface. If you 
have installed a pop-up blocker in your web browser, the Workbench will not 
open.
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Requests, and References -- that can be linked to each other. In addition, the 
Master Project maintains global settings and configurations that are tracked 
throughout an initiative’s life cycle.

There are three main stages in the creation of a Project:

• Stage One - Setting up a Master Project

• Stage Two - Adding Tasks to a Project

• Stage Three - Creating a Master Project Schedule

Stage One - Setting Up a Master Project: 

The Master Project is the overarching entity that keeps track of a particular 
initiative. The Master Project can be configured to display useful data about a 
Project as it moves toward completion. Project Templates can also be used to 
define an entire Master Project, and can be subsequently modified. 

• Creating the Master Project Entity
Using the Workbench, you will create a Master Project. When enabled, this 
Project will be visible to other users through the Mercury ITG Dashboard.

• Selecting Information to Track and Display
The Master Project contains configurable fields that collect information 
which will be tracked as the Project progresses. These fields, which include 
% Complete and Confidence, provide a constant point of reference for 
Project Managers and Participants throughout an initiative’s life cycle.

• Setting Up Exception Behavior
During the course of a Project’s life, some things can go wrong -- resources 
can be missing, Tasks can be completed late or not at all, the Project can go 
over budget, etc. The Master Project contains Exception Rules that can be 
configured to deliver advance warning of these circumstances or to signal 
when they have occurred.

• Setting Up Indicators
The Master Project also features configurable Project Plan Indicators. 
Indicators can display exceptions that have occurred, Projects with Custom 

A particular Task currently has no Resource assigned to it, and it is scheduled 
to begin in two days. The Master Project can flag this Exception for review.
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Fields, Tasks or Projects that might require rescheduling, Tasks with 
defined Notifications, and any scheduling constraints that apply to a Task.

• Setting Scheduling Options
The Master Project can be set to schedule Projects based on different 
configurations for resource availability and actual start and finish dates.

• Setting Security Restrictions
Project Managers can set Security Restrictions on a Project so that only 
those directly involved in a Project can view its information.

Stage Two - Adding Tasks to a Project:

Projects consist largely of Tasks and Subprojects. Tasks and groups of Tasks 
(using Templates) can be added freely to any Project Plan. Below are some 
common procedures used to add and modify Tasks:

• Adding Tasks to the Project Plan Panel

• Adding Tasks Using Project Templates

• Setting Up Project Hierarchy

• Attaching Additional Information to a Project or Task

Stage Three - Creating a Master Project Schedule:

Once the tasks have been added and the scheduling options have been set, the 
Project can be scheduled. Project Management will calculate scheduled start 
and finish dates automatically, and inform the user of any errors it encounters 
in the process.

Andrew, Jered, and Dave are the assigned Resources for a Project, but Jered 
is going on vacation for a week, and all three people need to be present for the 
initiative to move forward. The Project can be set not to include Jered’s 
vacation time as viable for scheduling.
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Setting Up a Master Project
The Master Project is the entity in Project Management that keeps track of a 
business initiative. It can be configured to display useful data about a given 
Project as it moves toward completion.

Figure 4-1 Master Project

The Master Project can be configured in the following ways:

• Creating the Master Project Entity

• Selecting Information to Track and Display

• Setting Up Exception Behavior

• Setting Up Indicators

When a user creates or edits a Project or Subproject, that user is the only one 
able to save changes. All other users will be warned of this before attempting 
to edit that Project or Subproject at the same time.

In the case of two users wanting to edit two different Subprojects under one 
Master Project, opening and editing only the desired Subprojects from the 
Project Workbench will enable each user to save changes without interfering 
with each other.

Two users can even edit separate Tasks in the same Project without risk.
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• Setting Scheduling Options

• Setting Security Restrictions

• Setting Up the Project Team

• Setting Up Microsoft Project Integration

• Importing Custom Fields from a Project Template

Creating the Master Project Entity
To create a Master Project:

1. From the Mercury ITG Menu Bar, select Administration > Open 
Workbench.

The Workbench opens.

2. Click the Project Mgmt screen group.

3. Click the Projects icon. 

The Project Workbench window opens. 

4. Click New Project. 

The New Project Menu window opens.

5. In Master Project Name, enter the name of the Project.

You can optionally select to use a Project Template to define the structure 
and custom fields for the new Project. 

6. Click OK.

The Project window opens.

7. Add Tasks according to the Project schedule.
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See “Adding Tasks to a Project” on page 52 for more details. You need to 
add at least one Task to the Project in order to save the Master Project.

8. Click Save.

You can now set up your Project. This includes setting up Project options 
and adding and configuring Tasks to the Project. 

To copy a Project to create a new Master Project:

1. Open the Project Workbench window.

2. Query for the Project that you would like to copy.

3. In the Results tab, select the Project.

4. Click Copy.

The Copy Project window opens. 

5. In the Project Name field, enter the new name of the Project.

6. Select the information that you would like to copy from the original Project 
by clicking the associated checkboxes. 

7. Click Copy. 

Selecting Information to Track and Display
The Master Project allows Project Managers to choose information they would 
like to track over the course of the Project. Fields selected in this window 
become enabled for all Project Participants.

To select information to track and display:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Project Fields tab. 
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3. For each field, select the appropriate check box, depending on whether you 
want the field to be displayed in both the Workbench and standard 
interface, or only in the Workbench.

If you do not want the field displayed in either location, do not select a 
check box for that field.

4. Apply the changes.

To apply changes to the Project and continue to set desired information 
without closing the window, click Apply. To apply changes to the Project 
and close the window, click OK.

Setting Up Exception Behavior
The Master Project comes with a set of predefined Exception Rules. A Project 
Manager can specify which Exception Rule(s) are to be enabled, as well as the 
criteria needed to trigger them. A Project Manager can also configure the 
Summary Condition, which is a simple color-coded indicator of the health of a 
Project. The Summary Condition watches for Exceptions that have been 
triggered, and changes color according to rules that can be set by the Manager. 
The health of the Project in terms of its cost can also be represented with the 
configurable Cost Health Indicator.
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Figure 4-2 Settings Window - Exception Rules Tab

By default, Unassigned Tasks, Late Tasks and Tasks Starting Late are enabled and 
included in the Project Summary Condition. The following topics are related to 
setting up Exceptions:

• Setting Exception Rule Behavior

• Summary Condition

• Cost Health Indicator

Setting Exception Rule Behavior
The Master Project is equipped with the Exception Rules described in 
Table 4-1:

For a Project with a very low margin for error, you can set the percentage of 
triggered Exceptions needed to change the Summary Condition red to 20, 
giving clear early warning of problems.

A Project whose cost needs watching can be configured such that its Cost 
Health Indicator takes into account violations of the planned budget.
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The following parameters for all Exception Rules are configurable:

• Enabled
Project Managers can decide whether or not the particular Exception Rule 
is enabled.

• Rule (number of days)
Specifies the number of days the particular Exception Rule waits for or 
monitors. The default number of days for each Exception Rule to be 
triggered is three.

• Include in Summary Condition
Decides whether or not the violations of the particular Exception Rule are 
included in Project Management’s Summary Condition (see “Summary 
Condition” on page 35).

Each Exception Rule within the Exception Rules tab can be configured 
independently.

To set Exception Rule behavior:

1. From the menu at the top of the Workbench, select Project > Settings.

Table 4-1. Exception Rules for Master Projects

Exception Rule Description

Unassigned 
Tasks

Task has no Resource assigned and Scheduled Start Date 
occurs in X days, where X is a user-configurable number.

Late Tasks Task is not yet “Complete,” and the Current Day is X days past 
the Scheduled Finish Date.

Tasks Starting 
Late

Task is not yet “In Progress,” and the current date is X days past 
the Scheduled Start Date.

Late Estimated 
Finish

Estimated Finish Date is more than X days past the Scheduled 
Finish Date.

Not Enough 
Time Left

Estimated Remaining Duration exceeds the time left between 
the current date and the Scheduled Finish Date by X days.

Predecessor 
Has Exception

Task directly preceding a milestone has triggered one of the 
above Exceptions.

Critical Path 
Running Late

Task preceding a milestone on the Project critical path has 
triggered one of the above Exceptions.
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The Settings window opens.

2. Click the Exception Rules tab.

3. To enable a particular Exception Rule, select the check box to its left in the 
Enabled column.

4. To set the number of days that trigger a particular Exception Rule, enter the 
desired number into the text field inside that Rule.

5. To include a particular Exception Rule in a Project’s Summary Condition 
View, select the check box to its right in the Include in Summary Condition 
column.

6. Apply the changes.

To apply changes to the Project and continue to set Exception Rule 
behavior without closing the window, click Apply. To apply changes to the 
Project and close the window, click OK.

Some Exception Rules require that certain fields in the Project Fields tab be 
enabled in order to trigger. For example, the Not Enough Time Left rule 
requires Estimated Remaining Duration to be enabled. See “Selecting 
Information to Track and Display” on page 30 for more information on 
enabling fields in the Project Fields tab.
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Summary Condition
The Summary Condition is a graphical indicator of the health of a Project, 
located next to the Project name. A Project’s Summary Condition color begins 
green and changes to yellow or red depending on the percentage of Tasks 
within a Project that have triggered Exceptions. This percentage is 
configurable in this tab, by any Project Manager. A Project’s Summary 
Condition will not be calculated until the Project is saved.

To set the values for triggering color changes in the Summary Condition:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Exception Rules tab.

3. Enter the desired triggering value into each text field.

Do not include the percent sign (%).

4. Apply the changes.

Table 4-2. Default Values for Triggering Color Change in Summary Condition 

Green 0%

Yellow 30%

Red 60%

A Project Manager sets the threshold value for yellow to 30%. Four Tasks 
trigger an exception in a Project consisting of ten Tasks total. The Summary 
Condition View indicator turns yellow, and will remain yellow until at least 
two Tasks are reworked until they no longer trigger Exceptions (this could be 
accomplished by changing a start date, or modifying resources). Once this 
occurs, the Summary Condition indicator turns green.
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To apply changes to the Project and continue to set Exceptions without 
closing the window, click Apply. To apply changes to the Project and close 
the window, click OK.

Cost Health Indicator
The Cost Summary is part of Financial Management, and can be enabled or 
disabled on a per-Project basis. It appears on the Project window’s Cost tab, 
and as an Indicator on the Project Plan tab if enabled in the Settings window’s 
Indicators tab. It is used to indicate the health of a Project in terms of its cost. 
Project cost health is calculated in the following areas:

• Cost Performance Index (CPI)
The cost efficiency ratio of the Project’s Earned Value (Baseline Costs * % 
Complete) to Actual Costs. 
Calculated as Earned Value / Actual Cost. CPI for a healthy Project should 
be greater than 1.

• Schedule Performance Index (SPI)
The difference in value between the scheduled completion of a 
Task/Project and its actual completion.
Calculated as Earned Value - Planned Value. SPI for a healthy Project 
should be greater than 1.

• Prorated Budget
A measure of the budget scheduled to have been spent to date.

Any one of these factors can be enabled or disabled when calculating Project 
cost health.

Table 4-3. Default Values for Triggering Color Change in Cost Health Indicator

Color CPI SPI Actual Costs > Prorated Budget By

Green > 1 > 1 < 5%

Yellow < 1 < 1 > 5%

Red < 0.7 < 0.7 > 10%
36 Setting Up a Project



Managing Your Projects (Project Management)
Setting Up Indicators
Project Management provides Project Plan Indicators to give users a better at-
a-glance overview of their Projects in progress. The following Indicators can 
be configured to be displayed at the Master Project level. Indicators appear in 
the Project Plan Panel to the left of Subproject and Task names, where 
appropriate.

• Constraint
Displays for Tasks with scheduling constraints.

• Custom Fields
Displays for Projects that have custom fields defined.

• Exception
Displays for Tasks that have triggered exceptions, and also displays the 
Summary Condition for Projects.

• Notification
Displays for Tasks that have Notifications defined.

• Scheduling
Displays for updated Tasks or Projects that might require rescheduling.

• Cost Health
Displays for Projects that have Financial Management enabled.

To set Indicators to be displayed:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Indicators tab.

A Project Manager doesn’t care about CPI or SPI, but wants to know when 
his Project exceeds its prorated budget by 2%. Exceeding the budget by 5% is 
the upper limit of tolerance.

He un-checks the boxes Include CPI Violation in the Cost Indicator and Include 
SPI Violation in the Cost Indicator.

He configures the Indicator to turn yellow if Actual Costs Exceed Prorated 
Budget by 2%, and red if Actual Costs Exceed Prorated Budget by 5%.
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3. To display a particular Indicator, select the check box to its left in the 
Displayed column.

The Exception Indicator is displayed by default.

4. Apply the changes.

To apply changes to the Project and continue to set Exceptions without 
closing the window, click Apply. To apply changes to the Project and close 
the window, click OK.

Setting Scheduling Options
Project Managers can set different scheduling options, depending on the 
Project’s level of resource dependency. Project Management’s Scheduling 
Options also allow for the creation of schedules based on actual start and finish 
dates. The default configuration is set to not use actual dates. Project Managers 
can perform the following scheduling actions:

• Setting a Default Date From Which to Schedule

• Setting Scheduling With or Without Actual Start/Finish Dates

• Setting Scheduling Options for Resource Dependency

• Setting the Work Day Hours

Setting a Default Date From Which to Schedule
Project Managers can set a default date for Project Management to start 
scheduling from. This is useful for setting a hard date from which to begin an 
initiative, no matter what occurs during the planning process.
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To set a default date from which to schedule the Project:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Scheduling tab. 

3. Select the Progressive scheduling option.

4. Select the desired date from the Default Date from which to Schedule field.

5. Apply the changes.

To apply changes to the Project and continue to set Scheduling Options 
without closing the window, click Apply. To apply changes to the Project 
and close the window, click OK.

Setting Scheduling With or Without Actual Start/Finish Dates
A Project Manager can choose to determine a Project’s schedule using actual 
start/finish dates. This is the default scheduling mode.

Once a Project becomes Active, its Tasks can be marked In Progress. When 
Tasks are marked In Progress, actual start dates are specified for that Task. If 
the Master Project is set to use actual start/finish dates in scheduling, it will 
use these dates to determine the schedule.
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To determine whether scheduling is based on actual dates or not:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Scheduling tab.

3. Set one of the two scheduling date options:

• To schedule your Project using actual start/finish dates, select 
Standard. This is the default setting.

• To schedule your Project without using actual start/finish dates, select 
Progressive.

4. Apply the changes.

To apply changes to the Project and continue to set Scheduling Options 
without closing the window, click Apply. To apply changes to the Project 
and close the window, click OK.

Setting Scheduling Options for Resource Dependency
Every business initiative has some minimum resource requirements, usually in 
the form of available personnel. The Master Project can be set to consider 
resource requirements when creating its schedule. For instance, it is possible to 
set the Master Project to ignore resource availability and schedule accordingly. 
The default configuration is set to require all resources to be available on any 
given day. When creating the Master Project’s schedule, Project Management 
will only consider days when all resources are present.
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To set the minimum resource requirements for the Master Project 
schedule:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Scheduling tab.

3. To specify the minimum resource requirement necessary for a day to be 
considered available, select the condition desired.

4. Apply the changes.

To apply changes to the Project and continue to set Scheduling Options 
without closing the window, click Apply. To apply changes to the Project 
and close the window, click OK.

Setting the Work Day Hours
Not all companies have the same length of working day. Project Management 
allows you to set the number of hours in a working day for scheduling 
purposes.

Only one condition can be selected at a time.
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To set the number of hours in a working day:

1. Open the Workbench 

2. Click the Project Mgmt screen group.

3. Click the Calendars icon.

The Calendar Workbench window opens.

4. Click Base Calendar. 

The Base Calendar window opens.

This is a system-wide configuration and should not be adjusted by 
unauthorized users.
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5. Click Settings. 

The Base Calendar Settings window opens.

6. Enter the number of Working hours in a day 

7. Click OK to save the change and close the Base Calendar window.

Setting Security Restrictions
Project Managers can set security restrictions on a Master Project such that 
only those who are involved in the Project can view it. Someone who is not a 
Manager or Participant in a Project will not be able to open or edit it. 
Additionally, the Project will not appear in any searches run by a non-
Participant or non-Manager, both from the Project Workbench and Project 
Search page. Project Management defines Project Participants as users who are 
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involved in Projects, but lack the administrative responsibilities of a Project 
Manager. For more information on Project Participants, see “Updating Tasks: 
Project Participant Activities” on page 167.

Security restrictions can be set in the following areas:

• Setting Security for the Master Project

• Setting Security for Cost Data

Setting Security for the Master Project
To set security restrictions for a Master Project:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Security tab. 

3. Select the restriction type desired from the This Project and its Tasks can be 
viewed by section.

• To allow any user to view and search for the Project, select All Users.

• To restrict Project visibility to only those involved in the Project, select 
Participant Restricted.

4. Apply the changes.

To apply changes to the Project and continue to set other options in the 
Settings window, click Apply. To apply changes to the Project and close the 
window, click OK.
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Setting Security for Cost Data
To set security restrictions for a Master Project’s Cost data:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Security tab. 

3. Select the restriction type desired from the Cost information on the Project 
and its Tasks can be viewed by section.

• To allow any user to view Cost data for the Project, select All Users.

• To restrict Cost data visibility solely to Master Project and its Project 
Managers, select Project Managers for this Master Project only.

• To restrict Cost data visibility to the Master Project, and its 
Subprojects’ Project Managers, select Project Managers for Master 
Project <Project Name> and all of its subprojects.

• To restrict Cost data visibility to only those involved in the Project, 
select Participants for only the Tasks and Projects for which they are 
Participants.

• To restrict Cost data visibility to only those specified in the Settings 
window’s Project Team tab, select Project Team only.

4. Apply the changes.
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To apply changes to the Project and continue to set other options in the 
Settings window, click Apply. To apply changes to the Project and close the 
window, click OK.

Setting Up the Project Team
Project Managers can specify who will be allowed to act as Resources for a 
Project. Resources can be users and groups of users. In the Project Team tab, 
the Project Manager can choose to either: 

• Allow all users with the Project option enabled in their Security Groups to 
be Resources for a Project.

Or 

• Only allow those Resources who are specified in the Project Team tab to be 
used as Resources for a Project. These Resources are listed in the tab’s 
Resource table.

To setup the Project Team for a Master Project:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Project Team tab. 

Exception: Users with the SysAdmin: Override Key Fields Segmentation can 
add any users as a Resource to the Project. 
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3. To allow all Resources with the Project option enabled in their Security 
Groups to be used as Resources for a Project, click the appropriate check 
box.

Skip the steps shown below and go to Step 9 of this procedure.

4. To specify Resources for a Project, deselect the appropriate check box.

5. Click Add.

The Resource: New window opens.

6. Select a Resource or group of Resources from the Resource auto-complete 
list.

The name of the selected Resource appears in the required Resource field 
of the Resource: New window.

7. Add the Resource. 
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Click Add to add the current Resource and continue adding more 
Resources. Click OK to add the current Resource and close the Resource: 
New window.

8. Save the selections.

Click OK to save the selections and close the window. Click Save to save 
the selections and leave the window open.

Deleting Resources from a Project Team
To delete a specified Resource from a Project Team:

1. From the Project Team tab, select the Resource in the tab’s Resource table.

2. Click Remove.

The Resource is removed from the Resource table.

3. Save the action.

Click OK to save the action and close the window. Click Save to save the 
action and leave the window open.

Setting Up Microsoft Project Integration
The Project Management - Microsoft Project 2000 interface allows Project 
Managers to synchronize project information in a Project with the project 
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information in a Microsoft Project 2000 Project file. Information can also be 
imported from Microsoft Project to Project Management and exported from 
Project Management to Microsoft Project.

Project Management has three different synchronization modes that a Project 
Manager can choose from. The various synchronization modes let the Project 
Manager use different strategies for importing/exporting information between 
Project Management and Microsoft Project. See “Control Mode” on page 50 
for more information about synchronization modes.

Before exporting or synchronization, the Project Manager must select a 
synchronization mode from the MSP Synchronization tab in the Settings 
window. The MSP Synchronization tab is shown in Figure 4-3.

Figure 4-3 MSP Synchronization Tab

The MSP Synchronization tab has four sections:

• Microsoft Project File Information

• Activity History

• Control Mode

The MSP Synchronization tab is available only for Projects, but not for 
Project Templates.
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• Resource Identification

Microsoft Project File Information
The Microsoft Project File Information section displays the path and filename 
information of the Microsoft Project file associated with a Project 
Management Project. The Microsoft Project file can be stored on a local 
machine or a local network.

Activity History 
The Activity History section displays information about the last synchronization, 
export or import that took place for this Project.

Control Mode
The Control Mode section lets the Project Manager select a synchronization 
mode. The available options are:

• Project Management-controlled
The Project Manager creates a project in Project Management to perform 
planning and tracking activities, such as scheduling tasks and tracking 
actuals. After exporting, the Microsoft Project file is used for reports and 
distribution. (This is the default value for new Projects created in Project 
Management.)

• Microsoft Project-controlled 
The Project Manager creates a project in Microsoft Project and 
synchronizes it in the Workbench. For all subsequent synchronizations, 
information in Project Management is updated with current information 
from Microsoft Project.

• Project Management controls actuals
The Project Manager plans and schedules the Project in Microsoft Project 
while using Project Management to track actuals. Each subsequent 
synchronization updates the Microsoft Project file with actuals data from 
Project Management. The Mercury ITG Project is updated with changes to 
the project structure or schedule in Microsoft Project.

When importing information from Microsoft Project to Project Management, 
the MSP Synchronization tab is not available because the Mercury ITG 
Project file has not been created yet. The Import Wizard performs the same 
functions as the MSP Synchronization tab sections described below.
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Resource Identification
The Resource Identification section lets the Project Manager choose how missing 
resources created during an export or synchronization will be named in the 
Microsoft Project file. (This section is only enabled when the Control Mode is 
set to Project Management-controlled.) Select one of the following options:

• Username
The username is used as the name of the new Microsoft Project resource 
created during synchronization. 

• Full Name 
The Full Name is used as the name of the new Microsoft Project resource 
created during synchronization.

After selecting the Control Mode and Resource Identification options, click OK 
to save your selections.

Importing Custom Fields from a Project Template
Project Templates are used in Project Management to create repeatable 
processes to be used in Projects. They can be used as a model and serve as a 
basis for Master Projects or Subprojects. Project Templates can also contain 
custom fields that can capture information not normally covered by standard 
Project and Task fields. These custom fields are unique to their Project 
Template.

Custom fields can be associated with an existing Project without importing the 
Project Template they come from. This allows you to capture whatever 
information is needed without having to simultaneously import a superfluous 
set of Projects or Tasks. Custom fields appear in the Project or Task Information 
window on their own tab.

To associate custom fields from a Project Template with your own 
Project:

1. Open the Project.

2. In the Project Plan Panel, double-click the Project name or select it and 
click Edit.

The Project Information window opens.
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3. Select the Project Template containing the desired custom fields from the 
Custom Fields Defined In auto-complete list.

4. Save the changes in the Project Information window. 

Click Apply to save changes and continue working in the Project Information 
window. Click OK to save changes and close the Project Information 
window. Click Cancel to close the Project Information window without 
saving any changes.

5. Save the changes. 

Click Save to save changes and continue working on the Project. Click OK 
to save changes and close the Project. Click Cancel to close the Project 
without saving any changes.

Adding Tasks to a Project
Once the Master Project has been configured, you can add Tasks to the Project 
and specify Task details, including assigning resources or resource groups. 
Tasks can be added individually or in a pre-sequenced group with a Project 
Template. Tasks can also be organized in a hierarchical fashion quickly and 
easily.

Some common methods for adding and manipulating Tasks are described 
below:
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• Adding Tasks to the Project Plan Panel

• Adding Tasks Using Project Templates

• Setting Up Project Hierarchy

• Attaching Additional Information to a Project or Task

• Creating a Task From a Request

• Adding Milestones

Adding Tasks to the Project Plan Panel
To add a Task to the Project Plan Panel:

1. Within the Project window, click Add Task.

A new Task appears in the Project Plan Panel below the current selection.

You can also add a new Task by selecting the last item in the Project Plan 
Panel and pressing Insert or the down arrow on your keyboard.

2. Edit the new Task’s information.

• Tasks can be edited directly inside the Project Plan Panel. Click on a 
field to edit its contents.
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• Tasks can also be edited through the Task Information window, which 
displays more detailed information on a Task.

I. DOUBLE CLICK ON THE NEW TASK. THE Task Information 
WINDOW OPENS.

II. MODIFY THE INFORMATION UNDER EACH TAB IN THE 
Task Information WINDOW AS NECESSARY (FOR DETAILS, 
SEE “Editing Task Information” ON PAGE 89).

3. Apply the changes.

To apply changes to the Project without closing the window, click Apply. 
To apply changes to the Project and close the window, click OK. You can 
also copy and paste Tasks using Ctrl-C and Ctrl-V. Multiple Tasks can be 
copied by holding down the Shift key and selecting with the mouse.

Adding Tasks Using Project Templates
Pre-defined bundles of Tasks can be added with the use of Project Templates. 
The Template will be copied into the working Project Plan Panel as a 
Subproject, along with its default values for Scheduled Effort, Scheduled 
Duration, and Notifications.
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To add a set of Tasks using a Project Template:

1. Within the Project window, select Project Created From Template from the 
drop down list.

2. Click Add.

The Add Project Template window opens.

3. Select a Project Template from the auto-complete list.

4. Click OK.

The Add Project Template window closes. The selected Template is added to 
the Project Plan as a collapsed Subproject.

5. Modify the information for any Task inside the Subproject by either editing 
it directly in the Project Plan Panel, or double-clicking on the Task and 
editing fields.

See “Adding Tasks to the Project Plan Panel” on page 53 for more 
detailed information.

Setting Up Project Hierarchy
Project Management allows users to add Tasks and Subprojects (from 
Templates) in any order. Once the Tasks have been added, Project 
Management users can also arrange and group them in a hierarchy.

Project Templates can be modified to contain custom fields. See “Creating 
Custom Fields for Project Templates” on page 201 for more detailed 
information.
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Figure 4-4 Project Plan Panel 

To move an item up in the hierarchy:

1. In the Project Plan Panel, select the Task or collapsed Subproject.

2. Click the Up Arrow button or press Ctrl-up arrow on your keyboard.

The selected Task or Subproject moves up in the list.

• If the selected item is not at the same level as the item it is switched 
with, it is indented or out-dented to match the level of the item it is 
switched with.

• If the switch results in a Subproject with no immediate children, that 
Subproject is converted to a Task after it moves.

To move an item down in the hierarchy:

1. In the Project Plan Panel, select the Task or collapsed Subproject.

2. Click the Down Arrow button or press Ctrl-down arrow on your keyboard.

The selected Task or Subproject moves down in the list.
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• If the item immediately above the selected item is an expanded 
Subproject, the selected item becomes its child.

• If the item immediately above the selected item is a collapsed 
Subproject or Task, the selected item is indented or out-dented to match 
the Subproject or Task’s level.

• If the selected item was the only child of a Subproject, that Subproject 
is converted to a Task after the selected item moves.

To indent an item:

1. In the Project Plan Panel, select the Task or collapsed Subproject.

2. Click the Right Arrow button or press Ctrl-right arrow on your keyboard.

The selected Task or Subproject moves one level deeper in the hierarchy.

• If the item immediately above the selected item is a Task, that Task is 
converted to a Subproject.

To outdent an item:

1. In the Project Plan Panel, select the Task or collapsed Subproject.

2. Click the Left Arrow button or press Ctrl-left arrow on your keyboard.

The selected Task or Subproject moves out one level in the hierarchy.

• If the selected item was a child of a Subproject, it becomes either a 
Task or Subproject on the same level as its former parent.

• If the selected item was a Subproject’s only child, that Subproject is 
converted to a Task.

• If the selected item was a Task with other Tasks of the same level 
beneath it, those Tasks are converted to children of the selected item, 
which is now a Subproject.

If the selected item is the first child of a Subproject, you will not be able to 
indent it.
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Useful Keyboard Shortcuts in the Project Plan Panel
Tasks and Subprojects within the Project Plan Panel can be manipulated from 
the keyboard as well as the buttons in the Project window. Table 4-4 lists all 
available keyboard shortcuts.

Attaching Additional Information to a Project or Task
Tasks and Subprojects can contain other types of information, such as Demand 
Management Requests, Change Management Packages, attachments, and 
URLs. They can also be configured to send Notifications based on certain 
conditions. 

Project Managers can create Tasks from Requests in the Workbench. The 
newly created Task is linked as a Reference to the originating Request. See 
“Creating a Task From a Request” on page 59 for more information.

Refer to “Configuring Tasks” on page 81 for detailed instructions on:

• Assigning Resources

Table 4-4. Keyboard Shortcuts in the Project Plan Panel

Keystroke Action

Insert Inserts a Task into the hierarchy above the current row.

Delete Deletes the selected Task from the Project.

Ctrl-Up Arrow Moves a Task up in the hierarchy.

Ctrl-Down Arrow Moves a Task down in the hierarchy.

Ctrl-Left Arrow Outdents a Task in the hierarchy.

Ctrl-Right Arrow Indents a Task in the hierarchy.

Down Arrow (on last 
Task in hierarchy)

Adds a new Task to the hierarchy below the last row.

Ctrl-C Copies the selected Task.

Ctrl-V Pastes a Task or Tasks (must be on the Project’s last line)

F2 Edits the selected cell in the Project Plan Panel.

ESC Cancels changes to a cell in the Project Plan Panel.

Left or Right Arrow 
(while editing)

Saves edits and moves cursor to the next cell in the Project 
Plan Panel.
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• Setting Up Notifications

• Editing Task Information

• Attaching References to Tasks

• Configuring Task Predecessors

• Setting Scheduling Constraints

Creating a Task From a Request
A Task can be created from a Request and added to the Project Plan. The new 
Task will have a Reference to the originating Request.

To create a Task from a Request:

1. Within the Project window, select Task Created From Request from the 
drop down list at the bottom left corner of the window.

2. Click Add.

The New Task From Request window opens.
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3. Specify the Request(s) to use in the Request No auto-complete list, or click 
Search to search for the Request(s).

The Request Selection window opens.

4. Search for the Request(s) to use by entering search criteria in the 
appropriate fields and clicking List.

The Requests that match your search criteria display in the Query Results 
section of the window.

5. Select the Request(s) in the Query Results section that you want turn into 
Tasks. 

You can select multiple Requests in the Query Results section. When they 
are added to the Project Plan, a new Task is created for each selected 
Request. 

6. Create the new Task.
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Click OK to create the new Task and close the window. Click Add to create 
the new Task and perform additional searches for more Requests.

7. Save the new Task.

Click Save to save the new Task and leave the Project window open. Click 
OK to save the new Task and close the Project window. The new Task has 
been created from the selected Request and is part of the current Project. 
The Task is linked to the Request. You can change the Reference for this 
Task at any time by double-clicking it, opening the Task Information 
window and editing it in the References tab.

Adding Milestones
Milestones are used to mark significant events in a Project, often the 
completion of a deliverable or arrival of a deadline. As markers, milestones are 
typically set by Project Managers to complete as soon as they are reached and 
therefore generally do not have effort or duration, though they can be 
configured to possess duration. Milestones are created the same way as Tasks.

To create a Milestone:

1. Within the Project window, click Add Task.

A new Task appears in the Project Plan Panel below the current selection. 
You can also add a new Task by selecting the last item in the Project Plan 
Panel and pressing Insert or the down arrow on your keyboard.
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2. Double click on the new Task.

The Task Information window opens.
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3. Select the Mark task as milestone check box.

If you want the Milestone to mark itself as Complete automatically upon 
being reached, select the Milestone automatically completes check box.

4. Modify the information under each tab in the Task Information window as 
necessary (for details, see “Editing Task Information” on page 89).

5. Apply the changes.

To apply changes to the Task without closing the window, click Apply. To 
apply changes to the Task and close the Task Information window, click OK. 
To close the Task Information window without saving changes, click Cancel.

Setting Up Project Dependencies
Project Management allows you to create dependencies between a Project or 
Task and another, completely separate Project or Task.

These dependency relationships are controlled from the Predecessors tab of 
the Project or Task Information window.

A Task will be automatically converted to a Milestone if its duration is 0.

Manager Bob has a Training Project for a new software module being 
installed on his group’s computers. In order for his Project to get started, the 
Software Upgrade Project headed by Manager Steve must be finished first. 
Bob can create a Finish-Start Dependency relationship between the Software 
Upgrade Project and his own Training Project.
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Figure 4-5 Predecessors Tab of the Task Information window

The types of Predecessor relationships available are described in Table 4-5.

The following sections discuss setting Predecessor relationships in more detail:

• Setting Internal Predecessors

Table 4-5. Possible Predecessor Relationships to a Project or Task

Predecessor 
Type

Description Possible Relationships

Task/Project A Task or Project in 
the current Project

Finish/Start - The Project or Task can 
start once its Predecessor has 
completed.

External Task A Task from a 
separate Project

Finish/Start - The Project or Task can 
start once its Predecessor has 
completed.

External Project A separate Project Finish/Start - The Project or Task can 
start once its Predecessor has 
completed.

Request A Request (possible 
for Tasks only)

Finish/Start - The Task can start once 
its Predecessor has completed.

Finish/Finish - The Task and Request 
can start at the same time, but neither 
will be marked complete until both are 
complete.
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• Setting an External Predecessor Task

• Setting an External Predecessor Project

• Setting an External Predecessor Request

Setting Internal Predecessors
Setting a Project/Task Predecessor that is contained in the same Project can be 
done directly in the Project Plan Panel.

Figure 4-6 Project Plan Panel 

In the Predecessor column, type the sequence number of the desired 
Predecessor Project or Task and click Save to save changes.

Setting an External Predecessor Task
To set an external Predecessor Task for a Task or Project:

1. Open the Project or Task Information window of the Project or Task.

2. Click the Predecessors tab.
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3. Click Add.

A line is added to the Predecessors tab table.

4. In the Type column, select External Task from the drop down list.

5. In the Project column, select the external Project from the auto-complete 
list.

6. In the Name column, select the Task Name from the auto-complete list.

7. Click the field in the ID/Seq column to display the Task ID.
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8. Apply the changes.

Click Apply to save changes and continue working in the Project or Task 
Information window. Click OK to save changes and close the Project or Task 
Information window. Click Cancel to close the Project or Task Information 
window without saving any changes.

Setting an External Predecessor Project
To set an external Predecessor Project for a Task or Project:

1. Open the Project or Task Information window of the Project or Task.

2. Click the Predecessors tab.
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3. Click Add.

A line is added to the Predecessors tab table.

4. In the Type column, select External Project from the drop down list.

5. In the Project column, select the external Project from the auto-complete 
list.

6. In the Name column, select the Project or Subproject Name from the auto-
complete list.

7. Click the field in the ID/Seq column to display the Project or Subproject ID.
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8. Apply the changes.

Click Apply to save changes and continue working in the Project or Task 
Information window. Click OK to save changes and close the Project or Task 
Information window. Click Cancel to close the Project or Task Information 
window without saving any changes.

Setting an External Predecessor Request
To set an external Predecessor Request for a Task:

1. Open the Task Information window of the Task.

2. Click the Predecessors tab.
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3. Click Add.

A line is added to the Predecessors tab table.

4. In the Type column, select Request from the drop down list.

5. In the ID/Seq column, select the Request ID from the auto-complete list.

6. In the Relationship column, select Finish-Start or Finish-Finish from the 
drop down list.
70 Setting Up a Project



Managing Your Projects (Project Management)
7. Apply the changes.

Click Apply to save changes and continue working in the Task Information 
window. Click OK to save changes and close the Task Information window. 
Click Cancel to close the Task Information window without saving any 
changes.

Creating a Master Project Schedule
Project Management generates schedules for Master Projects, based on the 
configurations set in the Scheduling tab of the Settings window. The following 
are common tasks and items associated with scheduling:

• Generating the Schedule

• Scheduling Errors

• Scheduling Warnings

Generating the Schedule
To generate the schedule for a Master Project:

1. In the Project window, click Schedule Project.
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The Scheduling window opens.

2. Specify whether to schedule all or part of the project.

a. To schedule the whole project, select Schedule Whole Project.

b. To schedule only a specific part of the project, make sure you have 
selected the part you want to schedule in the Project Plan Panel, and 
select Schedule Selected Part of Project. If a Subproject is clicked, all 
of its children will be scheduled.

3. Specify a date to begin scheduling from by clicking on and selecting from 
the Start Scheduling From field.

4. Click Schedule.

Scheduling Errors
It is possible for certain combinations of input to cause a schedule to be 
unworkable. If any of these errors are encountered, the schedule will not be 
created. Table 4-6 describes scheduling errors, their causes, and possible 
solutions.

If scheduling errors occur, no schedule will be generated and a list of errors 
will appear. Take note of each error and its cause, and make the necessary 
adjustments within the Project. See “Scheduling Errors” on page 72 for 
more details.

If scheduling warnings occur, a schedule will be generated and a list of 
warnings will appear. Take note of each warning, as they can be important to 
the initiative’s success. See “Scheduling Warnings” on page 73 for more 
details.
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Scheduling Warnings
It is possible for certain combinations of input when using actual-based 
scheduling or scheduling constraints to cause a schedule to be potentially 
unworkable. Warnings appear when actual-based scheduling has been 
specified. The schedule will still be created, however. Table 4-7 describes 
scheduling warnings, their causes, and possible solutions.

Table 4-6. Scheduling Errors, Causes, and Possible Solutions

Scheduling 
Error

Cause Possible Solution

Circular 
dependency

The predecessors of a set of projects 
or tasks contains a cycle. This cannot 
be scheduled.

Break the cycle by 
removing or changing a 
predecessor. 

Not enough 
available 
resources for 
task

The amount of working days available 
from the pool of resources assigned to 
a task is less than the duration of the 
task. This situation can occur if a 
resource does not have any available 
working days, or perhaps for 
contractors who only have set periods 
of time to work.

Assign more resources 
to the task, increase 
resource availability via 
resource Calendars, or 
change the Scheduling 
setting to require less 
resource availability.

Selected 
Subproject has 
dependencies 
outside of 
items to be 
scheduled

There are tasks or projects that are not 
in the selected sub-tree, but have 
predecessors in the selected sub-tree.

Select a larger sub-tree 
that includes all 
dependents, or remove 
the dependencies.

No tasks to be 
scheduled

There are no non-complete, non-
cancelled tasks within the selected 
sub-tree to be scheduled

Add tasks, or select a 
larger sub-tree that 
includes non-complete 
or non-cancelled tasks.
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Establishing a Project Baseline
A baseline is the original approved Project plan for a Project.  As scope 
changes happen, the baseline is updated to reflect those changes as part of the 
approved plan. A Project Manager uses baselines to continuously monitor the 
health of their Project in terms of schedule and cost by comparing the current 
Project plan to the baseline plan.

The following topics discuss baselines in more detail:

• Selecting Baseline Fields

• Taking a Baseline

• Managing Baselines

• Comparing Baselines

Selecting Baseline Fields
You can select any of the following Project fields to capture in a baseline:

Table 4-7. Scheduling Warnings, Causes, and Possible Solutions

Scheduling 
Warning

Cause Possible Solution

Duration extends 
past finish date for 
task

The duration for a task is longer 
than the number of available 
working days between the 
earliest possible start date and 
the actual finish date.   This 
assumes there is no actual start 
date.

Move the actual finish 
date, change the 
duration, or change the 
number of available 
working days.

Duration does not fit 
within actual dates of 
task

The duration of a task is longer 
than the number of available 
working days between the actual 
start and finish dates.

Change actual dates, 
duration, or number of 
available working days.

Actual start date of 
task occurs before 
predecessor finishes

The actual start date of a task 
occurs before its earliest 
possible start date.

Change actual start 
date, predecessors, or 
the earliest possible 
start date.
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• Summary Condition

• Scheduled Start

• Scheduled Duration

• Scheduled Finish

• Scheduled Effort

• Predecessor Information

• Resource/Project Manager

• Department

• Description

• Priority

• Resource Group

• Task Category

• Planned Labor

• Planned Non-Labor

• Planned Cost

To select fields for a baseline:

1. Open the Project.

2. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.
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3. Click the Baselines tab.

4. In the Baseline Fields section, double-click the fields or use the arrow 
buttons to move fields from the Available Fields list to the Selected Fields list.

5. Apply the changes.

To apply changes to the Project and continue to set baseline options 
without closing the window, click Apply. To apply changes to the Project 
and close the window, click OK.

Taking a Baseline
To take a baseline:

1. Open the Project.

2. Select Project > Baseline from the menu at the top of the Workbench.

The Baseline window opens.
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3. Enter a Name and optional Description for the baseline.

4. Click OK.

The baseline has been taken. It can be viewed from the Baselines tab of the 
Project window.

5. Click Save to save the baseline along with the Project.

Managing Baselines
Multiple baselines can be taken for a single Project. You can specify which is 
the active Project baseline, as well as delete baselines at any time.

To manage Project baselines:

1. Open the Project you have taken baselines of.

2. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

While any Project Manager can see the active baseline for a Project, only the 
Project Manager for the Master Project can manage baselines (take new 
baselines, delete baselines, specify the active baseline).
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3. Click the Baselines tab.

4. Select the radio button next to the baseline you want to be active for the 
Project.

5. (optional) Highlight a baseline you want to delete.

6. Click Delete.

a. A dialog box will open asking if you are sure you want to delete the 
baseline.

b. Click Yes to delete the baseline.

7. Apply the changes.

To apply changes to the Project and continue to set baseline options 
without closing the window, click Apply. To apply changes to the Project 
and close the window, click OK.
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Comparing Baselines
The Project Schedule Change Report can be used to compare baselines to each 
other, or to the Project schedule as it currently stands. 
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 Chapter

Configuring Tasks

This chapter explains how to configure Tasks within a Project, including 
assigning Resources, setting up Notifications, and creating Milestones.

The following topics are covered:

• Task Elements

• Adding Tasks to Projects

• Editing Task Information

• Assigning Resources

• Adding Action Items

• Adding Notes

• Setting Up Notifications

• Attaching References to Tasks

• Configuring Task Predecessors

• Changing the Task State

• Setting Scheduling Constraints

• Configuring User Data

Task Elements
Projects are repositories of information consisting of Tasks, Action Items, 
Subprojects, Notes and References. These elements define and process specific 
business initiatives within an organization. Projects are not static entities. They 
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gather additional information and are modified as they move through their 
Tasks to completion. 

Tasks are the components of a Project that must be completed in order for the 
Project to complete successfully. Project Managers gather the information 
from Tasks and make appropriate changes to them through the life of the 
Project. This means the Tasks must be configured to deliver the kinds of 
specific information that Project Managers need. For example, Project 
Managers can need to be notified when Tasks are completed or their states 
change.

Tasks also need to be modified as issues arise during the Project, such as 
extending Task schedules or assigning additional resources to a Task to make a 
deadline. Team members must update their individual statuses as they 
complete assigned Tasks. 

The following sections discuss the processes and elements used for 
configuring Tasks within a Project:

The following elements within Projects contribute to the information delivered 
by Tasks:

• Notifications

• References

• Task Categories

• Task States

Notifications
Project Managers can set up Notifications for Tasks within a Project. Email 
messages can be sent to appropriate team members whenever a specific event 
occurs on a Task. This would include such events as:

• The completion of a Task.

• The changing of a Task’s state designation. For example, the Task could 
progress from ‘Ready’ to ‘In Progress.’

• The triggering of an Exception Rule by a Task.

• The arrival of a Task’s start or finish date approaches.
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References
Tasks can include additional references to other entities or points of 
information, allowing easy access and visibility to data related to the current 
Task. Summary information for references is viewed as part of the Task. 

There are several reference types defined for Tasks: Requests, Packages, 
Projects, Releases, Attachments and URLs.

Task Categories
Tasks can be grouped in user-defined categories. For example, certain tasks 
could be grouped within a Design category, while other Tasks could be 
grouped within a Production category.

Task States
In the Workbench, the Task State is displayed in the State column of the Project 
window. The available states for a Task are defined in Table 5-1.

Project Managers can create Tasks from Requests in the Workbench. Once 
the Task is created, it automatically has a Reference to the originating 
Request. See “Creating a Task From a Request” on page 84 for additional 
details.

Table 5-1. Task State Definitions

Task State Definition

New A newly created Task starts in this state. 

Pending Predecessor A Task that is holding for one or more predecessors to 
be completed.

Pending Request A Task that is holding for one or more Requests to be 
completed.

Ready A Task that is ready to be worked on by its Resource.

In Progress A Task that is moving through the actions necessary 
for its completion.

Completed A Task that has been finished.
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Adding Tasks to Projects
Tasks can be added to a Project individually or in a pre-sequenced group, as 
defined in a Project Template. Tasks can also be quickly and easily organized 
in a hierarchical fashion. See “Adding Tasks to a Project” on page 52 for more 
information. 

The following sections explain how to create specific types of Tasks:

• Creating a Task From a Request

• Creating a Milestone

Creating a Task From a Request
A Task can be created from a Request on the Project window in the 
Workbench. The new Task will have a Reference to the originating Request.

To create a Task from a Request:

1. Go to the Project Plan Panel.

cancelled A Task that is not complete and will not be worked on, 
as it is no longer required for the completion of the 
Project.

Bypassed An incomplete Task that is left unfinished after the 
Project is completed.

Table 5-1. Task State Definitions

Task State Definition

Depending on their defined level of responsibility in a Project, users can only 
be able to change Tasks between certain states. 

For example, Project Managers can change a Task from Ready to In Progress 
to Cancelled, or from Bypassed back to Ready. Project Participants are only 
able to change a Task from Ready to In Progress to Complete.

Available Task states can also depend on the state of the Project.
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2. Select Task Created From Request from the drop down list at the bottom 
left corner of the window.

3. Click Add.

The New Task From Request window opens.

4. Specify the Request(s) to use in the Request No. auto-complete list, or click 
Search to search for the Request(s). 

The Request Selection window opens.
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5. Search for the Request(s) to use by entering search criteria in the 
appropriate fields.

6. Click List.

The Requests that match your search criteria display in the Query Results 
section of the window.

7. Select the Request(s) in the Query Results section that you want turn into 
Task(s). 

You can select multiple Requests in the Query Results section. When they 
are added to the Project Plan, a new Task is created for each selected 
Request. 
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8. Task Updated by Request is specified as the Relationship.

9. Create the new Task.

Click OK to create the new Task and close the window or click Add to 
create the new Task and perform additional searches for more Requests.

The new Task has been created from the selected Request and is part of the 
current Project. The Task is linked to the Request. You can change the 
Reference for this Task at any time by double-clicking it, opening the Task 
Information window and editing it in the References tab. 

10. Save the new Task.

Click Save to save the new Task and leave the Project window open or click 
OK to save the new Task and close the Project window.

Creating a Milestone
Milestones can be created for a Project plan in the same way as Tasks.

To create a Milestone:

1. Within the Project window, click Add Task. 

A new Task appears in the Project Plan Panel below the current selection. 
You can also add a new Task by selecting the last item in the Project Plan 
Panel and pressing Insert or the down arrow on your keyboard.
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2. Double click on the new Task.

The Task Information window opens.

3. Select the Mark task as milestone check box.
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If you want the Milestone to mark itself as Complete automatically upon 
being reached, select the Milestone automatically completes check box.

4. Modify the information under each tab in the Task Information window as 
necessary (for details, see “Editing Task Information” on page 89).

5. Apply the changes.

To apply changes to the Task without closing the window, click Apply. To 
apply changes to the Task and close the Task Information window, click OK. 
To close the Task Information window without saving changes, click Cancel.

Editing Task Information
Users with appropriate security permissions can edit information for Tasks 
displayed in the Project Plan Panel. Task information can be edited directly in 
the Project Plan Panel, or in the Task Information window.

To edit Task information from the Project Plan Panel

1. Locate the Task to edit.

• If you are editing an existing Task, query and open an existing Project.

• If you are editing a newly created Task, you are already in the Project 
Plan Panel.

2. Click on any desired fields to edit their contents directly.

3. Click OK or Save to save the information.

To edit Task information in the Task Information window

1. Locate the Task to edit.

2. Open the Task Information window. 

A Task will be automatically converted to a Milestone if its duration is 0.
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• Query and open the Task directly from the Task Workbench. The Task 
Information window opens.

Or

• Query and open an existing Project. Double-click the Task to edit, or 
select it and click Edit. The Task Information window opens.

3. Make whatever changes are necessary in the Task Information window.

4. Click OK or Save to save the information.

Assigning Resources
Users with appropriate security permissions can assign Resources to Tasks 
displayed in the Project Plan Panel. Resources can be assigned directly in the 
Project Plan Panel, or in the Task Information window. The following sections 
discuss Resource-related topics in more detail:

• Assigning Resources in the Project Plan Panel

• Assigning Resources in the Task Information Window

• Assigning Multiple Resources in the Task Information Window

• Assigning Resource Groups

• Determining Project Resources

Assigning Resources in the Project Plan Panel
Resources can be assigned for existing Tasks and new Tasks in the Project 
Plan Panel.

To assign Resources to existing and new Tasks in the Project Plan Panel:

1. In the Workbench, open the Project Plan Panel for the Project you are 
editing.

Updating information in the Project Plan Panel is more direct, while more 
detailed information can be edited in the Task Information window.
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• If you are assigning Resources to an existing Task, query and open the 
Project containing the Task.

• If you are assigning Resources to a newly created Task, you are already 
in the Project Plan Panel.

2. Select the Task to assign Resources. 

3. Click the auto-complete icon in the Resource/Proj Manager column field.

a. The Validate window showing all the available resources opens.

b. From the Validate window, select a resource.

4. Click OK or Save to save the information.

Assigning Resources in the Task Information Window
Resources can be assigned to existing Tasks and new Tasks in the Task 
Information Window.

To assign Resources to existing or new Tasks in the Task Information 
Window:

1. Open the Task Information window. 

2. Click the Details tab.

3. In the Resource field, click the auto-complete list icon.

4. From the Validate window, select a Resource.

5. Click OK or Apply to save the information.

Assigning Multiple Resources in the Task Information Window
Multiple Resources can be assigned to existing Tasks and new Tasks. Once 
multiple Resources have been assigned, their individual effort hours or Booked 
Skill can be adjusted at any time.

To assign multiple Resources to existing or new Tasks in the Task 
Information Window:

1. Open the Task Information window. 

2. Click the Resources tab.
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3. Specify a Resource in the Add Resource to Task auto-complete list.

4. Click Add.

Repeat as necessary.

5. If the Resource has more than one Skill defined, choose the appropriate 
Skill from the auto-complete in the Booked Skill column.

6. To adjust the number of effort hours for a Resource, click the numeric field 
in the Effort (hours) column and enter a new value.

7. Save the information.

Click Apply to store the information and continue to work in the Task 
Information window, or click OK to save the information and close the 
window. The Resource assignments will not be saved until you click either.

Assigning Resource Groups
In order to add Resource Groups, first make sure that the field is enabled in the 
Project Settings. See “Selecting Information to Track and Display” on page 30 
for details.
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Determining Project Resources 
Project Managers can specify users who will be allowed to act as Resources for 
a Project. In the Project Team tab of the Project Settings window, the Project 
Manager can choose to either: 

• Allow all users with the Project option enabled in their Security Groups to 
be Resources for a Project.

Or 

• Allow only those Resources who are specified in the Project Team tab to be 
used as Resources for a Project. These Resources are listed in the tab’s 
Resource table.

See “Setting Up the Project Team” on page 46 for more information about 
setting up the resources in the Project Team tab for a Master Project.

Adding Action Items
Action Items are used to capture important “to do” items that do not require the 
formal definition, tracking, and hierarchical restrictions of a Task. Action 
Items can be added to existing Tasks and new Tasks. Action Items are added in 
the Task Information window.

To add an Action Item to a Task:

1. Open the Task Information window. 

2. In the Task Information window, click the Action Items tab. 

3. Click Add.

The Action Item window opens.

4. Enter information in the required fields and drop down lists.

Select Required = Yes if you want the Action Item to be required. The Task 
will not complete until the Action Item has been completed.

5. Click Add to add the Action Item and continue to create more, or click OK 
to add the Action Item and close the window.

6. Save the Action Item.
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Click Apply to store the information and continue to work in the Task 
Information window, or click OK to save the information and close the 
window. The Action Item will not be saved until you click OK.

7. Save the Task information.

If the Task Information window is opened from the Project Plan Panel, you 
must click OK or Save in the Project window to save the task information.

Adding Notes
Users can enter free-form text in the Notes tab of the Task Information window. 
Saved entries are marked with a timestamp.

To add Notes to a Task:

1. Open the Task Information window. 

2. In the Task Information window, click the Notes tab. 

3. Enter any Notes into the New Notes text field.

To increase the viewable area, click Enlarge.

4. Save the Notes.

Click Apply to store the Notes and continue to work inside the Task 
Information window, or click OK to save the Notes and close the window. 
The Notes will not be saved until you click OK.

5. Click OK or Save in the Project window to save the task information.

The Notes tab can contain up to 32K of information per Project. 
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Setting Up Notifications
Notifications are set up in the Task Information window. 

To set up a Notification for a Task:

1. Open the Task Information window for the Task.

2. In the Task Information window, click the Notifications tab. 

3. Click New.

The Add Notification for Task window opens.

4. In the Setup tab, enter information as described in the Table 5-2 on 
page 96.

The Event drop down list allows you to choose to send a Notification based 
on any of the following criteria:

• The Task has reached a specific state.

• The Task has triggered a particular Exception.

• The Task’s Scheduled Start or Finish date is approaching, has arrived, 
or has passed.

5. To add a new user to the Recipients, click New.

The Add New Recipient window opens.

6. Enter information in the required fields.

7. Click Add to add the new recipient.

Note that the enabled Multi capability of the Username auto-complete list 
enables you to select multiple recipients. Click OK to return to the Add 
Notification for Task window. Click Cancel to return to the Add Notification for 
Task window without saving any changes. 

8. (Optional) In the Add Notification for Task window you can use the Edit and 
Delete buttons to modify the list of recipients. Click Token to view the 
available tokens.

9. (Optional) Click the Message tab in the Add Notification for Task window if 
you want to view and edit the Message Notification Template. 
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10. (Optional) Notifications can be configured to include the Web address 
(URL) for a specific Project or Task. This is referred to as a Smart URL. 
You can include a Smart URL token for the Notification. See the next 
section, Using Smart URLs in Notifications, for more information.

11. Click OK to close the window.

Using Smart URLs in Notifications
Notifications can be configured to include the Web address (URL) for the 
specific Project or Task. When users receive a Notification email and click the 
URL, they are taken directly to the Project or Task. The available Tokens for 
Projects and Tasks are described in Table 5-2.

To use a Smart URL:

1. Follow the procedure described in “Setting Up Notifications” on page 95.

2. Open the Task Information window.

3. Click the Notifications tab. 

4. Click New.

The Add Notification for Task window opens.

5. Click the Message tab.

6. Click Tokens.

Table 5-2. Smart URL Tokens

Smart URL Token Description

PROJECT_URL URL to access the Project Overview page for 
this Project.

WORKBENCH_PROJECT_URL URL to access the Project window for this 
Project in the Workbench.

TASK_URL URL to access the Task Detail page for this 
Task.

WORKBENCH_TASK_URL URL to access the Task window for this Task in 
the Workbench.
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The Token Builder window opens.

7. Click either the Project or Task folder to display the list of Tokens.

The figure above shows the Smart URLs for Projects.

8. In the Token column of the window, select the appropriate Token from the 
list of Tokens, such as CREATED_BY or DEPARTMENT_CODE for 
Projects.

The Token you select displays in the Token field.

9. Select the Token in the Token field.

10. Press Ctrl+c to copy the Token’s name.

11. Click Close to close the Token Builder window.

12. Click in the Notification’s Body text section at the point where you want to 
insert the Smart URL.

13. Press Ctrl+v to paste the Smart URL’s Token in the Body section. 

The figure below shows the Project URL in the Body section of an HTML-
format Notification.
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14. Click OK to close the Add Notification for Task window.

15. Click OK to close the Task Information window.

The email Notification sent from this Task will contain a URL to open a 
specific Project or Task.

Nested Tokens in Notifications
Notifications can be configured to include Project information using Tokens. 
As Project hierarchies become more complex, Token syntax can become 
correspondingly involved. For example, consider a Project with the following 
structure:

Figure 5-1 Project Structure

Master Project

Subproject 1

Task 1

Subproject 2

Task 2
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A Notification from Task 2 can use Tokens to refer to Project information on 
any level above it. The sample Notification below displays the Project Name 
for the Master Project and its Subprojects.

Figure 5-2 Sample Notification 

Entering Cost Data
If Project Management’s Financial Management capability has been enabled 
for this Project, you can track and enter Actual Cost data in the Project window. 
See “Entering Actual Cost Data” on page 240 for more detailed information.

Master Project

Subproject 1

Task 1

Subproject 2

[TSK.PARENT_PROJECT_NAME]

[TSK.MASTER_PROJECT_NAME]

johnsmith@Mercury.com

http://company:8080/mercury/html/mercuryHome.html

Task 2

[PRJ=[TSK.PARENT_PROJECT_ID].PARENT_PROJECT_NAME]
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Attaching References to Tasks
Project Management features a number of methods for capturing additional 
information, or References, related to your Projects. References are attached 
from the Task Information window. 

To attach References to a Task:

1. Open the Task Information window. 

2. In the Task Information window, click the References tab.

3. Attach the Reference.

In the Workbench, users can perform the following Reference activities for 
their Tasks:

• “Attaching Existing Requests” on page 100

• “Attaching New Requests” on page 103

• “Attaching Packages” on page 104

• “Attaching New Packages” on page 107

• “Attaching Tasks” on page 108

• “Attaching Releases” on page 110

• “Attaching Documents” on page 111

• “Attaching URLs” on page 112

Attaching Existing Requests
To attach an existing Request to a Task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Request (Existing) from the New Reference drop down list.

4. Click Add.

The New Reference - Request (Existing) window opens.
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5. To select the Request to attach, use one of the following methods:

• Enter the Request Number in the Request No. field or click the Request 
No. auto-complete list icon to locate and select the Request in a Validate 
window. (Hold down Ctrl+Click or Shift+Click to select more than one 
Request.) The selected Request displays in the Request No. field. If you 
selected multiple Requests, they all display in the Request No. field 
separated by semi-colons. 

• Click Search to search for Requests in a separate query window and 
follow the procedure in “Searching for Requests to Attach” on 
page 102.

6. Select the type of relationship you want to assign between the Task and its 
Reference from the list.

See “Dependency Relationships” on page 113 for a description of the 
various relationships that can be assigned.

7. Click OK. 

You return to the References tab in the Task Information window. The new 
attached Request displays as a Reference.

8. Click OK to close the Task Information window. 

You return to the Project window. 

9. Click Save to save the attached Request as a Reference in the Project.
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Searching for Requests to Attach
To search for Requests to attach to a Task:

1. From the New Reference - Existing Request window, click Search.

A new query window opens.

2. Query for the Request(s) you want to use by entering search criteria in the 
appropriate fields.

3. Click List.

The Requests that match your search criteria display in the Query Results 
section of the window. 

4. Select the Request(s) in the Query Results section that you want to attach to 
a Task.

5. Select the type of relationship you want to assign between the Task and its 
Request.

See “Dependency Relationships” on page 113 for a description of the 
various relationships that can be assigned.

6. Click OK to attach the Request(s) to the Task and close the current window. 

You return to the References tab in the Task Information window. 
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7. After you return to the Task Information window, the new attached Request 
displays as a Reference.

8. Click OK to close the Task Information window.

You return to the Project window.

9. Click Save to save the attached Request as a Reference in the Project.

Attaching New Requests
A new Request can be created from the References tab and immediately 
attached to a Task. This saves time from having to create a new Request in 
Demand Management, searching for it, and attaching it to the Task.

To attach a new Request to a Task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Request (New) from the New Reference drop down list.

4. Click Add.

The New Reference - Request (New) window opens.

5. Select a Request Type from the Request Type auto-complete list.

6. Select the type of relationship you want to assign between the Task and its 
Reference from the list.
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See “Dependency Relationships” on page 113 for a description of the 
various relationships that can be assigned.

7. Click Create.

The standard interface opens with the Request Type loaded.

8. Enter any necessary information in the Request’s fields.

9. Click Save.

The Request is submitted. You return to the References tab in the Task 
Information window. The new attached Request displays as a Reference.

10. Click OK to close the Task Information window.

You return to the Project window. 

11. Click Save to save the attached Request as a Reference in the Project.

Attaching Packages
To attach a Package to a Task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Package from the New Reference drop down list.

4. Click Add.

The New Reference - Package window opens.
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5. To select a Package for an attachment, use one of the following methods:

• Enter the Package Number in the Package No. field or click the Package 
No. auto-complete list icon to locate and select the Package in the 
Validate window. (Hold down Ctrl+Click or Shift+Click to select more 
than one Package.) The selected Package displays in the Package No. 
field. If you selected multiple Packages, they all display in the Package 
No. field separated by semi-colons. 

• Click Search to search for Packages in a separate query window and 
follow the procedure in “Searching for Requests to Attach” on 
page 102.

6. Select the type of relationship you want to assign between the Task and its 
Reference from the list.

See “Dependency Relationships” on page 113 for a description of the 
various relationships that can be assigned.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached Package displays as a Reference.

8. Click OK to close the Task Information window.

You return to the Project window. 

9. Click Save to save the attached Package as a Reference in the Project.

Searching for Packages to Attach
To search for Packages to attach to a Task:

1. From the New Reference - Existing Package window, click Search.

A new query window opens.
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2. Query for the Package(s) you want to use by entering search criteria in the 
appropriate fields.

3. Click List. 

The Packages that match your search criteria display in the Query Results 
section of the window. 

4. Select the Package(s) in the Query Results section that you want to attach to 
a Task.

5. Select the type of relationship you want to assign between the Task and its 
Reference from the list.

See “Dependency Relationships” on page 113 for a description of the 
various relationships that can be assigned.

6. Click OK to attach the Package(s) to the Task and close the current 
window.

You return to the References tab in the Task Information window. The new 
attached Package displays as a Reference.

7. Click OK to close the Task Information window.

You return to the Project window.
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8. Click Save to save the new Package as a Reference in the Project.

Attaching New Packages
A new Package can be created from the References tab and immediately 
attached to a Task. This saves time from having to create a new Package in 
Change Management, searching for it, and attaching it to the Task.

To attach a new Package to a Task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Package (New) from the New Reference drop down list.

4. Click Add.

The New Reference - Package (New) window opens.

5. Click Create.

The Package window opens.

6. Enter any necessary information in the Package’s fields.

7. Click Save.

The Package is submitted. You return to the References tab in the Task 
Information window. The new attached Package displays as a Reference.

8. Click OK to close the Task Information window.
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You return to the Project window. 

9. Click Save to save the attached Package as a Reference in the Project.

Attaching Tasks
To attach a Task to a Task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Task from the New Reference drop down list.

4. Click Add.

The New Reference - Task window opens.

5. To select a Task for attachment, use one of the following methods:

• Enter the Task Name in the Task Name field or click the Task Name 
auto-complete list icon to locate and select the Task in a Validate 
window. (Hold down Ctrl+Click or Shift+Click to select more than one 
Task.) The selected Task displays in the Task Name field. If you 
selected multiple Tasks, they all display in the Task Name field 
separated by semi-colons. 

• Click Search to search for Tasks in a separate query window and 
follow the procedure in “Searching for Requests to Attach” on 
page 102.
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6. Select the type of relationship you want to assign between the Task and its 
Reference from the list.

See “Dependency Relationships” on page 113 for a description of the 
various relationships that can be assigned.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached Task displays as a Reference.

8. Click OK to close the Task Information window. 

You return to the Project window. 

9. Click Save to save the attached Task as a Reference in the Project.

Searching for Tasks to Attach
To search for Tasks to attach to a Task:

1. From the New Reference - Task window, click Search.

A new query window opens.

2. Query for the Task(s) you want to use by entering search criteria in the 
appropriate fields.
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3. Click List.

The Tasks that match your search criteria display in the Query Results 
section of the window. 

4. Select the Task(s) in the Query Results section that you want to attach to a 
Task.

5. Select the type of relationship you want to assign between the Task and its 
attachment from the list.

See “Dependency Relationships” on page 113 for a description of the 
various relationships that can be assigned.

6. Click OK to attach the Task(s) to the Task and close the current window. 

You return to the References tab in the Task Information window. The new 
attached Task displays as a Reference.

7. Click OK to close the Task Information window.

You return to the Project window.

8. Click Save to save the attached Task as a Reference in the Project.

Attaching Releases
To attach a Release to a Task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Release from the New Reference drop down list.

4. Click Add.

The New Reference - Release window opens.
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5. To select a Release for an attachment, enter the Release Name in the 
Release Name field or click the Release Name auto-complete list icon to 
locate and select the Release in a Validate window. (Hold down Ctrl+Click 
or Shift+Click to select more than one Release.) The selected Release 
displays in the Release Name field. If you selected multiple Releases, they 
all display in the field separated by semi-colons. 

6. Select the type of relationship you want to assign between the Task and its 
Reference from the list.

See “Dependency Relationships” on page 113 for a description of the 
various relationships that can be assigned.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached Release displays as a Reference.

8. Click OK to close the Task Information window.

You return to the Project window.

9. Click Save to save the attached Release as a Reference in the Project.

Attaching Documents
To attach a Document to a Task:

1. Open the Task Information window.

2. Click the References tab.
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3. Select Attachment from the New Reference drop down list.

4. Click Add.

The New Reference - Attachment window opens.

5. To select a Document for an attachment, click the File Chooser icon.

Open the drive and directory where the file you want to attach is located 
and select it. The name of the Document displays in the Attachment field.

6. Enter a description in the Description field.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached Document displays as a Reference.

8. Click OK to close the Task Information window.

You return to the Project window.

9. Click Save to save the attached Document as a Reference in the Project.

Attaching URLs
To attach a URL to a Task:

1. Open the Task Information window.

2. Click the References tab.

3. Select URL from the New Reference drop down list.

4. Click Add.
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The New Reference - URL window opens.

5. Enter the name of the URL in the URL field.

6. Enter a description in the Description field.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached URL displays as a Reference.

8. Click OK to close the Task Information window.

You return to the Project window.

9. Click Save to save the attached URL as a Reference in the Project.

Dependency Relationships
The dependency relationships available when you attach References of various 
types to a Task are described in Table 5-3.

Table 5-3. Dependency Relationships

Relationship Description

Adding Requests to Tasks

FF Predecessor The Task does not complete until the selected 
Request closes.

Predecessor Action is not allowed on this Task until the selected 
Request closes.

Related to this Task The selected Request is related to this Task.

Successor No Action is allowed on the selected Request until 
this Task closes.
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Configuring Task Predecessors
Task predecessors are configured from the Project Plan Panel. A predecessor is 
a Task or Project that has a defined relationship between its start or finish date, 
and the start or finish dates of the Task that is dependent on it.

When Request References are attached to a Task, they can also act as 
predecessors for the dependency relationship you assign to them. For instance, 
if you assign a Predecessor relationship between a Task and a Request that has 
been attached to the Task as a Reference, action is not allowed on this Task 
until the Request closes. 

See “Attaching References to Tasks” on page 100 for more information on 
how to assign relationships between Tasks and References.

See “Dependency Relationships” on page 113 for a list of the dependency 
relationships and their descriptions.

See “Setting Up Project Dependencies” on page 63 for more detailed 
information on setting Task and Project Predecessors.

Task Updated by Request This Task is automatically updated by the selected 
Request.

Adding Packages to Tasks

Related to this Task The Referenced Package is related to this Task.

Adding Projects to Tasks

Related to this Task Referenced Project is related to this Task.

Adding Releases to Tasks

Related to this Task Referenced Release is related to this Task.

Adding Tasks to Tasks

Related to this Task The Referenced Task is related to this Task.

Table 5-3. Dependency Relationships

Relationship Description
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Changing the Task State
There are two methods for changing a Task’s state. A Task’s state can be 
changed from inside the Project window, or in its Task Information window.

To change a Task’s state from the Project window

1. States can be changed for existing Tasks and new Tasks.

• If you are changing the state of an existing Task, query and open an 
existing Project.

• If you are changing the state of a newly created Task, you are already in 
the Project Plan Panel.

2. In the Project Plan Panel, select a new state for the Task from the drop 
down list in the State column.

To change a Task’s state from its Task Information window

1. Open the Task Information window. 

2. Select the new Task state from the Task State drop down list at the top of 
the window.

3. Click OK.

4. Click Save to save the Task state changes.

Setting Scheduling Constraints
Scheduling constraints prevent certain changes to a schedule. If a Project 
Manager attempts to schedule a constrained Task outside of its constraint, 
Project Management will alert the user to the conflict and reset the date to its 
previous value. Scheduling constraints are set in the Task Information window. 

To set a Task’s scheduling constraints:

1. Open the Task Information window. 

2. Click the Details tab in the Task Information window.
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3. Under Scheduling Constraints, select the type of constraint you want to use 
from the Constraint Type drop down list.

4. Enter a date in the Constraint Date field.

5. Click OK.

Configuring User Data
User Data is the set of custom fields that can be defined for various Project 
Management entities. User Data fields can be used to capture data not covered 
by the default Project/Task information fields, such as Cost. These fields are 
accessed through the User Data tab in the Task Information window. If no User 
Data has been defined for a particular entity, the tab is disabled. 

Project/Task User Data Roll-Up
Values from Task User Data fields can be configured to “roll up” 
(combine/process values in a meaningful way) into parent Project User Data 
fields. The following types of Task User Data can roll up into Project User 
Data:

• Numeric fields (Text Field component type with Numeric data mask)

• Date fields

For each Project, a Project User Data field can show a roll-up of Task User 
Data values using one of the following methods:

• Average
Shows the average of all values of a specified Task User Data field for 
every Task under the Project (Numeric fields).

• Maximum
Shows the largest of all values of a specified Task User Data field for every 
Task under the Project (Numeric and Date fields).

• Minimum
Shows the smallest of all values of a specified Task User Data field for 
every Task under the Project (Numeric and Date fields).

• Sum
Shows the summation of all values of a specified Task User Data field for 
every Task under the Project (Numeric fields).
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Project/Task User Data Roll-Up can be used to capture various important 
aspects of a Project.

Creating Project/Task User Data Roll-Up 
User Data must be configured for Projects and Tasks before specifying Roll-
Up Methods. 

1. Create and configure Project and Task User Data fields.

2. Link Project and Task User Data fields with Roll-Up Method.

Example: Using Project/Task User Data Roll-Up

Company X would like to capture total cost for its Projects. Total Project cost 
in this case is to be calculated by adding the costs of individual Tasks. User 
Data fields for Task cost and Project total cost are each defined. The 
relationship is illustrated below:

Figure 5-3 User Data Roll-Up 

Using the “Average” Roll-Up Method, the average cost of all a Project’s 
Tasks can be easily determined and automatically recalculated each time a 
Task is updated.

Using the “Maximum” Roll-Up Method, the latest date out of a Project’s 
Tasks can be captured.

Using the “Minimum” Roll-Up Method, the earliest date out of a Project’s 
Tasks can be captured.

Using the “Sum” Roll-Up Method, the total cost of a Project’s Tasks can be 
easily determined and automatically recalculated each time a Task is updated.

Task Cost UD

Task Cost UD

Task Cost UD

Project Total Cost UD(sum)
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Each Task has its own Cost User Data field. The values for each Task Cost 
User Data field are rolled up using the “Sum” Roll-Up Method into the Project 
Total Cost User Data field.

Figure 5-4 User Data Roll-Up Example 

Once Project and Task User Data fields have been configured and saved, the 
Roll-Up relationship can be specified.

To specify the Roll-Up Method:

1. In the Workbench, click the Configuration screen group.

2. Click the User Data icon.

The User Data Workbench opens.

+

=
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3. Select Project User Data from the User Data Type drop down list.

4. Click List.

The Results tab opens with the Project User Data Type loaded.

5. Select the Project User Data and click Open.

6. Click the Roll-Up tab.

7. Click New.

The Add New Roll-Up window opens.
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8. Select the Project User Data Field that will contain rolled-up Task User Data 
values.

9. Select the Task User Data Field whose values will roll up into the chosen 
Project User Data Field.

10. Select the Roll-Up Method from the drop down list.

The drop down list will only display valid options for the data types of the 
Project and Task User Data Fields.

11. Select Yes to enable the Roll-Up.

12. Click OK.

The Roll-Up relationship is added to the Roll-Up tab.

13. Click Save.

Editing Project/Task User Data Roll-Up 
Project/Task User Data Roll-Up can be edited from the Workbench once it has 
been created.

Only two User Data fields of the same type can be selected for Roll-Up (for 
example, a Numeric field cannot roll up into a Date field, nor vice versa).

While a Task User Data field can have multiple Roll-Up relationships 
associated with it, a Project User Data field cannot have more than one Roll-
Up relationship defined.
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To edit a Project/Task User Data Roll-Up relationship:

1. In the Workbench, click the Configuration screen group.

2. Click the User Data icon.

The User Data Workbench opens.

3. Select Project User Data from the User Data Type drop down list.

4. Click List.

The Results tab opens with the Project User Data Type loaded.

5. Select the Project User Data and click Open.

6. Click the Roll-Up tab.

7. Select the Roll-Up relationship to edit.
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8. Click Edit.

The Edit Roll-Up window opens.

9. Make any desired changes to the Project/Task User Data Field or Roll-Up 
Method.

10. Click OK.

The Roll-Up definition is updated in the Roll-Up tab.

11. Click Save.

Deleting Project/Task User Data Roll-Up 
Project/Task User Data Roll-Up can be deleted. This deletion only removes the 
Roll-Up relationship; it does not delete the referenced User Data fields.

To delete a Project/Task User Data Roll-Up relationship:

1. In the Workbench, click the Configuration screen group.

2. Click the User Data icon.

The User Data Workbench opens.
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3. Select Project User Data from the User Data Type drop down list.

4. Click List.

The Results tab opens with the Project User Data Type loaded.

5. Select the Project User Data and click Open.

6. Click the Roll-Up tab.

7. Select the Roll-Up relationship to remove.

8. Click Remove. 

9. Click Save.

Example: Creating and Using Project/Task User Data Roll-Up
Company X wants to capture the total cost of any Project. This value will be 
calculated as the sum of all Task costs. They also want the calculated cost to be 
updated every time a Task cost is changed. They will accomplish this using 
Project/Task User Data Roll-Up.

To create Project/Task User Data Roll-Up that will calculate total Project 
cost:

1. In the Workbench, click the Configuration screen group.

2. Click the User Data icon.

The User Data Workbench opens.
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3. Create the Project User Data field.

a. Select Project User Data from the User Data Type drop down list.

b. Click List.

The Results tab opens with the Project User Data Type loaded.

c. Open the Project User Data Type.

d. Click New in the Fields tab.

The Field: New window opens.

e. Fill in the following information:

Field Value

Field Prompt Total Cost

Token (any useful token)

Description (any useful description)

Validation Numeric Text Field

Enabled Yes

User Data Col (any available User Data column)

Display Only Never

Display Yes

Required Never

Workbench Only No
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f. Click OK in the Field: New window.

g. Click OK in the Project User Data window to save the new field.

4. Create the Task User Data field.

a. In the User Data Workbench Query tab, select Task User Data from the 
User Data Type drop down list.

b. Click List.

The Results tab opens with the Task User Data Type loaded.

c. Open the Task User Data Type.

d. Click New in the Fields tab.

The Field: New window opens.

e. Fill in the following information:

Field Value

Field Prompt Cost

Token (any useful token)

Description (any useful description)

Validation Numeric Text Field

Enabled Yes

User Data Col (any available User Data column)
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f. Click OK in the Field: New window.

g. Click OK in the Task User Data window to save the new field.

5. Create the Roll-Up relationship between the Task and Project User Data 
fields.

a. In the User Data Workbench Query tab, select Project User Data from 
the User Data Type drop down list.

b. Click List.

The Results tab opens with the Project User Data Type loaded.

c. Open the Project User Data Type.

d. Click the Roll-Up tab.

Display Only Never

Display Yes

Required Never

Workbench Only No

Field Value
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e. Click New. The Add New Roll-Up window opens.

f. Select the Total Cost Project User Data Field that will contain the rolled-
up Cost Task User Data cost values.

g. Select the Cost Task User Data field whose values will roll up into the 
Total Cost Project User Data field.

h. Select Sum from the Roll-Up Method drop down list.

i. Click OK.

The Roll-Up relationship is added to the Roll-Up tab.

j. Click Save.
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To use the Roll-Up relationship, no further configuration is necessary. The 
rolled-up fields are accessible from the User Data tab of the respective Project 
or Task.

Each Task has its own Cost User Data field. The values for each Task Cost 
User Data field are rolled up using the “Sum” Roll-Up Method into the Project 
Total Cost User Data field.
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Figure 5-5 User Data Roll-Up Example 

+

=
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 Chapter

Managing a Project

This chapter describes how to oversee a Project from inception to completion 
using Project Management.

The following topics are covered:

• Managing a Project, An Overview

• Setting Up a Project

• Adding Tasks to a Project

• Taking a Baseline

• Revising the Project

• Updating the Schedule

• Viewing Project and Task Progress

• Analyzing Project Costs

• Tracking Project History

• Completing, Cancelling, and Deleting Projects

• Creating a URL to Open the Project Window

• Printing a Project Gantt Chart

Managing a Project, An Overview
Business initiatives can be divided into a set of goals that must be met through 
the completion of measurable tasks by an assigned group of people. The tasks 
must be monitored to determine if they are on schedule. In order to provide 
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organization and structure for these activities, a Project Manager is responsible 
for managing the work group and Project.

Some common responsibilities for Project Managers include:

• Organizing and assigning Tasks.

• Tracking Task and Project progress, and ensuring that assigned Tasks are 
completed on time.

• Communicating Project status to participants and stakeholders, including 
the appropriate escalation of Project-related issues.

Project Managers can integrate and streamline these responsibilities using the 
features of Project Management. The following sections provide instructions 
for performing common Project Management tasks, such as setting up a 
Project and tracking its status.

This chapter discusses:

• Setting Up a Project
Every Master Project contains a set of options to configure that are specific 
to the Project, such as what information is tracked and displayed, the rules 
for the display of indicators and exceptions, scheduling, and who can view 
Tasks and Projects.

• Adding Tasks to a Project
After the global options have been configured for a Master Project, Tasks 
and Subprojects can be arranged and ordered into a meaningful hierarchy.

• Taking a Baseline
Project Managers can take a baseline of their Projects, which can be used to 
monitor a Project plan’s changes as it moves through its life cycle.

• Revising the Project
Project Managers can move their Projects into different Project “states.” 
These states help Managers to maintain visibility and control over a 
Project.

In Project Management, Project Managers are those users who have Power 
licenses and specific Project Manager Access Grants. See Security Model 
Guide and Reference for details.
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• Updating the Schedule
After making revisions, a Project Manager might find it necessary to 
reschedule the Project. This includes recalculating Start and Finish dates.

• Viewing Project and Task Progress
Managers can search for Projects and Tasks, as well as track a particular 
Project’s progress using its Summary Condition. Any exceptions that have 
been triggered can also be displayed.

• Analyzing Project Costs
Project Cost data can be collected and analyzed by the Project Manager to 
track budgets, compare Project sizes, or spot potential trouble.

• Tracking Project History
Project history is maintained and can be viewed for Projects and Tasks.

• Creating a URL to Open the Project Window
Project Managers and can construct a URL that opens their Project in the 
Workbench.

• Printing a Project Gantt Chart
Project Managers can print the Project Gantt chart, with a wide range of 
filtering options. The Project Gantt chart can also be exported to an image 
file and used in presentations.

When a user creates or edits a Project or Subproject, that user is the only one 
able to save changes.

In the case of two users wanting to edit two different Subprojects under one 
Master Project, opening and editing only the desired Subprojects will enable 
each user to save changes without interfering with each other.

See “Concurrent Editing” on page 142 for more detailed information.

When you import a large Microsoft Project (or a large number of projects) 
into Project Management, tables in the Mercury ITG database are updated to 
handle this new configuration. Because of the scope of database changes, 
you should re-run the Database Statistics on your Mercury ITG Database. 
Contact your application administrator for help with this procedure.
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Setting Up a Project
Project Management’s Master Project entity is made up of the following 
components:

• Tasks

• Subprojects

• Activities

• Notes

• Packages 

• Requests 

• References 

These components are used to define and process a specific business initiative. 
The Master Project also contains a number of global settings that can be 
configured to suit a particular Project’s objectives. See the following sections 
for more information on setting up a Project:

• “Selecting Information to Track and Display” on page 30

• “Setting Up Exception Behavior” on page 31

• “Setting Up Indicators” on page 37

• “Setting Scheduling Options” on page 38

• “Setting Security Restrictions” on page 43

• “Setting Up the Project Team” on page 46

• “Setting Up Microsoft Project Integration” on page 48

• “Configuring Cost in the Project Settings Window” on page 237

• “Establishing a Project Baseline” on page 74

Adding Tasks to a Project
Once the Master Project has been configured, the Project Manager can add 
Tasks to the Project and specify Task details, including assigning resources or 
resource groups. Tasks can be added individually or in a pre-sequenced group 
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with a Project Template. Tasks can also be organized in a hierarchical fashion 
quickly and easily.

Taking a Baseline
A baseline is the original approved Project plan for a Project.  As scope 
changes happen, the baseline is updated to reflect those changes as part of the 
approved plan. A Project Manager uses baselines to continuously monitor the 
health of their Project in terms of schedule and cost by comparing the current 
Project plan to the baseline plan.

See “Establishing a Project Baseline” on page 74 for more detailed 
information about taking and using Project baselines.

Revising the Project
Project plans rarely remain unchanged during a Project’s life. Revisions are 
commonly made to accommodate Project updates, reorganizations and 
reassignments. Project Management enables Project Managers to revise their 
plan quickly. This section discusses the following aspects of revising a Project:

• Viewing and Modifying Project Hierarchy

• Project States

• Updating Scheduling and Dependencies

• Concurrent Editing

See the following chapters and sections for more details on including Tasks 
in a Project:

• “Adding Tasks to a Project” on page 52

• “Creating a Task From a Request” on page 84

• “Configuring Tasks” on page 81

• “Using Project Templates” on page 199

• “Entering Actual Cost Data” on page 240
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Viewing and Modifying Project Hierarchy
The ordering and grouping of Tasks and Subprojects is graphically displayed 
in the Project Plan Panel.

Figure 6-1 Project Window with Project Plan Panel

Use the directional arrow buttons to reorganize the Project hierarchy. Tasks 
can be grouped and ordered into Subprojects, using the right arrow  to 
indent. Subprojects can have their tasks removed and made into separate Tasks 
using the left arrow  to outdent. Top-to-bottom reordering can be performed 
on Subprojects and Tasks as well, using the up  and down  arrows. For 
step-by-step instructions, see “Setting Up Project Hierarchy” on page 55.

When a user creates or edits a Project or Subproject, that user is the only one 
able to save changes. All other users will be warned of this before attempting 
to edit a Project or Subproject that is already open.

In the case of two users wanting to edit two different Subprojects under one 
Master Project, opening and editing only the desired Subprojects from the 
Project Workbench will enable each user to save changes without interfering 
with each other.
136 Managing a Project



Managing Your Projects (Project Management)
Project States
To display the different stages in a Project’s life from planning to completion, 
a Master Project can have various states associated with it. These states are 
New, Plan, Active, Completed and Cancelled. Project Managers can move 
Projects into different states to facilitate the work associated with that stage of 
the Project. The following table describes the various Project states, their 
behaviors, and applications.

Table 6-1. Project States and Descriptions 

Project State Behavior Application

New Projects and their Tasks are not shown in 
the My Tasks Portlet or the Dashboard.

Notifications are not sent and Exceptions 
are not triggered.

All Projects start in this state. Once a 
Project is moved out of the ‘New’ state it 
becomes permanently visible and cannot 
return to this state.

This state allows a Project Manager to 
manipulate the Project without having to 
notify Participants or Stakeholders.

On Hold Projects and their Tasks are displayed in 
My Tasks and the Dashboard but cannot be 
edited.

Notifications are not sent and Exceptions 
are not triggered.

Hierarchy can be modified.

This state allows a Project Manager to 
manipulate the Project (such as 
changing project hierarchy and revising 
predecessors). This state informs 
Participants and other Managers that a 
rework is being done.

Active Projects and their Tasks can be seen in My 
Tasks and in the Dashboard.

Notifications are sent and Exceptions are 
triggered.
Project structure can change.

This is the state of a Project that is 
actively being managed. 

Completed Projects and their Tasks can be seen in the 
Dashboard but not in My Tasks.

Notifications are not sent and Exceptions 
are not triggered.

This is the state of a Project that has 
been worked to completion. The Project 
can be edited but will not show up as a 
Project or Task that needs attention.
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Project Management also features a set of Task states. For a list of Task states, 
see “Task States” on page 83.

Modifying States
Project Managers can change states at the Master Project, Subproject, or Task 
level at any time.

To change the state of the Master Project:

1. Open the Project to edit.

For more details on searching for and opening Projects, see “Searching for 
Projects in the Workbench” on page 144.

2. In the Project Plan Panel, select the row at the top of the hierarchy.

This is the Master Project.

3. Select a new State for the Master Project from the drop down list in the 
State column.

4. Click Save.

To change the state of a Task, Subproject, or group of Tasks or 
Subprojects:

1. Open the Project to edit.

For more details on searching for and opening Projects, see “Searching for 
Projects in the Workbench” on page 144.

2. In the Project Plan Panel, select the Task or Subproject whose state you 
want to change.

Cancelled Projects and their Tasks can be seen in the 
Dashboard but not in the My Tasks Portlet.

Notifications are not sent and Exceptions 
are not triggered.

This state is used for Projects that are 
not complete but will not be worked on.

Table 6-1. Project States and Descriptions  [continued]

Project State Behavior Application
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When selecting a group of Tasks or Subprojects, be sure they are all in the 
same state.

3. Select a new State for the Task or Subproject from the drop down list in the 
State column.

4. Click Save.

Updating Scheduling and Dependencies
Project Managers are able to update aspects of a Project at any time to reflect 
the changing state of a business initiative. The following sections discuss 
updating Project scheduling and dependencies in more detail:

• Changing Scheduled Duration, Start, Finish, and % Complete

• Changing Predecessors

• Changing Resource Assignments

Changing Scheduled Duration, Start, Finish, and % Complete
The Scheduled Duration, Scheduled Start, Scheduled Finish, and % Complete fields 
are viewed in the Project Plan Panel.

To change Scheduled Duration, Start, Finish, or % Complete for a Task:

1. Open the Project to edit.

For more details on searching for and opening Projects, see “Searching for 
Projects in the Workbench” on page 144.

2. In the Project Plan Panel, select the Task to update. 

• Tasks can be edited directly inside the Project Plan Panel. Click on a 
field to edit its contents.

• Tasks can also be edited through the Task Information window, which 
displays more detailed information on a Task.

3. Click Edit.

The Project or Task Information window opens, depending on whether you 
have selected a Project or Task.
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4. In the Task Information window, click the Details tab. 

5. Update fields in the Details tab.

To update Scheduled Start and Finish dates, enter the desired date in the 
appropriate date field. To make sure these dates are set explicitly and will 
not change after the Schedule Project button is clicked, select a Constraint 
Type (such as Start No Earlier Than or Finish No Earlier Than) from the 
Constraint Type drop down list.

To update Scheduled Duration and % Complete, enter the new information 
into the appropriate text field.

6. Apply the changes.

To apply changes to the Task and continue to update the Task without 
closing, click Apply. To apply changes and close the window, click OK.

If you want to update a Subproject’s Scheduled Duration, Start, Finish, or % 
Complete, you must update its individual Tasks’ values. This is accomplished 
by selecting a Task in the Project window and clicking Edit. You can then 
follow the process described below.
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Changing Predecessors
You can specify which Tasks must be completed before beginning another 
Task. The Tasks that first need to be completed are Predecessors of the 
dependent Task. Predecessors can be changed directly in the Project Plan 
Panel.

External Tasks, Projects, and Requests can also be set as Predecessors for 
Tasks. For more information on setting these types of Predecessors, see 
“Setting Up Project Dependencies” on page 63.

To change the Predecessors for a particular Task:

1. Open the Project to edit.

For more details on searching for and opening Projects, see “Searching for 
Projects in the Workbench” on page 144.

2. In the Project Plan Panel, click the row that contains the Task or Subproject 
to update.

3. To update Predecessors, enter the sequence numbers of the new 
Predecessors, separated by semicolons, into the text field of the dependent 
Task.

Changing Resource Assignments
Resources can be changed directly in the Project Plan Panel.

To update Resources:

1. Open the Project to edit.

For more details on searching for and opening Projects, see “Searching for 
Projects in the Workbench” on page 144.

2. In the Project Plan Panel, click on the Resource field of the Task to update.

3. Update the field with the new information.

To update Resources, select the user that you want to assign from the 
Resource auto-complete list.
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Concurrent Editing
Project Management allows users to edit and update parts of Projects 
simultaneously, allowing for more efficient representation of changes to a 
Project. The following scenarios help illustrate how concurrent editing in 
Project Management works:

• Unrelated Subprojects in a Master Project

• Simultaneous Edits on a Project

• Simultaneous Editing and Updating of a Task

• Updating an Unrelated Task

Unrelated Subprojects in a Master Project
Yukio and Bob are Project Managers with access to the same Master Project.

1. Yukio opens the Master Project and begins working on one of its 
Subprojects.

2. Bob opens the same Master Project and begins working on a different 
Subproject.

3. Yukio and Bob are both able to save their changes.

Simultaneous Edits on a Project
Yukio and Bob are Project Managers with access to the same Master Project.

1. Yukio opens the Master Project and begins working on one of its 
Subprojects.

2. Bob opens the same Master Project and tries to edit part of the same 
Subproject Yukio is working on.

3. Bob receives a message that another user is currently editing that part of 
the Project. Bob cannot make changes.

Simultaneous Editing and Updating of a Task
Yukio is a Project Manager and Carlos is a Resource assigned to one of the 
Tasks in Yukio’s Master Project.

1. Yukio opens the Master Project and begins working on one of its 
Subprojects.
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2. Carlos would like to update his Task, which is part of the Subproject Yukio 
is currently editing.

3. Carlos receives a message that another user is currently editing that part of 
the Project. Carlos cannot make changes.

Updating an Unrelated Task
Yukio is a Project Manager and Carlos is a Resource assigned to one of the 
Tasks in Yukio’s Master Project.

1. Yukio opens the Master Project and begins working on one of its 
Subprojects.

2. Carlos opens his Task, which is not part of the Subproject Yukio is 
working on, and makes his changes successfully.

3. Yukio opens Carlos’s Task.

4. Yukio receives a message that the Task has been updated, and the newest 
data will be loaded.

5. The information for Carlos’s Task is refreshed in Yukio’s Workbench 
window, while the other changes Yukio made persist.

Updating the Schedule
If you have modified any of your Project’s hierarchy, dependencies, resources 
or dates, you might want to re-level the schedule. Project Management 
generates a new schedule based on the updated dates, and whatever 
preferences have been set in the Settings window.

For more detailed information on updating a schedule, see “Generating the 
Schedule” on page 71.

You can also want to create a new baseline for the Project. See “Taking a 
Baseline” on page 76 for more detailed information.
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Viewing Project and Task Progress
As a Project moves through its life, Managers can keep track of:

• Projects and Tasks as they are completed

• Exceptions that have been triggered

• High-level and low-level accounts of progress

Project Management provides this information through Project Management 
Reports and the Summary Condition View.

Searching for Projects in the Workbench
The Query tab in the Project Workbench window is used to locate and open 
Projects.

To open Projects in the Workbench:

1. Click the Project Mgmt screen group.

2. Click the Projects icon.

The Project Workbench opens. 

When a user creates or edits a Project or Subproject, that user is the only one 
able to save changes. 

In the case of two users wanting to edit two different Subprojects under one 
Master Project, opening and editing only the desired Subprojects will enable 
each user to save changes without interfering with each other.

See “Concurrent Editing” on page 142 for more detailed information.
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3. Enter search criteria into the appropriate fields in the Query tab.

4. To save your query, click Save Query.

You can then perform a quick search using these specified criteria later. To 
clear all information entered into the Project Query fields, click Clear.

5. Click List to return the matching results in the Results tab.

6. From within the Results tab you can:

• Sort the results based on any field in the table by clicking on the 
column header.

• View a Project by double-clicking on the desired Project or selecting it 
and clicking Open.

• Open multiple Projects by selecting a group (using Shift+Click or 
Ctrl+Click from your keyboard) and clicking Open.

Searching for Tasks in the Workbench
You can locate Tasks using the Query tab in the Task Workbench window.

To locate specific Tasks in the Workbench:

1. Click the Project Mgmt screen group.

2. Click the Projects icon.

The Project Workbench opens. 
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3. Select the Task Workbench, behind the Project Workbench, by either 
clicking on its title bar or the Task Workbench button at the bottom of the 
Workbench window.

4. Enter search criteria into the appropriate fields in the Query tab.

5. To save your query, click Save Query.

You can then perform a quick search using these specified criteria later. To 
clear all information entered into the Task Query fields, click Clear.

6. Click List to return the matching results in the Results tab.

7. From within the Results tab you can:

• Sort the results based on any field in the table by clicking on the 
column header.

• View a Task by double-clicking on the desired Task or selecting it and 
clicking Open.

• Open multiple Tasks by selecting a group (using Shift+Click or 
Ctrl+Click from your keyboard) and clicking Open.

Viewing the Summary Condition
The Summary Condition is a graphical indicator of the health of a Project, 
located next to the Project name. A Project’s Summary Condition color begins 
as green and changes to yellow or red depending on the percentage of Tasks 
within a Project that have triggered Exceptions. This percentage is 
configurable in this tab by the Project Manager. A Project’s Summary 
Condition is not calculated until the Project is saved.
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The Summary Condition View appears in its own column next to the names of 
all Projects in the Results tab of the Project Workbench. For more detailed 
information, see “Summary Condition” on page 35.

Viewing Milestones
In the Workbench, Milestones are visible in the Project window as black 
diamonds in the Gantt chart.

Figure 6-2 Gantt Chart with Milestones

The Project Overview page in the standard interface contains two Portlets that 
display Milestones:

• The Project Milestones Portlet lists the Milestones in a Project.

Figure 6-3 Project Milestones Portlet
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• The Project Overview Gantt Portlet shows the Project’s Gantt chart, 
including Milestones.

Figure 6-4 Project Overview Gantt Portlet with Milestones

Viewing the Project Critical Path
A Project’s critical path is composed of all of the Tasks in a Project that 
determine its duration. In Project Management, the critical path of a Project 
can be displayed in the Project window’s Gantt chart. Tasks that are part of the 
critical path are cross-hatched.

Figure 6-5 Gantt Chart With Critical Path

There are several ways to display or access a Project’s critical path. See the 
following sections for more detailed information:

• Viewing the Critical Path in the Project Window

• Viewing the Critical Path from the Project Overview Gantt Portlet

• Obtaining a Critical Path Table
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Viewing the Critical Path in the Project Window
A Project’s critical path can be displayed in the Project window’s Gantt chart. 

To see a Project’s critical path:

1. In the Workbench, open the Project.

For more details on searching for and opening Projects, see “Searching for 
Projects in the Workbench” on page 144.

2. Click Display Options in the upper-right corner of the Project window.

The Gantt Options window opens.

3. Select the Highlight Critical Path check box.

4. Click OK.

5. The Project window’s Gantt chart displays the Project’s critical path.

Viewing the Critical Path from the Project Overview Gantt Portlet
A Project’s critical path can also be viewed from the Project Overview Gantt 
Portlet in the Project Overview page of the standard interface.

To see a Project’s critical path in the Project Overview Gantt Portlet:

1. Navigate to the Project Overview page of the Project.

For more detailed information, see “Searching for Tasks and Projects” on 
page 168.

2. Scroll down to the Project Overview Gantt Portlet and click Edit.

The filter page for the Project Overview Gantt Portlet opens.
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3. In the Display Options section of the filter page, select the Highlight Critical 
Path check box.

4. Click Done.

5. The Project Overview page opens, refreshing all of the Portlets including the 
Project Overview Gantt Portlet.

Obtaining a Critical Path Table
The Project Critical Path Report generates a list of all the Tasks that comprise a 
Project’s critical path in convenient HTML form.

Figure 6-6 Project Critical Path Report 

For more information on running Reports in Project Management, see “Project 
Management Reports” on page 249.
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Viewing Exceptions
Exceptions indicate that a rule that has been defined in the Project has been 
violated for a particular Task. For example, Resources have not been assigned 
to a Task that is due to begin soon, or a Task is being completed a certain 
number of days late. Exception Rules are configurable; for more detailed 
information, see “Setting Up Exception Behavior” on page 31.

Exceptions that have been triggered display as a red exclamation mark in the 
first column on the left in the Results tab of the Task Workbench.

To view a particular triggered Exception for a Task:

1. Select a Task in the Project Plan Panel.

2. Click Edit.

The Task Information window opens.

3. Click the Exceptions tab.

Depending on whether you have the proper Access Grant to edit the Task, 
the button in the Project Window might read Edit or View. Users who can only 
View a Task include Project Participants who have not been assigned to that 
particular Task, as well as Project Managers who are not managing the 
Project within which that particular Task is contained.
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The Exceptions tab lists the Exception Rules for the Project containing that 
particular Task. 

• The red exclamation point in the Triggered column indicates that the 
Task has triggered an Exception. 

• The Violation column displays the number of days the Task is from the 
Exception.

Using the Mercury ITG Dashboard to View Progress
Project Managers can also view Projects using the standard interface. This 
interface comes with a configurable set of application windows, known as 
Portlets, through which common Project Management queries and actions can 
be performed.

This interface can be expanded to include the Mercury ITG Dashboard, which 
offers an expanded set of Portlets that feature additional functionality, such as 
the Project List Portlet. 

Project Management Reports
Project Management is capable of generating a wide range of reports for 
project management purposes. For example, a Manager could query for the 
custom fields being used in a Project. A Manager can also generate reports on 
any Tasks that had triggered Exceptions, the Resources assigned to a Project or 
which Security Groups are associated with a Project. Project Management 
features the following Reports:

• Project Critical Path Report

• Project Custom Detail Report

• Project Detail Report

• Project Detail Report (Filter by Custom Fields)

• Project Exception Detail Report

• Project Resource Report

• Project Schedule Change Report

• Project Status Report

• Project Status Detail Report

• Project Summary Report
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• Project Task Assignment Report

• Project Template Detail Report

• Report Type Detail Report

• Resource Availability Report

• Security Group Detail Report

• User Data Detail Report

• User Detail Report

• Validations Report

For more information about Project Management Reports, see “Project 
Management Reports” on page 249.

Comparing Against the Baseline
If you have taken a baseline of your Project, you might want to compare it to 
your current Project. This can be done using the Project Schedule Change 
Report, which can compare the current Project to any baseline, or baselines to 
each other.

Figure 6-7 Project Schedule Change Report 

For more information on running Reports in Project Management, see “Project 
Management Reports” on page 249.
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Analyzing Project Costs
Project Management provides useful interfaces for visualizing Project Costs 
using Financial Management and the Mercury ITG Dashboard. The primary 
visualization tools are discussed below:

• Project Cumulative Cost Metrics

• Project Current Cost Metrics

• Viewing the Earned Value Analysis for a Project

Project Cumulative Cost Metrics
The Analyze Cumulative Cost Metrics page can be reached by selecting Analyze > 
Projects > Cumulative Cost Metrics from the Cost menu group in the menu bar.
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Figure 6-8 Analyze Cumulative Cost Metrics page

The Analyze Cumulative Cost Metrics page can be filtered according to the 
criteria described in Table 6-2.

Table 6-2. Analyze Cumulative Cost Metrics Page Parameters

Field Description

Project Name The name of the Project being analyzed.

Period The period to be used in the graph’s time axis. Possible 
values: Week, Month, Year.
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Use the Analyze Cumulative Cost Metrics page to get a look at a Project’s 
performance in terms of different Cost variables over time. The Project’s 
projected Actual Cost is also calculated by Project Management and displayed 
at the top of the chart.

Project Current Cost Metrics
The Analyze Current Cost Metrics page can be reached by selecting Analyze > 
Projects > Current Cost Metrics from the Cost menu group in the menu bar.

Start Date The date at which to start the graph.

Finish Date The date at which to end the graph.

Include in Graph:

Planned Value (PV) Graphs the portion of the Baseline Cost planned to be spent 
between the Project’s start date and each data point.

Earned Value (EV) Graphs the portion of the Baseline Cost for the entire 
Project that has theoretically been spent by each data point. 
(Baseline Cost * % Complete)

Actual Costs (AC) Graphs the total dollar cost for the Project. (Actual Labor 
Cost + Actual Non-Labor Cost)

Budget Graphs the Budget for the Project at each data point.

Budget Actuals Graphs the Budget actual values, if any have been entered, 
at each data point.

Table 6-2. Analyze Cumulative Cost Metrics Page Parameters

Field Description
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Figure 6-9 Analyze Current Cost Metrics page

The Analyze Current Cost Metrics page can be filtered according to the criteria 
described in Table 6-3.
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Table 6-3. Analyze Current Cost Metrics Page Parameters 

Field Description

Project Name

Project Name Select a Project to be displayed.

Master Project and 
Subproject

Select a Master Project and/or Subproject to be displayed.

Other Criteria

Department Select Projects from a certain Department to be displayed.

Project Manager Select Projects with a certain Manager to be displayed.

Project State Select Projects of a certain State to be displayed.

Actual Costs exceed 
Earned Value by

Select Projects with a Cost variance greater than a certain 
amount to be displayed.

Planned Value 
exceeds Earned 
Value by

Select Projects with a schedule variance greater than a 
certain amount to be displayed.

CPI Less Than Select Projects with a CPI under a certain value to be 
displayed.

SPI Less Than Select Projects with an SPI under a certain value to be 
displayed.

BUDGET GREATER 
THAN

Select Projects with a Budget greater than a certain amount 
to be displayed.

BASELINE COSTS 
GREATER THAN

Select Projects with baseline costs greater than a certain 
amount to be displayed.

BUDGET ACTUALS 
GREATER THAN

Select Projects with Budget actual values greater than a 
certain amount to be displayed.

SHOW ONLY MASTER 
PROJECTS?

Select only Master Projects to be displayed.

Size of Bubble Indicates

BUDGET Bubbles representing Projects will vary in size based on the 
size of their associated Budgets.

BUDGET ACTUALS Bubbles representing Projects will vary in size based on the 
size of their actual Budget values, if any have been entered.

BASELINE COSTS Bubbles representing Projects will vary in size based on the 
size of their last baseline costs.

PROJECTED ACTUAL 
COST AT COMPLETION

Bubbles representing Projects will vary in size based on the 
size of their projected Actual Cost at completion.
158 Managing a Project



Managing Your Projects (Project Management)
Use the Analyze Current Cost Metrics page to compare the sizes and Cost health 
of one or more Projects.

Viewing the Earned Value Analysis for a Project
Use the EV Analysis tab in the Project window to view EV Analysis data for the 
of the Project. Table 6-4 defines the fields on this tab. 

All fields within the EV Analysis tab are read-only and cannot be edited. 
Values within these fields are not propagated dynamically.

Table 6-4. EV Analysis tab fields 

Field Description

Seq Number of a Subproject or Task in the hierarchy.

Name Name of a Task or Project.

Cost Health Indicates cost health based on Cost Summary Condition settings.

Actual Cost 
(AC)

Total dollar cost incurred in completing a Task or Project during a 
given time period.

Planned Value 
(PV)

Portion of the Baseline Cost, in the latest Baseline of the Project 
Plan, that is planned to be spent on the Project or Task between 
the start and status dates.

Earned Value 
(EV)

Portion of the Baseline Cost planned for the entire Project or Task 
that should have been spent on the status date for the current 
percentage of work completed. This value is calculated by 
multiplying Baseline Cost by % Complete (EV = BC * % 
Complete).

Cost Variance 
(CV)

Difference between the estimated cost and the actual cost for the 
Project or Task during a given time period. This value is 
calculated by subtracting Actual Cost from Earned Value (CV = 
EV - AC).

Schedule 
Variance (SV)

Difference between the scheduled completion and the actual 
completion of the Project or Task. This value is calculated by 
subtracting Planned Value from Earned Value (SV = EV - PV).

CPI Cost Performance Index. Cost efficiency ratio of Earned Value to 
Actual Cost. Used to predict the magnitude of possible cost 
overrun. The value is calculated by dividing Earned Value by 
Actual Cost (CPI = EV / AC).
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Tracking Project History
Project Management maintains a State Change History for both Projects and 
Tasks. The transaction history includes the Date, User Name, Project or Task 
Name, and Project or Task State.

To view the State Change History for a particular Task:

1. In the Project Plan Panel, select the Task whose State Change History you 
want to view.

2. Select Project > View > State Change History from the View drop down list. 

The State Change History window opens.

3. Click Refresh to update the history list.

4. Click Close to close the window.

To view the State Change History for a particular Subproject:

1. In the Project Plan Panel, select the Subproject whose State Change 
History you want to view.

SPI Schedule Performance Index. Schedule efficiency ratio of Earned 
Value accomplished against Planned Value. Describes what 
portion of the planned schedule was actually accomplished. This 
value is calculated by dividing Earned Value by Planned Value 
(SPI = EV / PV).

Table 6-4. EV Analysis tab fields  [continued]

Field Description
160 Managing a Project



Managing Your Projects (Project Management)
2. Select Project > View > State Change History from the View drop down list. 

The State Change History window opens.

3. Click Refresh to update the history list.

4. Click Close to close the window.

Completing, Cancelling, and Deleting Projects
All Projects must reach an endpoint. The Project can either be brought to 
completion, or reach a point where no more work can be done. Project states 
provide distinct ways of differentiating between Projects that have been 
Completed or Cancelled. For more detailed information on Project states, see 
“Project States” on page 137.

This section contains information on:

• Completing Projects

• Canceling Projects

• Deleting Projects

When a user creates or edits a Project or Subproject, that user is the only one 
able to save changes. 

In the case of two users wanting to edit two different Subprojects under one 
Master Project, opening and editing only the desired Subprojects will enable 
each user to save changes without interfering with each other.

See “Concurrent Editing” on page 142 for more detailed information.
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Completing Projects
Project Managers can set the Project state to Completed. For more information, 
see “Modifying States” on page 138.

If a Project is manually set to Completed: 

• Any incomplete Tasks under that Project are set to Bypassed.

• Any incomplete projects under that Project are set to Completed.

Reopening a Completed Project
A Project that is Completed can be moved to On Hold.

• Upon moving the Project from Completed to On Hold:

o Bypassed tasks will move to a Task state of New.

• If the Project is moved to Active:

o Task states will be recalculated.

o Tasks previously In Progress will not regain the Task state of In 
Progress. 

To change a Completed Project’s state:

1. Open the Project to edit.

For more details on searching for and opening Projects, see “Searching for 
Projects in the Workbench” on page 144.

2. In the Project Plan Panel, select the Project at the top of the hierarchy.

This will be the Master Project.

3. Select a new State for the Master Project from the drop down list in the 
State column.

4. Click Save.

Canceling Projects
Occasionally, all work on a particular business initiative can be stopped. The 
endeavor might have been found to be unprofitable, it might not be feasible 
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given current resource limitations or there might be another business reason. 
Projects can have their states changed to Cancelled to reflect this circumstance. 

• If a Project is manually set to Cancelled, any incomplete Tasks or Projects 
under it are set to Cancelled.

• From Cancelled, a Project can be moved back to On Hold using the same 
procedure as “Reopening a Completed Project” on page 162. Upon 
moving the Project from Cancelled to On Hold, bypassed Tasks will move 
to a Task state of New.

• Once the project is moved into an Active Project state:

o Task states will be recalculated.

o Tasks previously In Progress will not regain the Task state of In 
Progress. 

Deleting Projects
Once a Project has been completed, it continues to reside in the Mercury ITG 
database. It might not be necessary to archive completed Projects in the 
Mercury ITG system. Projects can be deleted from the Results tab of the 
Project Workbench. 

To delete a Project:

1. Locate the Project that you want to delete using the Query tab of the Project 
Workbench.

2. In the Results tab of the Project Workbench, select the Project you want to 
delete.

3. Click Delete.

Subprojects cannot be deleted from the Results tab of the Project Workbench.
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Creating a URL to Open the Project Window
Project Managers and can construct a Web address (URL) that opens their 
Project in the Workbench. They can then use this URL to access the Project 
from the World Wide Web or from their Intranet.

Users can construct this URL manually using either of the following formats:

http://host:port/mercury/servlet/SmartURL?screen=PRJ&pkid=PROJE
CT_ID
http://host:port/mercury/servlet/SmartURL?screen=PRJ&pkname=PRO
JECT_NAME

You can also configure your Task Notifications to automatically create and 
send these URLs in an email message. Include the following Token in the 
Message area in the Notification window. When the email is sent, the full URL 
will be displayed.

[PRJ.WORKBENCH_PROJECT_URL] 

See “Using Smart URLs in Notifications” on page 96 for more information on 
setting up Task Notifications and using Smart URLs.

Printing a Project Gantt Chart
A Project Gantt chart can be printed or exported to an image file for use in 
presentations. The following sections discuss printing and exporting in more 
detail:

• Printing a Gantt Chart

• Exporting a Gantt Chart to an Image File

Printing a Gantt Chart
To print a Project Gantt chart, select File > Print from the menu at the top of the 
Workbench. The Print Gantt Chart wizard opens, allowing you to select options 
for the Gantt chart’s Project display, time range, Project Plan columns, and 
generic printer settings.
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Figure 6-10 Print Gantt Chart Wizard

Exporting a Gantt Chart to an Image File
A Project Gantt chart can also be exported to an image file with the same 
options as normal printing. The following file formats are supported:

• JPEG

• PNG

• GIF

• BMP

To export a Project Gantt chart to an image, select File > Export to Image from 
the menu at the top of the Workbench. The Export Gantt Chart Wizard opens, 
allowing you to select options for the Gantt chart’s Project display, time range, 
Project Plan columns, and generic image settings.
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Figure 6-11 Export Gantt Chart Wizard
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 Chapter

Updating Tasks:
Project Participant Activities

This chapter explains how Project Participants locate, update, modify, and 
report on Tasks to which they are assigned.

The following topics are covered:

• Locating Tasks

• Viewing Project Information

• Updating Tasks

• Viewing and Adding Notes

• Viewing and Modifying References

• Viewing Reports

Locating Tasks
Project Management defines Project Participants as users who work on Tasks 
as part of a Project team, but do not have the administrative responsibilities of 
a Project Manager. Project Participants view and update their Tasks using the 
standard Project Management interface.

Project Participants update their Task status in Project Management. Project 
Management provides several different ways for Participants to locate their 
Tasks:

• Searching for Tasks and Projects
Project Participants can search for Tasks directly, or they can search for 
Projects in order to get to the Tasks they want through the Projects that 
contain them.
Updating Tasks: Project Participant Activities 167



Managing Your Projects (Project Management)
• Finding Tasks Using the My Tasks Portlet
The My Tasks Portlet allows users to update multiple Tasks at once, as well 
as providing links to individual Task details.

• Finding Tasks Using Notifications
Tasks can be reached from a Notification simply by clicking on the link 
provided in the body of the email, or by copying and pasting it into any 
Web browser.

• Finding Tasks in the Workbench
Project Participants can also search for and update Tasks in the 
Workbench.

Searching for Tasks and Projects
Participants can search for Tasks and Projects that match certain criteria using 
the Task Search and Project Search pages. The following sections provide 
instructions for locating tasks and projects:

• Locating Tasks Using the Task Search Page

• Locating Projects Using the Project Search Page

Locating Tasks Using the Task Search Page
Participants can search for Tasks using the Task Search page. 

To locate Tasks in Project Management:

1. From the Search menu group in the menu bar at left, select Tasks.

The Task Search page opens.
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2. Enter the search criteria for the desired Task.

You can search for an existing Task based on any of the fields located on 
the Task Search page. Limiting the maximum number of results in the 
Maximum Tasks Displayed field can yield quicker results.

3. Click Search.

The Task Search Results page opens, displaying the results matching your 
search criteria.

4. Click on the name of any Task in the list to view its Details page. 

See “Viewing and Updating Task Details” on page 184 for more 
information. To clear all fields in the Task Search Query page and reset to 
default values, click Clear Fields.
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Locating Projects Using the Project Search Page
While Project Participants can locate and view Projects, only Participants with 
a Project Manager Access Grant can edit Projects, through the Workbench 
interface. Participants can locate Projects using the Project Search page. 

To search for Projects in Project Management:

1. From the Search menu group in the menu bar at left, select Projects. 

The Project Search page opens.

2. Enter the search criteria for the desired Project.

You can search for an existing Project based on any of the fields located on 
the Project Search page. Limiting the maximum number of results in the 
Maximum Projects Displayed field can yield quicker results.

3. Click Search.

The Project Search Results page opens, displaying the results matching your 
search criteria.
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4. Click on the name of a Project to view its Project Overview page. 

See “Viewing Project Overview” on page 176 for more information. To 
clear all fields in the Project Search page and reset to default values, click 
Clear Fields.

Finding Tasks Using the My Tasks Portlet
The My Tasks Portlet is available to all Project Management users. This Portlet 
is included on your Mercury ITG Home page by default. It shows a 
configurable list of the Tasks currently assigned to the user.

Participants can update Task States and fill in information that the Project 
Manager would like to collect for all Tasks displayed. In this way, the My Tasks 
Portlet can save valuable time by providing a single point for multiple Tasks to 
be updated at once.

The Participant can also click on the name of a Task in the Task List to view its 
Details page. See “Viewing and Updating Task Details” on page 184 for more 
information.

Figure 7-1 My Tasks Portlet

Finding Tasks Using Notifications
Email Notifications can be configured by Project Managers to include 
hyperlinks to Tasks in Project Management. If you have received an email 
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containing a link to a Task, click on it, and it will open to that Task’s Details 
page in your Web browser. If your email client doesn’t handle HTML links 
directly, copy and paste it into your Web browser.

Finding Tasks in the Workbench
The Workbench is the Java application that allows for configuration as well as 
creation and processing of Projects, Project Templates, and Tasks. Project 
Participants can also search for and update Tasks in the Workbench.

Project Participants can find Tasks by searching for them directly, or by 
looking for the Projects that contain them.

The following sections contain more detailed information on searching for 
Tasks and Projects, as well as updating Tasks, in the Workbench:

• Searching for Tasks in the Workbench

• Searching for Projects in the Workbench

• Updating Tasks in the Project Plan Panel

• Updating Tasks in the Task Information Window

Searching for Tasks in the Workbench
You can locate Tasks using the Query tab in the Task Workbench window.

To search for Tasks from within the Workbench:

1. Click the Project Management screen group.

2. Click the Projects icon.

The Project Workbench opens.

3. Select the Task Workbench, behind the Project Workbench, by either 
clicking on its title bar or clicking Task Workbench at the bottom of the 
Workbench window.

Only Mercury ITG users who have been given a Power license can access the 
Workbench. Project Participants with a Power license can access the 
Workbench, but as in the standard interface, they will not be able to edit 
Project information or update Tasks they have not been assigned.
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4. Enter search criteria into the associated fields.

To save your query, click Save Query. You can then perform a quick search 
using these specified criteria anytime later.

5. Click List to return the matching results in the Results tab.

6. From within the Results tab:

• View a Task by double-clicking on the desired Task or selecting it and 
clicking Open. The Task Information window opens.

• Open multiple Tasks by selecting a group (using Shift-Select or Ctrl-
Select) and clicking Open. Many Task Information windows open, one 
for each selected Task.

7. Update Task information in the Task Information window.

For details on updateable fields, see “Updating Tasks in the Task 
Information Window” on page 175.

Searching for Projects in the Workbench
The Query tab in the Project Workbench window is used to locate and open 
Projects.

To search for Projects from within the Workbench:

1. Click the Project Management screen group.

2. Click the Projects icon.

The Project Workbench opens, with the Query tab defaulted to appear on 
top.
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3. Enter search criteria into the associated fields.

4. To save your query, click Save Query.

You can then perform a quick search using these specified criteria anytime 
later.

5. Click List to return the matching results in the Results tab.

6. From within the Results tab:

• View a Project by double-clicking on the desired Project or selecting it 
and clicking Open. The Project window opens.

• Open multiple Projects by selecting a group (using Shift-Select or Ctrl-
Select) and clicking Open. Multiple Project windows open, one for each 
selected Project.

7. From within the Project window, you can edit Tasks directly, or edit them 
in the Task Information window.

See “Updating Tasks in the Project Plan Panel” on page 174 and 
“Updating Tasks in the Task Information Window” on page 175 for more 
information.

Updating Tasks in the Project Plan Panel
Project Participants can update Tasks displayed in the Project Plan Panel.

To update Task information from the Project Plan Panel:

1. Select the Task to update. 

2. Click on the desired field to update its contents directly.
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Project Participants can only update the fields that have been enabled for 
them to edit by the Project Manager. This set of fields can vary. 
Additionally, Participants can only update those Tasks that have been 
assigned to them. All other Tasks will be view-only. This is also true for 
Project Managers viewing Tasks and Projects that they are not in charge of.

Updating Tasks in the Task Information Window
Project Participants can also update Tasks inside each Task’s Information 
window.

To edit Task information in the Task Information window:

1. Open the Task Information window by one of the following ways:

• Query and open the Task directly from the Task Workbench. The Task 
Information window opens.

• Query and open an existing Project. Double-click the Task to edit, or 
select it and click Edit. The Task Information window opens.

2. Make all necessary changes in the Task Information window.

3. Click OK.

Project Participants can only update the fields that have been enabled for 
them to edit by the Project Manager. This set of fields can vary. 
Additionally, Participants can only update those Tasks that have been 
assigned to them. All other Tasks will be view-only. This is also true for 
Project Managers viewing Tasks and Projects that they are not in charge of.

Viewing Project Information
Project Participants might want to view the Projects they are part of in the 
standard interface, as a way of setting context for their own Tasks, checking on 
other dependent Tasks, or keeping track of deadlines. Participants can view the 
following Project information at any time:

• Viewing Project Overview

• Viewing Project Details

• Viewing Project Hierarchy
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• Viewing Exceptions

• Viewing Project References

• Viewing the Project Gantt Chart

• Viewing the Critical Path

• Viewing Project Milestones

Viewing Project Overview
The Project Overview page displays a wide range of information about a 
particular Project: its Subprojects and Tasks, its State and Project Manager, 
and any Exceptions it might have triggered. All of this data and more is 
presented and arranged through the following Portlets:

• Project Summary
Displays the Project’s name, state, % complete, manager, description, 
scheduled start, and scheduled finish. It also contains a link to the Project 
Details page. See “Viewing Project Details” on page 177.

• Project Overview Gantt 
Displays the Gantt chart for a Project. See “Viewing the Project Gantt 
Chart” on page 181.

• Project Milestones 
Lists the Milestones in a Project. See “Viewing Project Milestones” on 
page 182.

• Subprojects and Tasks Summary
Provides a list of all Subprojects and Tasks included in that Project, and a 
link to the Project Plan, located on the Project Hierarchy page. See “Viewing 
Project Hierarchy” on page 179.

• Exception Summary
Shows the number and kinds of Exceptions triggered and links to the 
Exception Details Portlet. See “Viewing Exceptions” on page 180.

• Project References
Provides a list of all References linked to the Project (Requests, Packages, 
Tasks, Projects, Releases, Attachments, URLs) and where in the Project 
they are Referenced from. See “Viewing Project References” on page 181.

• Project Related Actions 
Displays links to a Project’s Assignment visualizations and Staffing 
Profiles. See Managing Your Resources (Resource Management) for more 
details.
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Figure 7-2 Project Overview Page

Users can access the Project Overview page through the Project Search Results 
page, as well as the Project List Portlet, which is available for display on the 
Participant’s Mercury ITG Home page as part of the Mercury ITG Dashboard. 

Viewing Project Details
The Project Details page contains detailed information on a particular Project, 
grouped into the following categories:
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• Progress
% complete, confidence, start date (scheduled and actual), finish date 
(scheduled, estimated, and actual), duration (scheduled, estimated 
remaining, and actual), and effort (scheduled, estimated remaining, and 
actual).

• Details
Project number, Project Template, department, description, priority, 
complete and incomplete predecessors.

• Action Items
Action item names, states, and priorities.

• Notes
Any notes.

• References
Requests, Packages, other Projects, URLs, and attachments.

Figure 7-3 Project Details Page

The Project Details page can be accessed through the Project Summary Portlet in 
the Project Overview page, which contains a link to the Project Details page. 
Click Project Details to go to the Project Details page.

Figure 7-4 Project Summary Portlet 
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Viewing Project Hierarchy
The Project Hierarchy page displays the Project’s hierarchical organization of 
Tasks and Subprojects (its Project Plan) as well as information such as:

• Task or Subproject name

• Task or Subproject state

• Task or Subproject scheduled duration, start, and finish

• Task or Subproject predecessors

• Task or Subproject Resource or Manager

• Task Exceptions or Subproject Summary Condition

The Project Hierarchy page is useful for providing context for Participants in 
terms of the location of their Tasks in the overall Project framework, as well as 
indicating Summary Conditions and Exceptions at a glance.

Clicking on any Task within the Project Hierarchy page takes the user to that 
Task’s Details page. See “Viewing and Updating Task Details” on page 184 
for more detailed information.

Figure 7-5 Project Hierarchy Page

The Project Hierarchy page can be accessed through the Subprojects and Tasks 
Summary Portlet in the Project Overview page, which contains a link to the 
Project Hierarchy page. Click Project Hierarchy to go to the Project Hierarchy 
page.
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Figure 7-6 Subprojects and Tasks Summary Portlet 

Viewing Exceptions
The Project Exception Detail Portlet displays the Exceptions that have been 
triggered for the Project being viewed, breaking each triggering Task down 
according to:

• Exception Type and number of days violated

• Task state, resource, scheduled start and finish

• Project path

This is useful for Participants in that it provides specific context for every 
Exception in a Project, telling them what Task has gone wrong (or what might 
go wrong, depending on the Exception Rules enabled), when it went wrong, 
and where the problem Task is located.

Figure 7-7 Project Exception Detail Portlet

Getting to the Exception Details Portlet
The Project Exception Summary Portlet in the Project Overview page contains a 
link to the Project Exception Detail Portlet. Click Details to go to the Project 
Exception Detail Portlet.
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Figure 7-8 Project Exception Summary Portlet 

Viewing Project References
The Project References Portlet in the Project Overview page displays all entities 
linked to the Project as References. References (Requests, Packages, Tasks, 
Projects, Releases, Attachments, and URLs) are listed with details including:

• Reference Type

• Description

• Referenced By

The Project References Portlet provides a convenient single point of access for 
all entities referenced by a Project.

Figure 7-9 Project References Portlet 

Viewing the Project Gantt Chart
The Project Overview Gantt Portlet, displayed on the Project Overview page, 
shows the Project’s Gantt chart including Milestones.

Figure 7-10 Project Overview Gantt Portlet
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Display criteria for the Gantt chart can be configured by clicking Edit, which 
opens the Portlet’s filter page.

Figure 7-11 Project Overview Gantt Portlet filter page - Display Options section

Viewing the Critical Path
The critical path of a Project is made up of the Tasks that define its duration. A 
Project’s critical path can be displayed in the Project Overview Gantt Portlet by 
clicking Edit and selecting the Highlight Critical Path checkbox.

Viewing Project Milestones
Milestones are used to mark significant events in a Project, often the 
completion of a deliverable or arrival of a deadline. In the Project Overview 
Gantt Portlet, milestones appear as black diamonds.

Milestones are also listed in the Project Milestones Portlet, displayed on the 
Project Overview page.

Figure 7-12 Project Milestones Portlet

Viewing Resource Information
Resources can view information on their current assignments using the View 
Resource page. The View Resource page includes a chart of their capacity and a 
customized Gantt chart illustrating their assignments for the next two weeks.

Project Managers with the proper level of access can also view information on 
Resources including their Cost rate and workload capacity. Figure 7-13 
illustrates a View Resource as shown to a Manager with access to Cost data.
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Figure 7-13 View Resource page for a Manager with Cost Access

To open the View Resource page, select Search > Resources from the menu bar. 
Enter any search criteria into the Search Resources page and click Search.

Updating Tasks
Project Management makes it easy for Project Participants to report on 
different aspects of Tasks in multiple levels of detail:

• Viewing and Updating Task Details
Participants can view their Tasks in detail, updating and saving information 
such as Task progress, attachments, and action items.

• Viewing and Updating Multiple Tasks
Multiple Tasks can also be updated simultaneously, with information 
deemed essential by the Project Manager available to update immediately.
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Updating a Task can trigger events in the Project that move it along its path to 
completion.

Viewing and Updating Task Details
The Task Details page contains detailed information on multiple aspects of a 
single Task. Many fields in the Task Details page are updateable by Project 
Participants.

To update fields in the Task Details page:

1. Make the update in the desired field.

2. Click Save.

To clear all changes and reset all fields to their previous values, click 
Reset.

A Task in a Project that has predecessor Tasks associated with it cannot be 
marked Complete until its predecessors have been completed, unless a Project 
Manager attempts it.

In order for updates to take effect, the Participant must click Save. Only then 
will Project Management take into account the updates that have been made.
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Getting to the Task Details Page
A relevant Task must first be located in order to get to its Details page and 
update its information. There are several ways for Participants to locate and 
view details for any Tasks that might require their attention:

• “Searching for Tasks and Projects” on page 168

• “Finding Tasks Using the My Tasks Portlet” on page 171

• “Finding Tasks Using Notifications” on page 171

Any Task’s Details page can also be reached from the Project Hierarchy page. 
See “Viewing Project Hierarchy” on page 179 for more detailed information.
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Viewing and Updating Multiple Tasks
Sometimes it might be necessary for a Project Participant to only update a 
specific Task detail, such as the Task State or % Complete. The My Tasks Portlet 
is perfectly suited to this need, and has the added advantage of being able to 
show multiple Tasks at once.

The fields collected by the Portlet can be configured by Project Managers. See 
“Selecting Information to Track and Display” on page 30 for details.

The My Tasks Portlet displays information for multiple Tasks. The maximum 
number of Tasks displayed can be specified by the user, as well as the Portlet 
title. Most fields in the My Tasks Portlet are updateable by Project Participants. 

To update fields in the My Tasks Portlet:

1. Make the update in the desired field.

2. Click Save.

To clear all changes and reset all fields to their previous values, click 
Reset.

Figure 7-14 My Tasks Portlet

Getting to the My Tasks Portlet
The My Tasks Portlet is defaulted to display on a Project Participant’s 
Homepage. The Homepage can be reached at any time by selecting Dashboard 
> My Pages > Front Page from the menu bar at left.

In order for updates to take effect, the Participant must click Save. Only then 
will Project Management take into account the updates that have been made.
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Viewing and Adding Notes
Notes are available for viewing and editing in the Task Details page. See 
“Viewing and Updating Task Details” on page 184 for information on the Task 
Details page.

To create a new Note:

1. Get to the Details page of the Task to update.

2. Type the new note into the New Note text field.

3. Click Save.

Viewing and Modifying References
Project Management features a number of methods for capturing additional 
information, or References, related to your Projects. Tasks can include 
references to other entities or points of information, allowing easy access and 
visibility to data related to the current Project. The following References can 
be attached to a Task:

• Requests

• Packages

• URLs

• Attachments (anything that can be placed on a server: PDF files, JPEG 
images, Java .class files, etc.)

• Tasks

• Projects

• Releases (referenced from the Workbench only)

References are attached from the Task Details page. References can be added 
and modified using both the standard interface and the Workbench. The 
following sections provide instructions for adding, modifying and deleting 
references using the standard Project Management interface:

• Adding References to Tasks

• Viewing and Editing References
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• Deleting References

Adding References to Tasks
You can reference a Web accessible file or attach a file from your local 
machine to the current Task. You can also reference an existing Mercury ITG 
entity (Request, Package, Project, or Task). 

To attach References to a Task:

1. Open the Task Details page using one of the following methods:

• Search for and open the Task directly using the Search > Tasks menu 
option.

• Query and open an existing Project using the Search > Projects menu 
option. Locate the Task within the Project and open the Task Details 
page.

2. Scroll down to the References section of the page.

3. Select a Reference type from the New Reference drop down list. 

4. Click Add.

A page corresponding to the selected Reference type opens. Enter the 
Reference on this page. For certain Reference types, you have the option of 
searching for a Reference.

5. Attach the Reference. 

6. Click Save on the Task Details page.

You can attach different types of References to your Task. See the 
following sections for instructions on referencing different entities.

• Attaching Existing Mercury ITG Entities

• Attaching New Requests

• Attaching Files 

• Attaching URLs
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Attaching Existing Mercury ITG Entities
You can attach an existing Mercury ITG entity (Request, Package, Project, or 
Task) to a Task.

To attach an existing Mercury ITG entity to a Task:

1. Navigate to the Task Details page and scroll down to the References section.

2. Select Entity (Existing) (“Entity” can be Task, Project, Request (Existing), 
Request (New), Package (New), or Package) to be added from the New 
Reference drop down list.

3. Click Add.

A page opens presenting search criteria for the Request, Package, Release, 
Project, or Task to be referenced.

4. Enter the appropriate information and click Search.

A page opens presenting search results.
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5. Select the check box next to the entity or entities to be referenced.

To check all boxes, click Check All. To un-check all boxes, click Clear All.

6. Select a relationship for the referenced entities from the drop down list at 
the top of the page.

For a complete list of all Reference relationships, see “Dependency 
Relationships” on page 113.

7. Click Add.

8. The referenced entities appear in the References to be added on Save list on 
the Task Details page. The References have not been added yet.

9. Click Save to add the References to the Task.

Attaching New Requests
A new Request can be created from the References section of the Task Details 
page.

To create a new Request from the References section of the Task Details 
Page:

1. Select Request (New) from the New Reference drop down list.

2. Click Add. 

The Create New Request page opens.
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3. Choose the Request Type that you want to generate from the Request Type 
drop down list in the Create New Request section.

A description of each Request Type displays below the list. To save time, 
the most recently created Request Types will be first on the list.

4. Select the relationship for the new Request from the Relationship drop down 
list.

5. Click Create. 

6. Enter the information related to your new Request in the Create New 
Request page.

Required fields are displayed in red. If you would like to make additional 
comments on the Request, enter them in the Notes field.

7. Save and submit the new Request.

The referenced Request appears in the References to be added on Save list 
on the Task Details page. The Reference has not been added yet.

8. Click Save to add the Reference to the Task

Attaching Files
To add a file as a Reference:

1. Navigate to the Task’s Details page and scroll down to the References 
section.

2. Select Attachment from the New Reference drop down list.

3. Click Add. 

The Reference Attachment page opens.
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4. Select the desired file from your local machine and enter a description if 
desired.

5. Click Add to add the selected Attachment as a Reference.

The referenced Attachment appears in the References to be added on Save 
list on the Task Details page. The Reference has not been added yet.

6. Click Save to add the Attachment to the Task.

Attaching URLs
To add a URL as a Reference:

1. Navigate to the Task Details page and scroll down to the References section.

2. Select URL from the New Reference drop down list. 

3. Click Add.

The Reference URL page opens.

4. Type the URL into the URL field and enter a description if desired.

5. Click Add to add the specified URL as a Reference. 

The referenced URL appears in the References to be added on Save list on 
the Task Details page. The Reference has not been added yet.

6. Click Save to add the Reference to the Task.
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Viewing and Editing References
You can view the References that have been linked to a Task. The References 
are listed in the References section of the Task Details page.

To view the References currently linked to the Task:

1. Open the Task Details page.

2. Scroll down to the References section.

Expand and collapse sections by clicking the + and - icons to view 
additional details.

3. Click on the name of the Reference you want to view.

• If the Reference is a URL, it opens inside your Web browser.

• If the Reference is a file of any other kind, it is handled by your Web 
browser in the usual fashion, either opening directly or asking to be 
saved to your local machine.

• If the Reference is a Project, its Project Overview page opens, displaying 
summary information related to that particular Project.

• If the Reference is another Mercury ITG entity (Request, Package, or 
Task) it will open the entity’s Details page.

If you have permission to edit the Task, you can modify the Task’s References. 
In addition to adding new References, you can delete and change the 
Relationships of existing references. The following figure illustrates the 
functionality related to References.

If you have licenses for Demand Management and Change Management, you 
can click the Request or Package to access their detail pages. You can then 
update those entities according to normal Mercury ITG operation. 
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Figure 7-15 References section 

You can also view References related to your Tasks and Projects using the 
Project References Portlet on your Mercury ITG Dashboard. Add the Portlet to 
your Dashboard and then personalize it to show the References that are 
relevant to your activities. The Portlet can be personalized to display 
References based on the following information: Reference Types, 
Relationship, time period when they were added, and whether or not they are 
preventing actions on Tasks. 

Figure 7-16 Project References Portlet 

Deleting References
If you have permission to edit the Task, you can delete the Task’s References. 

To delete a Task Reference:

1. Navigate to the Task Details page and scroll down to the References section.

2. Click the X to the left of the Reference.

A message will appear asking you to confirm the deletion. 

Lists current
References.

Select a new 
Relationship from 
the drop down list.

Add new
References.

Click Save to save
your changes.
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3. Click Yes.

The Reference is removed from the Task.

Figure 7-17 References section

Visibility Between Projects and Programs
Mercury Program Management provides a way for managers to link multiple 
Projects together as Programs, and to submit and track Requests against them.

Organizations implement a Program Management Office in order to:

• Ensure alignment of IT projects with business objectives

• Eliminate duplicate and non-priority efforts

• Improve operational efficiency

• Leverage resources

• Ensure on-time and on-budget delivery

Programs can be tracked and analyzed with the same kind of familiar Cost 
metrics as Projects. 

Viewing Reports
You can run reports on your Project Management information from the 
Reports menu group in the menu bar.

Click X to remove
the Reference.
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To run a Project Management report:

1. From the Reports menu group in the menu bar, select Project Reports.

The Available Reports page opens.

2. Choose the Report to be submitted from the list of Report Types by 
clicking on its name.

The Report’s creation page opens.
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This example of a Report creation page shows the required and optional 
fields for the Project Custom Detail Report. Each Report Type has its own 
set of required and optional fields. The Report creation page always 
displays a different set of fields depending on which Report Type is 
selected. See “Submitting a Report from the HTML Interface” on page 253 
for more information.

3. Enter information in the Report creation page’s required fields.

4. Enter any information in the Report creation page’s optional fields.

5. Click Submit.

The Report Submitted page opens and displays the Report contents in a new 
window.
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 Chapter

Using Project Templates

This chapter explains how to create and use Project Templates in Project 
Management.

The following topics are covered:

• Setting up a Project Template

• Creating a Project Template from an Existing Project

• Creating a Master Project from a Project Template

• Creating a Subproject from a Template

Setting up a Project Template
Project Templates are used in Project Management to create repeatable 
processes to be used in Projects. They can be used as a model and serve as a 
basis for numerous Master Projects. Templates can also be created and then 
imported as a Subproject into a Master Project.

Project Templates speed up the process of setting up your Projects. A repeated 
set of Tasks are bundled into a Template and dropped into any Project while 
preserving its Notifications, project plan, and any custom fields the template 
can have.

A company with several different software products might use the same 
process for all development efforts. A Project Template could be used to 
create the Master Project for each one, as opposed to creating them all 
individually every time a project is planned. Information for each individual 
Project can then be modified by a particular Project Manager as needed.
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Project Templates consist of three parts: 

• Project Plan
An ordered list of Tasks. The sequence of Tasks is identical in form and 
function to the Project Plan Panel.

• Any custom fields created by the user
Configurable custom fields define and collect any necessary information 
that is not already covered by standard Task or Project detail fields. 

• Project Template settings
Settings for a Project Template work the same way as settings for a Master 
Project.

The following sections provide instructions for creating and configuring 
Project Templates:

• Adding Tasks to a Project Template

• Creating Custom Fields for Project Templates

• Configuring Tasks in a Project Template

• Configuring Settings for a Project Template

• Setting Ownership for a Project Template

• Creating a Master Project from a Project Template

• Creating a Subproject from a Template

Figure 8-1 Project Template Window
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Adding Tasks to a Project Template
The process of adding Tasks to a Project Template is identical to adding Tasks 
in the Project Plan Panel. See “Adding Tasks to the Project Plan Panel” on 
page 53 for details.

Creating Custom Fields for Project Templates
Project Managers can create custom fields that collect information not covered 
by Project or Task detail fields. Custom fields are unique to each Template. 
Custom fields are added and modified by:

• Defining Custom Fields for Project Templates

• Modifying the Layout of Custom Fields

Defining Custom Fields for Project Templates
To add a custom field to a Project Template:

1. Click the Project Management screen group.

2. Click the Project Templates icon.

The Project Template Workbench opens.

3. Open an existing template by searching for and double-clicking the 
template, or create a new template by clicking New.

The Project Template window opens.

4. Click Custom Fields.

The Custom Fields for Project Template window opens.

Project Templates do not contain References, Action Items, or Notes, and 
some fields are not updateable.
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5. Click New. 

The Field: New window opens.

6. Enter the general field information which includes the following:

• Field Prompt

• Token

• Validation

7. In the Attributes tab, enter information as described in the following table.
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8. Click the Default tab.

9. Enter information as described in the following table.

10. Click the Dependencies tab.

11. Enter information as described in the following table.

Field Description

Parameter Col. Used to determine the place in the internal database 
column where the field value is stored. Fields in a Project 
Template cannot use the same column number.

Transaction History Controls the transaction auditing facility for this field. If set to 
Yes, whenever this field changes in a Project, the change is 
logged in a transaction history table.

Display Only Determines if the field is only displayed and cannot be 
updated. To use the logic defined in the Dependencies tab, 
select Use Dependency Rules.

Notes History Turns notes auditing on or off for this field. If set to Yes, 
whenever this field changes in a Project, the change will be 
logged in the Notes.

Required Determines if the user is required to specify a value for this 
field. To use the logic defined in the Dependencies tab, 
select Use Dependency Rules.

Workbench Only Determines if the field is visible in the Workbench only and 
not in the HTML interface.

Field Description

Default Type Defines if the field will have a default value. Either defaults the field 
with a constant value by selecting Constant, or with a value from 
another field by selecting Parameter.

Visible Value If Default Type is set to Constant, enter the constant value in this 
field. This value should be what the user would normally enter in 
the field.

Depends On If the Default Type is set to Parameter, select the token name of 
that field. At runtime, any value that is entered or updated in the 
source field will automatically be entered or updated in this 
destination field.
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12. Click the Security tab to define the field security. 

See “Setting Visibility at the Field Level” on page 204 for details.

13. Click Add to save the configuration for this custom field and create 
additional custom fields, or click OK to save the configuration for this 
custom field and close the Field: New window.

Setting Visibility at the Field Level

By default, all fields are set to be visible to all users and editable by all users. 
Field visibility and editability can be controlled from the Field window’s 
Security tab using the Edit Field Security window. To configure field visibility 
from the Field window:

1. Open the desired Project Template.

2. Click Custom Fields to open the Custom Fields for Project Template window.

3. Select the desired field and click Edit.

The Field window opens.

4. Click the Security tab.

Field Description

Clear When Changes Indicates that the current field should be cleared when the 
specified field changes (the field needs to be on the 
Project Template).

Display Only When Indicates that the current field should only be editable 
when certain logical criteria are satisfied. This field 
functions with two adjacent fields: a drop down list 
containing logical qualifiers and a text field. To use this 
functionality, select Use Dependency Rules in the 
Attributes tab.

Required When Indicates that the current field should be required when 
certain logical criteria are satisfied. This field functions with 
two adjacent fields: a drop down list containing logical 
qualifiers and a text field. To use this functionality, select 
Use Dependency Rules in the Attributes tab.
204 Using Project Templates



Managing Your Projects (Project Management)
5. Click Edit.

The Edit Field Security window opens.

6. Un-check the Visible to all users box to begin fine-tuning field properties.

7. Make a choice from the Select Users/Security Groups that can view this field 
drop down list.

You can select a User, Security Group, Standard Token, or User Defined 
Token.
Using Project Templates 205



Managing Your Projects (Project Management)
8. Once you have made your choice from the drop down list, select the User, 
Security Group, or Token from the auto-complete list.

If you want to assign the selected User, Security Group, or Token editing 
rights as well as viewing rights to the field, check the Provide Editing Rights 
box.

9. Click the Add arrow button to add the selected User, Security Group, or 
Token to the This field is visible to these Users/Security Groups area.

If you change your mind about granting the selected User, Security Group, 
or Token editing rights, you can un-check the box in the Editable column of 
the This field is visible to these Users/Security Groups area. The field will then 
be visible but not editable to the selected User, Security Group, or Token. 
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To remove viewing rights entirely, select the User, Security Group, or 
Token and click Remove.

10. When you are finished adding Users, Security Groups, or Tokens to the 
This field is visible to these Users/Security Groups area, click OK to save 
changes and return to the Security tab.

The Security tab is updated with the list of Users, Security Groups, or 
Tokens with viewing or editing rights to the field.

Modifying the Layout of Custom Fields
You can modify the graphical representation and placement of the custom 
fields in the Project Template. These changes are made in the Layout tab in the 
Custom Fields for Project Template window.

Figure 8-2 Custom Fields for Project Template Layout Tab

Field layout can be modified in the following ways:
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• Modifying Custom Field Widths

• Moving Fields

• Adding Sections

• Previewing Layouts

Modifying Custom Field Widths

To change the column width of a Project Template’s custom field:

1. Click the Project Management screen group.

2. Click the Project Templates icon.

The Project Template Workbench opens.

3. Query for and open the Project Template that you would like to modify. 

The Project Template window opens.

4. Click Custom Fields to open the Custom Fields for Project Template window.

5. Click the Layout tab.

6. Select the custom field.

7. Select either the 1, 2, or 3 choice in the Width drop down list.

For custom fields of component type Text Area, the number of lines the text 
area displays can be specified. Select the field in the Layout tab and change 
the value in the Component Lines attribute. If the selected custom field is not 
of the type Text Area, this attribute will be blank and non-updateable.

The Layout editor will not allow changes to be made if the change conflicts 
with another field in the layout. For example, a field’s width cannot be 
changed from one to two if another field exists in column two on the same 
row
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Moving Fields

To move a custom field or set of custom fields:

1. Click the Project Management screen group.

2. Click the Project Templates icon.

The Project Template Workbench opens.

3. Query for and open the Project Template that you would like to modify. 

The Project Template window opens.

4. Click Custom Fields to open the Custom Fields for Project Template window.

5. Click the Layout tab.

6. Select the custom field(s).

To select more than one custom field, press the Shift key while selecting 
the last custom field in a set. Only a group of adjacent fields can be 
selected.

7. Use the directional arrow buttons to move the custom fields to the desired 
location.

Adding Sections

To add a section to a Project Template:

1. Click the Project Management screen group.

2. Click the Project Templates icon.

The Project Template Workbench opens.

3. Query for and open the Project Template that you would like to modify. 

The Project Template window opens.

Custom fields cannot be moved to an area where other fields already exist. 
The other fields must be moved out of the way first.
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4. Click Custom Fields to open the Custom Fields for Project Template window.

5. Click the Layout tab.

6. Click New in the Sections frame.

The Input dialog opens.

7. Enter a Section Name.

8. Click OK.

The name of the new section appears in the Layout tab. When Project 
Templates are used to create a Master Project, the sections with the 
appropriate custom fields are displayed. To change a section name, click 
on a field that resides in that section and click Rename to enter a new value 
in the Input dialog. The change is reflected immediately.

Previewing Layouts

Click Preview to view the layout. This opens a small window that shows the 
fields as they will appear.

Remember that:

• If all of the custom fields have a width of one column, all displayed 
columns will automatically span the entire available area when the 
Template is displayed.

• Any rows with no custom fields are ignored. They do not show up as a 
blank line.

• Any non-displayed custom fields do not affect the layout. The layout 
engine considers them the same as blank fields.

Adding Fields to Existing Projects
Custom fields can be imported into an existing Project at any time without 
simultaneously importing the Project Template they come from. This allows 
you to capture whatever information is needed without having to deal with a 
superfluous set of Projects or Tasks. Custom fields appear in the Project or Task 
Information window on their own tab.

For information on adding custom fields to existing Projects, see “Importing 
Custom Fields from a Project Template” on page 51.
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Configuring Tasks in a Project Template
Tasks and Notifications in a Project Template can be configured the same way 
as they are in the Project Plan Panel. See “Editing Task Information” on 
page 89 for details.

Configuring Settings for a Project Template
Project Templates contain settings identical to the settings for a Master Project. 
The process of configuring these settings is also identical. From the Project 
Template window, you can access the Settings for Project Template window 
where you can configure the following:

• Project Fields

• Exception Rules

• Indicators 

• Scheduling

• Security

• Project Teams

• Financial Management

Project Templates do not contain References, Action Items, or Notes, and 
some fields are not updateable.
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See “Setting Up a Master Project” on page 28 for detailed instructions on 
configuring the Project Template settings.

Setting Ownership for a Project Template
Different groups of users can have exclusive control over the Project 
Templates used by their group. These groups are referred to as Ownership 
Groups. Members of the ownership group are the only users who can edit, 
delete or copy the Project Template. Each Project Template can be assigned 
multiple ownership groups. 

Ownership groups are defined in the Security Group window in the Workbench. 

To set the Ownership for a Project Template:

1. Click the Project Management screen group.

If a Master Project is created from a Project Template, that Master Project 
will have all of the Template’s settings.

However, if a Project Template is used to create a Subproject inside a Master 
Project, then that Template’s settings will be overridden by the current 
Master Project’s settings.
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2. Click the Project Templates icon.

The Project Template Workbench opens.

3. Click the Ownership button.

The Ownership window opens.

4. Select the Only groups listed below that have the Edit Project Templates Access 
Grant option.

5. Click Add.

The Add Security Groups window opens.
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6. Select a Security Group from the Security Group auto-complete list.

The name of the Security Group you selected is displayed in the Security 
Group field.

7. Click OK to close the Add Security Group window. 

8. Click OK. The Security Groups are added to the Ownership Group and the 
Ownership window closes.

Now only members of the Security Group(s) specified in the Ownership 
window can edit, delete or copy this Project Template.
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Creating a Project Template from an Existing Project
Project Managers can create a new Project Template from an existing Project. 
Project Managers who want to convert their Microsoft Projects into Project 
Management Templates can first import their Microsoft Project into a Mercury 
ITG Project and then convert it into a template. See “Integrating Project 
Management with Microsoft Project” on page 257 for detailed instructions on 
converting a Microsoft Project into a Mercury ITG Project.

To create a Project Template from an existing Project:

1. Click the Project Management screen group.

2. Click the Project icon. 

The Project Workbench opens.

3. Locate and open the Project that you would like to convert to a Project 
Template.

4. Select Project > Convert Project to Template from the menu.

The Convert Project to Template window opens.

If no Ownership groups are associated with the entity, the entity is 
considered global and any user with the Edit Access Grant for the entity can 
edit, copy or delete it. 

Application administrators have the Ownership Override Access Grant and 
can access configuration entities even if the application administrator is not a 
member of one of the Ownership Groups and does not have the Edit Access 
Grant.

If a Security Group is disabled or loses the Edit Access Grant, that group will 
no longer be included in the ownership group.
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5. Enter a new Template Name, Template Owner and Description for the new 
Project Template.

6. Select whether to include Project Setup, Custom Fields, Notifications and 
Resource Groups by checking the associated box.

See “Project to Template Conversion Details” on page 217 for a list of 
items copied from the Project to the Template.

7. Click Convert.

When the conversion is complete, a message window opens.

8. Click Yes to edit the new Project Template.

In order to successfully convert a Project to a Template, you must be the only 
user editing the Project. If other users are editing the Project, a message will 
appear stating that the “Project is being edited by another user” and the 
conversion stops. 

In the Project to Template conversion, not all Project details are copied to the 
new Template. The Project actuals information is discarded during the 
conversion, such as the actual duration, efforts, start date and end date of the 
Project and Tasks. The resource, Task notes and all References in the Project 
are also discarded because the Project Template cannot represent these data.
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Project to Template Conversion Details
Table 8-1 describes the items that are copied or created in the Project Template 
when converted from an existing Project. 

Table 8-1. Items Copied or Created During the Project to Template Conversion 

Item in Project Template Description

The new Template Name Provided by the user.

Enabled Initially set to not enabled.

Template Owner Set to the username of the user performing the conversion

Description Provided by the user.

Default Project Settings Uses the standard default or copies the settings from the Project, 
depending on the choice the user makes. Project settings include all of 
following:

• Project fields (Planning fields and activity fields)

• Exception rules

• Indicators

• Scheduling settings

• Security settings

Custom Fields and Layout The user can select to copy custom fields and their layout. For custom 
fields defined at the Master Project level, the field definitions are copied 
into the new Template. For custom fields defined at the Subproject level, 
only the references to the source Projects are copied.

Notifications Optional setting in the ‘Convert Project To Template’ window.

Project Hierarchy Copied based on the Project.
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Project Info • Project Name: copied

• Project Manager: set to blank

• Project State: clear to default value

• Department: copied

• Template: converted (blank for Master Projects)

• Project Path: converted

• Description: copied

• Priority: copied

• % Complete: set to 0

• Confidence: set to blank

• Predecessors: converted

• Start Date/Actual: set to blank

• Finish Date/Estimate: set to blank

• Finish Date/Actual: set to blank

• Duration/Scheduled: copied

• Duration/Est. Remaining: set to blank

• Duration/Actual: set to blank

• Effort/Scheduled: copied

• Effort/Est. Remaining: set to blank

• Effort/Actual: set to blank

Table 8-1. Items Copied or Created During the Project to Template Conversion  [continued]

Item in Project Template Description
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Task Info • Task Name: copied

• Task Category: copied

• Task State: cleared to default value 

• Department: copied

• Template: copied

• Project Path: converted

• Resource: set to blank

• Resource group: copied

• Description: copied

• Priority: copied

• % Complete: set to 0

• Confidence: set to blank

• Predecessors: converted

• Start Date/Actual: set to blank

• Date/Estimate: set to blank

• Finish Date/Actual: set to blank

• Duration/Scheduled: copied

• Duration/Est. Remaining: set to blank

• Duration/Actual: set to blank

• Effort/Scheduled: copied

• Effort/Est. Remaining: set to blank

• Effort/Actual: set to blank

• Scheduling Constraint: all constraints are removed

Table 8-1. Items Copied or Created During the Project to Template Conversion  [continued]

Item in Project Template Description

Task Notes and all References are dropped, since the Project Template 
cannot represent this data.
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Creating a Master Project from a Project Template
If a company has a business process that is used repeatedly, it will be easier to 
create and manage if it has its own Template containing preconfigured settings. 

To create a new Master Project from a Project Template:

1. Click the Project Management screen group.

2. Click the Project icon. 

The Project Workbench opens.

3. Click New Project. 

4. Enter a Master Project name in the Master Project Name field.

5. Select the desired template from the Project Template auto-complete list.

6. Click OK.

A new Master Project is created, including the Project Plan, all of the fields 
to be collected, Indicators, Exception Rules, Custom Fields, Notifications, 
Financial Management and scheduling parameters defined in the Project 
Template.

Creating a Subproject from a Template
Project Templates can be used to add Subprojects to a Master Project, adding 
Tasks in a predefined order and hierarchy. The new Subprojects added will 
include Notifications, custom fields, and default values for Scheduled Effort 
and Duration. 

To add a set of Tasks to a Project using a Project Template:

1. Open the Project window for the Project that you would like to change. 
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2. Select Project Created from Template from the drop down list.

3. Click Add.

The Add Project Template window opens.

4. Select a Project Template from the auto-complete list and click OK.

The selected Template is added to the Project Plan as a collapsed 
Subproject. If the Subproject is not in the place you want it to be, you can 
move it with the arrows in the Project Plan Panel (See “Setting Up Project 
Hierarchy” on page 55 for more details).

5. Modify the information in any Task inside the Subproject by double-
clicking on it.

The Task Information window for that Task opens.

6. Edit the information.
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7. Click OK to save the information and close the Task Information window, or 
click Save to save the changes without closing the window.
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 Chapter

Creating and Using Project Budgets

This chapter explains how to create, modify, and compare Budgets for use with 
Projects in Project Management.

The following topics are covered:

• Defining a Budget

• Modifying Project Budgets

• Comparing Budgets

Defining a Budget
Project Management’s Financial Management capability allows users to 
capture and track Planned and Actual cost information for their Projects, 
giving visibility into Project performance from a financial standpoint. Budgets 
are a key component of Financial Management.

A Budget indicates an allocation of money between specific start and finish 
dates. Between these dates, the Budget specifies the money available for each 
time period (usually a calendar month). 

Budgets have many key aspects that can be configured:

• A Budget can be associated with a Project or Organization Unit.

• A Budget has lines that can be modified individually.

• Users who can access the Budget can be specified.

• Budgets have states associated with them (New, Proposed, Under Review, 
etc.). 
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The following sections discuss creating and configuring Budgets:

• Creating a Budget

• Associating a Budget with a Project

• Configuring Access to a Budget

Creating a Budget
To create a new Budget:

1. Log onto Project Management.

2. From the menu bar, select Create > Budget.

The Create a New Budget page opens.

3. Enter the Budget Name, Start Period, and Finish Period.

4. Click Continue.

The Create a New Budget: Enter Details page opens.

Budget amounts are always entered in terms of whole thousands.
224 Creating and Using Project Budgets



Managing Your Projects (Project Management)
5. (optional) Enter any desired information in the Budget Information section.

6. To add lines to the Budget, scroll down to the Budget Breakdown section. 

a. Click Add. 

The Add Lines to Budget page opens.
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b. Specify a Type and Category for the Budget line.

c. Click Add.

d. Repeat as necessary.

You can add more than one line to the Budget at a time without 
returning to the Create a New Budget: Enter Details page by clicking Add 
Another once you have filled in the values for one line.

7. The Create a New Budget: Enter Details page reloads with the Budget lines 
added.

8. Enter amounts for each Budget line and period and click Save.

9. (optional) If you want to track actual amounts for your Budget alongside 
the planned amounts, click the Planned and Actuals option in the Show line 
and click Refresh. The Create a New Budget: Enter Details page will reload 
with Act fields allowing you to fill in actual values next to the planned 
amounts in the Budget’s columns.
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Associating a Budget with a Project
A Budget can be associated with a Project from two places:

• Linking a Budget from the Modify Budget Page

• Linking a Budget from the Project Information Window

Linking a Budget from the Modify Budget Page
To link a Budget to a Project from the Modify Budget page:

1. Navigate to the Budget you want to link. 

2. Click Modify Budget.

The Modify Budget page opens.

3. In the Budget Information section, specify Project.

4. Click Save.

Linking a Budget from the Project Information Window
To link a Budget from the Project Information window:

1. In the Workbench, open the Project to link.

2. Double-click the Master Project line.

The Project Information window opens.

3. Click the Cost tab.
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4. Choose the desired Budget from the Budget auto-complete list.

Configuring Access to a Budget
Configuring access to a Budget consists of the following operations:

• Granting Access to a User

• Configuring Existing User Access

Granting Access to a User
To grant a user access to a Budget:

1. Create a new Budget or open an existing one.

2. Click Configure Access at the top of the page.

The Configure Access for Budget page opens.
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3. Select a user from the Give Access to Username auto-complete list.

4. Click Add.

The user is added to the View Access list.

5. Click Save.

The user has been granted View access to the Budget. To configure further 
Budget security options for the user, see “Configuring Existing User 
Access” on page 229.

Configuring Existing User Access
User access to a Budget can be further configured once the user has been added 
to the View Access list. The available options are listed in Table 9-1.

To configure existing user access:

1. Create a new Budget or open an existing one.

2. Click Configure Access at the top of the page.

The Configure Access for Budget page opens.

Table 9-1. Additional Editing Access for a Budget

Field Description

Edit Basic Budget 
Information

Allows the user to edit basic Budget information such as 
Name, Description, Status, etc.

Edit Plan and Actuals Allows the user to edit the Budget’s lines and enter new 
values in the Actuals fields.

Edit Actuals Allows the user to enter new values in the Actuals fields.

Edit Security Allows the user to configure access to the Budget.
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3. Check or un-check the desired boxes in the Additional Editing Access section. 

See Table 9-1 for descriptions of each category.

4. Click Save.

Modifying Project Budgets
Budgets can be accessed from the standard interface from at least two 
locations:

• Selecting Search > Budgets from the menu bar, you can search for and 
open existing Budgets to which you have access.

Figure 9-1 Modify Budget 
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• Selecting Financial Management > Budgets > Modify Budgets opens a 
search page that can be used to locate and open existing Budgets to which 
you have access. You can also delete Budgets and create new Budgets 
directly from this page.

Figure 9-2 Modify Budget 

To modify an existing Budget:

1. Open the Budget and click Modify Budget to open the Modify Budget page.
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2. Make any necessary changes. 

3. (optional) Click Configure Access to open the Configure Access for Budget 
page and configure security options for the Budget.

4. Click Save.
232 Creating and Using Project Budgets



Managing Your Projects (Project Management)
Comparing Budgets
The Budget to Budget Comparison Portlet allows you to make a number of 
comparisons between Budgets, as well as compare a Budget’s planned values 
to its actuals.

As with all Portlets, the Budget to Budget Comparison Portlet’s Edit page allows 
you to choose parameters for the Portlet’s filtering and display of information. 
These parameters are listed in Table 9-2.

The following sections illustrate two uses for the Budget to Budget 
Comparison Portlet.

• Comparing Planned to Actual Values

• Comparing Related Budgets

Table 9-2. Budget to Budget Comparison Portlet parameters

Field Description

Compare One or 
More Budgets

A multi-select auto-complete field that allows you to select 
one or more Budgets.

To Actuals Compares the selected Budget(s) to its actual values, 
assuming any have been entered.

To Active Child 
Budgets

Compares the selected Budget(s) to the Budgets that roll up 
into it (child Budgets).

To Active Child 
Budget Actuals

Compares the selected Budget(s) to the actual values 
entered for its child Budgets.

Another Set of 
Budgets

Compares the selected Budget(s) to another set of Budgets. 
This is another multi-select auto-complete list.

Use Budget The Budget(s)’s planned values will be used in the 
comparison.

Use Actuals The Budget(s)’s actual values will be used in the 
comparison.

Time Period 
Covered by Budgets

Limits the Portlet’s display range to the time period covered 
by the selected Budget(s).

Show From/To Allows you to select a date range to display.
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Comparing Planned to Actual Values
The Budget to Budget Comparison Portlet can be used to compare a Budget’s 
planned values to its actual values, if actual values are being captured. To see 
how to capture actual values for a Budget, see “Creating a Budget” on 
page 224.

You can compare a single Budget’s planned and actual values, as shown in 
Figure 9-3. This is accomplished by selecting a Budget from the Compare One 
or More Budgets field and the To Actuals radio button on the Budget to Budget 
Comparison Portlet’s Edit page.

Figure 9-3 Budget to Budget Comparison Portlet - Single Budget planned vs. 
actual values

In this case, we can see that the actual values for the first month of this Budget 
went over its planned amounts by a fairly significant margin, while the second 
month stayed even, and no values have been entered for the last month.

You might also find it useful to compare a set of Budgets’ planned and actual 
values, as shown in Figure 9-4. This is accomplished by selecting multiple 
Budgets from the Compare One or More Budgets field and the To Actuals radio 
button on the Budget to Budget Comparison Portlet’s Edit page.
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Figure 9-4 Budget to Budget Comparison Portlet - Multiple Budget planned vs. 
actual values

In this case, we can see that user “jakesmith’s” miscellaneous Projects always 
seem to go over budget, while “janesmith” is consistently under budget.

Comparing Related Budgets
The Budget to Budget Comparison Portlet can also be used to compare sets of 
related Budgets, as shown in Figure 9-5. This is accomplished by selecting a 
Budget or Budgets from the Compare One or More Budgets field and the To 
Another Set of Budgets radio button and multi-select auto-complete list on the 
Budget to Budget Comparison Portlet’s Edit page.

Figure 9-5 Budget to Budget Comparison Portlet - Comparing related Budgets
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What we have here is a Portlet comparing the Budget for an entire IT 
Organization Unit with three Project Budgets owned by its members. We can 
see that during almost every month, the combined Budgets for these Projects 
exceeds the Organization Unit’s, in some cases by a wide margin.
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 Chapter

Project Costs

This chapter explains how to use Project Management’s Financial 
Management capabilities to track Project costs. Additional Project- and cost-
related visualizations are accessible from the standard interface.

The following sections discuss Project-based Financial Management in more 
detail:

• Configuring Cost in the Project Settings Window

• Entering Actual Cost Data

• Analyzing Costs in Project Management

Configuring Cost in the Project Settings Window
Selecting Settings from the Project menu at the top of the Workbench opens 
the Project Settings window.
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Figure 10-1 Project Fields Tab of the Project Settings window

The Project Settings window contains tabs controlling various aspects of a 
Master Project. Two tabs in particular focus on Financial Management:

• The Financial Management tab lets you configure how cost data is 
calculated on the Project/Task level, and what level of manual entry is 
needed.

• The Security tab lets you control which users can see cost data for the 
Project.

For more detailed information on configuring Financial Management from the 
Project Settings window, see:

• Financial Management Tab

• Security Tab

Financial Management Tab
The Financial Management tab in the Project Settings window determines 
whether or not cost data is tracked for a Project.
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Figure 10-2 Financial Management Tab of the Project Settings window

Selecting the Enable Financial Management for this Project check box turns on 
Financial Management. You must then choose from the following options for 
the tracking of cost data:

• Automatically calculated for tasks and rolled up to projects
Planned and Actual Labor Costs for Tasks will be automatically calculated 
and rolled up to Projects. These values are not calculated until a Resource 
is assigned to a Task. For definitions of Planned and Actual Labor Costs 
and how Project Management calculates them, see “Financial 
Management” on page 17.

• Manually entered for Tasks but automatically rolled up to Projects
Planned and Actual Labor Costs for Tasks will be entered by the Project 
Manager or other user with the proper level of access. These values are 
rolled up to Projects automatically.

• Manually entered for Tasks and Projects
Planned and Actual Labor Costs for Tasks and Projects will be entered by 
the Project Manager or other user with the proper level of access. These 
values do not roll up.

Security Tab
The Security tab in the Project Settings window determines the users allowed to 
view cost data for a Project. 
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Figure 10-3 Security Tab of the Project Settings window

You can choose from the following options:

• All users (default)

• Project Managers for this Master Project only

• Project Managers for this Master Project <Project Name> and all of its 
Subprojects

• Participants for the Tasks and Projects for which they are Participants

• Project Team only

Entering Actual Cost Data
Actual Labor Cost data can be automatically calculated by Project 
Management as a function of time spent on a Task multiplied by the Rate of 
the Resource assigned to that Task. The values for Tasks can be rolled up to 
their parent Projects.
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Actual Non-Labor Costs, which represent miscellaneous costs incurred in 
performing work on a Task, are manually entered by the user.

Actual Non-Labor Costs can be entered manually at any time. 

For more detailed information about entering Actual Labor Costs, see the 
following sections:

• Actual Labor Cost Settings

• Entering Actual Labor Costs

Actual Labor Cost Settings
Depending on the Financial Management tab setting in the Project Settings 
window, Actual Labor Costs can be entered manually for Projects or Tasks.

• Automatically calculated for tasks and rolled up to projects
Actual Labor Costs for Tasks are calculated by Project Management and 
rolled up to parent Projects. Actual Labor Cost values for Tasks and 
Projects cannot be updated.

• Manually entered for Tasks but automatically rolled up to Projects
Actual Labor Costs are entered manually by the user, and the values are 
rolled up to parent Projects. Project Actual Labor Costs cannot be updated, 
since they are rolled up from subordinate Tasks.

Developer Bob has a Rate of $20/hour. He spends 4 hours on a Task in a bug-
fixing Project. 

The Task’s Actual Labor Cost is computed as $20/hour * 4 hours = $80 for 
the Task.

The bug-fixing Project has a total of 5 Tasks identical to Bob’s. The Total 
Actual Labor Cost for the Project comes to $400 with no Actual Non-Labor 
Costs incurred.

Developer Bob needs to spend $100 on RAM to upgrade his machine so he 
can finish his Task. This is an Actual Non-Labor Cost.
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• Manually entered for Tasks and Projects
Actual Labor Costs are entered manually by the user for Tasks and 
Projects. No roll-up takes place, which means that there can be some 
variance between the sum of Task Actual Labor Costs and the Project’s 
Actual Labor Cost.

Entering Actual Labor Costs
Actual Labor Costs can be entered from the following locations:

• Entering Cost Data in the Project Window - Cost Tab

• Entering Cost Data in the Project Window - Plan Tab

• Entering Cost Data in the Project or Task Information Window

Entering Cost Data in the Project Window - Cost Tab
Actual Labor Cost data can be entered in the Cost tab of the Project window.

To enter Actual Labor Cost data in the Cost tab of the Project window:

1. Open the desired Project in the Workbench.

Before attempting to enter Actual Labor Cost values for a Project, check the 
Project Settings window’s Financial Management tab to verify the Financial 
Management settings.

Financial Management must be turned on from the Project Settings window’s 
Financial Management tab in order for the Cost tab to be enabled.
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2. Verify in the Project Settings window’s Financial Management tab that you 
can enter Actual Labor Cost values for Tasks or Projects. 

The All Planned Labor Costs and Actual Labor Costs will be radio button should 
be set to one of the last two options, depending on what level of control is 
desired.

Upon verifying, click OK. The Project Settings window closes, returning 
you to the Project window.

3. Click the Cost tab.

4. Enter the Actual Labor Cost values in the appropriate Task or Project lines 
as described in the Table 10-1 on page 243.

5. Save the changes.

Click Save to save changes to the Project and continue editing it. Click OK 
to save changes to the Project and close the Project window. Click Cancel to 
close the Project without saving any changes.

Table 10-1. Project Information window - Cost tab fields and controls 

Field Description

Project Cost Health Indicates cost health based on Cost Summary Condition 
settings.
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Entering Cost Data in the Project Window - Plan Tab
To enter Actual Labor Cost data in the Cost tab of the Project window:

1. Open the desired Project in the Workbench.

Baseline Labor Labor cost for the Task or Project in the latest Baseline of 
the Project.

Baseline Non-Labor Non-Labor cost for the Task or Project in the latest Baseline 
of the Project.

Baseline Total Total cost planned for the Task or Project in the latest 
Baseline of the Project.

Planned Labor Dollar cost planned to be spent on the amount of scheduled 
effort involved to complete the Task or Project.

Planned Non-Labor Dollar cost planned to be spent on miscellaneous costs 
required to complete the Task or Project.

Planned Total Total dollar cost planned to be spent on the Task or Project.

Actual Labor Dollar cost of the effort performed on a Task or Project 
during a given time period.

Actual Non-Labor Dollar cost of the miscellaneous costs acquired in 
completing a Task or Project.

Actual Total Total dollar cost incurred in completing a Task or Project 
during a given time period.

Budget Name of the Project Budget.

Table 10-1. Project Information window - Cost tab fields and controls  

Field Description
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2. Open the Project Settings window.

3. In the Project Fields tab, enable the desired fields (Actual Labor, Actual Non-
Labor, Planned Labor, Planned Non-Labor).

4. Verify in the Financial Management tab that you can enter Actual Labor 
Cost values for Tasks or Projects. 
Project Costs 245



Managing Your Projects (Project Management)
The All Planned Labor Costs and Actual Labor Costs will be radio button should 
be set to one of the last two options, depending on what level of control is 
desired.

Upon verifying, click OK. The Project Settings window closes, returning 
you to the Project window.

5. Click the Plan tab.

6. Enter the Actual Labor Cost values in the appropriate Task or Project lines.

7. Save the changes.

Click Save to save changes to the Project and continue editing it. Click OK 
to save changes to the Project and close the Project window. Click Cancel to 
close the Project without saving any changes.

Entering Cost Data in the Project or Task Information Window
To enter Actual Labor Cost data in the Cost tab of the Project or Task 
Information window:

1. Open the desired Project in the Workbench.

2. Verify in the Project Settings window’s Financial Management tab that you 
can enter Actual Labor Cost values for Tasks or Projects. 
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The All Planned Labor Costs and Actual Labor Costs will be radio button should 
be set to one of the last two options, depending on what level of control is 
desired.

Upon verifying, click OK. The Project Settings window closes, returning 
you to the Project window.

3. Double-click the Project or Task you want to update.

The Project or Task Information window opens. 

4. Click the Cost tab.

5. Enter the Actual Labor Cost values in the appropriate Task or Project lines.

6. Save changes to the Project or Task.

Click Apply to save changes to the Project or Task and continue editing it. 
Click OK to save changes to the Project or Task and close the Project or 
Task Information window.

7. Save changes to the Project.

Click Save to save changes to the Project and continue editing it. Click OK 
to save changes to the Project and close the Project window. Click Cancel to 
close the Project without saving any changes.
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Analyzing Costs in Project Management
Project Management provides convenient and powerful tools for visualizing 
your Project Cost data. Using specialized Project Management pages and 
Portlets, you can:

• Display Projects being managed by a particular user, arranged according to 
the size of their Budget. The Projects’ Cost health, and CPI/SPI 
performance are also indicated.

• Display Projects in a particular Department, arranged according to their 
Baseline cost. The Projects’ Cost health, and CPI/SPI performance are also 
indicated.

• Display Projects being managed by a particular user, arranged according to 
their projected Actual Cost at completion. The Projects’ Cost health, and 
CPI/SPI performance are also indicated.

• Display a chart for a single Project graphing any of the following values 
over a configurable period of time:

o Planned Value

o Earned Value

o Actual Costs

o Budget

o Budget Actuals

For more information on analyzing Project Costs in Project Management, see 
“Analyzing Project Costs” on page 154.
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Project Management Reports

Mercury Project Management features a pre-defined set of HTML-based 
Reports that are accessed through a Web browser. The Reports provided with 
Project Management allow users to view the current detailed status of their 
deployment data at any point in time. 

This chapter describes the procedures used to submit and view Reports using 
both the standard interface and the Workbench. 

This chapter covers the following topics:

• “Reports Overview” on page 249

• “Processing Reports” on page 252

Reports Overview
The standard Reports that ship with Mercury Project Management and a brief 
description are listed in the following table. These Reports can be accessed 
through both the Workbench and the HTML interface. 

The following table lists all standard Report Types that have a product scope 
of Project Management or All Products. 
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Table 11-1. Standard Project Management Reports 

Report Description

Portlet Detail Report Returns the definitions of selected Portlets, including 
columns, filter fields, access security, ‘used by,’ and the 
Portlets’ full SQL query.

Project Schedule 
Change Report

Compares the current Project schedule to that of a 
baseline, or baselines to each other.

Project Critical Path 
Report

Lists the Tasks that make up a Project’s critical path.

Notification History 
Report

Lists Notifications that have been sent or are pending.

Portlet Detail Report Returns the definitions of selected Portlets, including 
columns, filter fields, access security, ‘used by,’ and the 
Portlets’ full SQL query.

Project Custom Detail 
Report

Lists only the specified columns from the header fields and 
custom field parameters in HTML table format.

Project Detail Report Provides the details of each Project.

Project Detail (Filter 
by Custom Fields) 
Report

This report is similar to the Project Detail Report. The only 
difference is the report can filter by custom fields.

Project Exception 
Detail Report

Lists all the task details for the tasks that have triggered 
Exceptions and need attention by a Project Manager. 

Project Resource 
Report

Lists all the resources working on a project and the tasks 
that the resources are working on.

Project Status Detail 
Report

A summary of Project statuses of selected Projects and 
Tasks.

Project Task 
Assignment Report

Shows which users or groups have been assigned to the 
Tasks for a given Project.

Project Summary 
Report

Provides a summary of all the Projects that meet criteria 
entered in the header fields.

Project Template 
Detail Report

Lists the parameters and parameter details for every 
Project Template.

Report Type Detail 
Report

Lists the parameters and parameter details for each 
Report Type as well as the commands used to run the 
Report.

Resource Availability 
Report

Provides a high level view of the availability of Resources 
in Project Management.
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Report Type Detail 
Report

The parameters and parameter details for each Report 
Type, as well as the exact commands used to run the 
report.

Run Field Security 
Denormalization

Runs Field Level Security related denormalization tasks 
for particular entities.

Run ITG Organization 
Unit Interface

Imports data from the organization unit interface tables or 
an LDAP server.

Run ITG Package 
Interface Report

Validates and loads Package data from the Package open 
interface tables into the standard Mercury Change 
Management data model. 

Run ITG User 
Interface Report

Imports data from the user interface tables or an LDAP 
server.

Run License Usage 
report

View current License usages.

Run Workflow 
Transaction Interface 
Report

Validates and runs Workflow transactions based on data 
in the Workflow open interface tables. Used to kick-off 
process steps from outside the end-user screens

Security Group Detail 
Report

Lists the set-up information for a single Security Group or 
a group of Security Groups. It also lists which users belong 
to the group and what Workflow Steps the Security Group 
has access to.

Special Command 
Detail Report

This report lists details for a special command or a range 
of special commands.

Synchronize Meta 
Layer Report

Assesses or synchronizes the Meta Layer.

User Data Detail 
Report

Reports on the definition of each custom field. 

User Detail Report Lists the users defined in your Mercury ITG system as well 
as the Security Groups attached to each user.

Validation Report A System Administration report on the various custom 
Validations that your application administrator has entered 
into the system or which come standard with the Mercury 
ITG Center.

Workflow Detail 
Report

Use this report to view the complete definition of a specific 
Workflow or a set of Workflows.

Workflow Statistics 
Report

Uses a given date range and a Workflow (or a range of 
Workflows) to provide statistical information regarding the 
usage of the Workflow.

Table 11-1. Standard Project Management Reports  [continued]

Report Description
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Processing Reports
Mercury Project Management reports can be run either from the Workbench or 
the standard (HTML) interface. Similarly, previously run reports can be 
viewed from either interface. The following sections provide instructions for 
processing and viewing reports:

• Submitting a Report from the Workbench

• Submitting a Report from the HTML Interface

• Viewing Previously Submitted Reports

Submitting a Report from the Workbench
To submit a report from the Workbench: 

1. Click Project Mgmt.

2. Click the Reports icon.

3. The Report Submission Workbench opens.

4. Click New Report. 

The New Report Submission window opens.

5. Select the type of report to submit from the Report Type auto-complete list.

After selecting the Report Type, report-specific parameters appear in the 
Parameters tab of the New Report Submission window. 

All Report Types that end with ‘Report’ are textual reports that list details 
about specific entities. Report Types that end with ‘Program’ perform some 
activity and then report on their results.

You might not have access to all Report Types. If you need access to a 
Report Type, but do not see it listed, contact your application administrator 
for permission. 
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6. Fill in all the required parameters (as indicated by the red field label) and 
any optional parameters for the report.

7. Set up the schedule for running the report:

a. Click the Scheduling tab and specify when the report is to be run. If no 
scheduling information is entered, the report runs immediately.

b. Enter the frequency with which the report should be re-run.

8. Set up the Notification:

a. Click the Notifications tab. 

b. Click New. 

c. Select any users who should be informed of the report results. 

d. Click OK to close the Add Notification for Report Submission window.

9. Click Submit to run the report. 

10. Click View Report to view the results in your Web browser.

11. If the report fails, click View Log to view the technical details of the report 
execution.

Submitting a Report from the HTML Interface
Mercury Project Management reports can be run from the standard (HTML) 
interface. 

To run a report from the standard interface:

1. Logon to Mercury Project Management.

2. From the menu bar, select Reports > Project Reports.

The Available Reports page opens.
Project Management Reports 253



Managing Your Projects (Project Management)
3. Choose the report to be submitted from the list of Report Types by clicking 
on its name. 

The report’s creation page opens. 

This example of a Report page shows the required and optional fields for 
the Project Custom Details Report. Each Report Type has its own set of 
required and optional fields. The Report creation page always displays a 
different set of fields depending on which Report Type is selected.

4. Enter information in the Report creation page’s required fields.
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5. (Optional) Enter information in the Report creation page’s optional fields.

6. Click Submit.

The Report Submitted page opens. The report’s output is displayed in a 
separate page.

Viewing Previously Submitted Reports
You can view previously submitted reports. This section discusses the 
following topics: 

• Viewing Reports from the Workbench

• Viewing Reports from the HTML Interface

Viewing Reports from the Workbench
To view previously submitted reports:

1. Enter search criteria in the Query tab of the Reports Workbench.

2. Click Search. 

All matching report submissions are listed in the Results tab. 

3. Click Open to view the criteria used for the report.

4. Click View Report to view the report output.

You might not have permission to view all reports. If that is the case, contact 
your application administrator to get permission for reports that are restricted 
by Security Groups. You might also not have access to any reports that are 
restricted to Creator only.

It is not possible to modify the values used for a previous report submission. 
However, it is possible to select a particular report submission on the Results 
tab of the Report Submissions Workbench and click Copy. This makes an 
exact duplicate of the report submission. The duplicate report submission can 
be modified and submitted.
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Viewing Reports from the HTML Interface
To view a previously submitted report from the standard (HTML) 
interface:

1. Logon to Mercury Project Management.

2. Select Search > Reports. 

The Report Search page opens. 

3. In the Search Information section, enter search criteria in the appropriate 
fields. 

4. Under Result Display Options, enter the maximum number of results to be 
displayed.

5. Click Search. 

The Report Search Results page opens. The page displays summary 
information about any reports that match your search criteria.

6. Click the Report Number under the Report # column to see the output 
details of any report.
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Integrating Project Management
with Microsoft Project

This chapter explains how to integrate Project Management with Microsoft 
Project. The Project Management - Microsoft Project interface allows Project 
Managers to import project information from Microsoft Project to a new 
Mercury ITG project. Project information can also be exported from Project 
Management to Microsoft Project, creating a new project in Microsoft Project. 
Projects that have been imported or exported can be synchronized. Any 
information that is shared between projects in both applications is updated 
during synchronization.

The following topics are covered:

• Synchronization Modes

• Project Management Strategies

• Requirements for the Project Management - Microsoft Project Interface

• Exporting to Microsoft Project from Project Management

• Importing from Microsoft Project

• Synchronizing Microsoft Project and Project Management

• Synchronization of Resources

• Impact of Microsoft Project Rules on Fields

• Conditional Editing Allowed In Project Management

The Project Management - Microsoft Project interface is only compatible 
with Microsoft Project 98 and 2000, North American localization. It is not 
compatible with earlier versions of Microsoft Project such as Project Central. 
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• Summary of Synchronization Behavior

• Integration with Other Mercury ITG Products

• Available Reports

• Troubleshooting

Synchronization Modes
By importing, exporting and synchronizing information between Project 
Management and Microsoft Project, you have the advantage of using the “best 
of both possible worlds.” Depending on your project management strategy, 
you can use one application to perform all planning and tracking activities, and 
then use the other for publishing project information to managers, participants 
and stakeholders. See “Project Management Strategies” on page 259 for more 
information about different project management strategies.

The Project Manager can select from three synchronization modes for 
importing/exporting information between Project Management and Microsoft 
Project. Each mode offers a different strategy for communication between the 
two applications and has its own set of advantages. The three modes are:

• Project Management controlled

• Microsoft Project controlled

• Project Management controls actuals

Project Management controlled
The Project Manager initially creates a project in Project Management to 
perform planning and tracking activities. These activities include defining the 
project, scheduling tasks and tracking actuals. The first time the project is 
synchronized, Project Management creates a new project file on the Project 
Manager's desktop computer. For each subsequent synchronization, all of the 
information in the Microsoft Project project that is also contained in the 
Mercury ITG project is replaced with the current information in Project 
Management. Other information in the Microsoft Project project (custom 
fields, resource cost rates, etc.) is not altered.

After exporting, the Project Manager can distribute the Microsoft Project file 
or use it to run reports for managers and other people in the organization. 
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Microsoft Project controlled 
The Project Manager creates a project in Microsoft Project to perform project 
planning and tracking activities and then synchronizes it in the Workbench. 
The synchronized Mercury ITG Project automatically rolls up into the 
Mercury ITG Dashboard. Also, participants can create references from tasks in 
the synchronized project to other Mercury ITG information (Requests and 
Packages). These references can provide information back to the Project 
Manager, or can automatically inform external participants of project events 
they are monitoring.

For all subsequent synchronizations, information in Project Management is 
updated with current information from Microsoft Project.

Project Management controls actuals
The Project Manager plans and schedules the project in Microsoft Project 
while using Project Management to track actuals. Participants in the project 
directly report actuals data using the Task Update Portlet in the standard 
interface. Each subsequent synchronization updates the Microsoft Project file 
with actuals data from Project Management. The Mercury ITG Project is 
updated with changes to the project structure or schedule in Microsoft Project.

See “Synchronizing Microsoft Project and Project Management” on page 275 
for more information about synchronization.

Project Management Strategies
The following scenarios demonstrate how Project Managers can use different 
project management strategies offered by the Project Management - Microsoft 
Project interface. 

• Converting a Microsoft Project File to a Mercury ITG Project - Overview

• Publishing a Mercury ITG Project through Microsoft Project

• Publishing a Microsoft Project File through Project Management

• Using Project Management to Track Actuals in Microsoft Project
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Converting a Microsoft Project File to a Mercury ITG Project - 
Overview

A Project Manager who has previously used Microsoft Project but is adopting 
Project Management can use the interface to convert a Microsoft Project 
project to a Mercury ITG Project. Conversion is a one-time action, but the 
Project Manager might want to keep the Microsoft Project project and the 
Mercury ITG Project synchronized after conversion. 

To convert a Microsoft Project file to a Mercury ITG Project:

1. Save the Microsoft Project project to a local file on your computer.

2. Open the Workbench and start an import from the Project window. 

3. Follow the instructions from the Import Wizard. (See “Importing from 
Microsoft Project” on page 269 for detailed instructions.) 

a. Browse for the Microsoft Project project file. 

b. Enter additional information about the new Project in the Wizard as 
you go through the steps of the Import.

When the Import Wizard completes the procedure, the Project Manager can 
see the new project in Project Management and can decide whether or not to 
save the project. The Microsoft Project project has been updated with 
hyperlinks to the related pages in the standard interface. The Project Manager 
can decide whether to save these changes also. Both projects will have unsaved 
changes.

Initially, the Project Manager might want to keep the project under the control 
of Microsoft Project, and periodically synchronize the Mercury ITG Project 
with Microsoft Project information. (See “Publishing a Microsoft Project File 
through Project Management” on page 261 for more information about 
synchronizing projects.) This allows the Project Manager to see how the 
project is presented in Project Management. Later, when the Project Manager 
is more comfortable with Project Management, the Project Manager can 
change to the Project Management controlled mode, and can decide to stop 
synchronizing the project with Microsoft Project entirely.

Publishing a Mercury ITG Project through Microsoft Project
A Project Manager who uses Project Management to manage projects can use 
the Project Management - Microsoft Project interface to publish the projects. 
Publishing can simply mean distributing the Microsoft Project project file to 
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external audiences (such as a PMO group). Publishing could also mean 
synchronizing the Microsoft Project project file with Project Management, and 
then running Microsoft Project reports for distribution. The projects can be 
published on a regular basis (weekly or quarterly) or at defined milestones 
(such as design completion). 

To publish a Mercury ITG project through Microsoft Project:

1. Open the project to be exported in Workbench. 

2. Export the project into a new Microsoft Project project file. (See 
“Exporting to Microsoft Project from Project Management” on page 265 
for detailed instructions.)

Since a project created in Project Management defaults to the 
synchronization settings for Project Management controlled mode, the 
Project Manager will probably not need to change any project settings.

3. A new Microsoft Project project is created and opens.

You can then save the project and run reports as usual.

After the first export, you will synchronize the Mercury ITG project with the 
Microsoft Project project. This will effectively overwrite shared information, 
but will not affect additional information in the Microsoft Project project that 
is added manually after the export has occurred (such as a baseline). 

Publishing a Microsoft Project File through Project Management
A Project Manager who uses Microsoft Project to manage projects can publish 
those Projects using Project Management. Publishing means loading the 
project data into the Project Management repository, which has the following 
benefits:

• The Project Status appears in the Mercury ITG Dashboard. Project 
Management calculates exceptions and stoplight status (red/yellow/green) 
based on the project settings on the Mercury ITG project.

If you want to export a new project each time, the Project Manager can 
simply rename the Microsoft Project file on the computer before clicking the 
Synch button, which causes Project Management to export into a new file.
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• Project participants and external audiences can see the project in various 
interfaces such as the My Tasks Portlet and the search screens. Although 
these participants cannot use Project Management to update Project Status, 
this is an effective way to increase visibility of project information through 
the standard interface.

• Project Management users can create references from other Mercury ITG 
entities (such as Requests and Packages) to tasks in the synchronized 
project. These references could be used to monitor the state of a particular 
task, and block progress on a Request or Package until the predecessor task 
is complete.

The Project Manager is likely to publish the project to Project Management on 
a regular basis. The Project Manager's actions are identical to the scenario 
described in Publishing a Mercury ITG Project through Microsoft Project, 
except that synchronization is left in Microsoft Project controlled mode for all 
shared project data.

Using Project Management to Track Actuals in Microsoft Project 
A Project Manager who uses Microsoft Project to plan and manage projects 
can use Project Management to collect actuals from participants. In addition to 
the benefits described in Publishing a Microsoft Project File through Project 
Management, this integration shifts some of the effort of collecting and 
entering actuals information from the Project Manager to the participants. The 
Project Manager will need to periodically synchronize the projects, either to 
publish a re-planned project to Project Management or to collect new actuals 
updates into Microsoft Project.

To use Project Management to track actuals from Microsoft Project:

1. Import the Microsoft Project project into Project Management.

2. During the import, select the ‘Project Management controls actuals’ 
synchronization mode.

Initially, the Mercury ITG project is identical to the Microsoft Project 
project. After the import, participants or the Project Manager can enter 
actuals information into Project Management.

3. The Project Manager synchronizes the two projects, and the Microsoft 
Project file is updated with the new actuals in Project Management.
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This causes some changes to schedule dates in the Microsoft Project 
project. For example, an actual start date entered into Project Management 
will overwrite a scheduled start date in Microsoft Project.

The Mercury ITG Project is updated to match the project structure and 
schedule information of the modified Microsoft Project project. Both Projects 
are shown to the Project Manager in their respective applications, and the 
Project Manager can choose whether to save either or both projects. If 
necessary, the Project Manager can adjust the Microsoft Project project. This 
can mean shifting assignments, changing schedule dates (using the Microsoft 
Project resource leveling feature), or other changes. The Project Manager 
saves the changed Microsoft Project project and synchronizes it with Project 
Management a second time to publish these schedule changes to participants.

Requirements for the Project Management - Microsoft 
Project Interface

The Project Manager configures the interface behavior and performs 
synchronizations from the Workbench. The Project Management - Microsoft 
Project interface is transparent from the Microsoft Project side, with the 
exception of task hyperlinks added to Project Management Web pages. To 
perform import, export and synchronization procedures, the following 
requirements must be met: 

• Microsoft Project Requirements

• Access Grants

• Required Software

Microsoft Project Requirements
The Microsoft Project requirements for the interface are:

• Microsoft Project must be installed on the desktop PC.

• The saved project file must either be on the local PC, or on a mapped 
network drive.
Integrating Project Management with Microsoft Project 263



Managing Your Projects (Project Management)
Access Grants
The Project Manager needs a Mercury ITG Power license and the appropriate 
Access Grants. The Project Management - Microsoft Project interface relies on 
two Project Management Access Grants: Edit Projects and Project Manager.

The Edit Projects Access Grant allows a user to edit planning data for a 
Mercury ITG project, but only if that user is identified as one of the Project 
Managers. (Each Mercury ITG project has a distinct list of one or more Project 
Managers.) 

The Project Manager Access Grant is a skeleton-key grant that allows the user 
to edit planning data for all Mercury ITG projects. Both grants allow the user 
to create new projects.

In order to use the Project Management - Microsoft Project interface, a user 
needs to have either:

• The Edit Projects Access Grant and be a Project Manager for the specific 
project.

Or 

• The Project Manager Access Grant.

Required Software
In order for the Workbench to communicate with the Microsoft Project 
installation on the Project Manager’s desktop computer, an additional file must 
be installed. 

The Security model for the Project Management - Microsoft Project interface 
is as follows:

• If the user is allowed to edit the planning data for the Project Management 
master project, then that user can export or synchronize the project. Any user 
who can create a Mercury ITG project in the Project Management application 
can also create a Mercury ITG project by importing an Microsoft Project 
project.

• The Project Manager Access Grant is an easy way to give global permissions 
to the Program Management Office (PMO) staff.
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A Windows Dynamic Link Library (.DLL) file must be installed on the Project 
Manager’s desktop computer. This .DLL file needs to reside somewhere in the 
PATH of the Windows operating system.

• If your browser is Internet Explorer, the process of installing the .DLL file 
is automatic.

• If your browser is Netscape, you will be prompted to manually download 
and install the .DLL file. The first time you try to use the Microsoft Project 
Integration feature, a dialog box opens that contains a link to the file. Click 
the link and follow the download/install procedure. You can download the 
file from the Mercury ITG Web server to an appropriate location such as 
C:\WINDOWS, C:\WINNT, or the SYSTEM or SYSTEM32 directories. 
Then restart your Netscape browser.

Exporting to Microsoft Project from Project 
Management

The following procedure describes how to export a Mercury ITG project to 
Microsoft Project. This creates a new project in Microsoft Project using the 
exported project’s information.

1. Click the Project Mgmt screen group.

2. Click the Projects icon.

The Project Workbench opens.

Before exporting or synchronization, the Project Manager can select a 
synchronization mode from the MSP Synchronization tab in the Settings 
window or accept the default, Project Management controlled. See “Setting 
Up Microsoft Project Integration” on page 48 for more information about 
selecting a synchronization mode in the Settings window.
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3. Query for and open the project to be exported.

When the Project window opens, a menu option File > Export to Microsoft 
Project is available if the project was not originally imported from 
Microsoft Project or if it has never been exported to Microsoft Project. If 
the project does not meet these criteria, then the option displays as Synch 
with MSP.

4. Select the menu option File > Export to Microsoft Project.

The Export to Microsoft Project Wizard opens. 

The various steps of the Export process are shown in the Progress Indicator 
column on the left side of the Wizard. The current step of the Export 
process always displays in bold. Each step has its own interface that 
displays within the Export to Microsoft Project wizard. After each step is 
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completed, a check mark appears by the name of the step. At this point, you 
should be at the Select Destination File step of the process.

You can click Next after completing each step of the Wizard or click Export 
Now. 

• Click Next to go to the next interface for selecting options for the 
Export. 

• Click Export Now at any step to bypass the remaining steps and begin 
exporting the Mercury ITG project file. The Wizard uses the system 
default settings the first time you export a project. For each subsequent 
Export, the Wizard uses the settings from the last time you exported a 
Mercury ITG project.

5. Select a drive/directory as a destination for the new Microsoft Project file.

Either enter a new file name or select an existing file name for the 
Microsoft Project file to be created during the export. 

The path and name of the new Microsoft Project file appears in the File 
Chooser field.

6. Click Next.

The Confirm Options interface displays in the Export to Microsoft Project 
Wizard. It displays the following information:

• The path and name of the Microsoft Project file to be created during the 
Export.

• The properties selected by the user on the MSP Synchronization tab of 
the Project Settings window.

7. If the options presented on this interface are not correct, click the Back 
button, go to the appropriate step in the Export process and change the 
options. (Or close the Wizard to access the Microsoft Synchronization 
Project Settings. These are located on the MSP Synchronization tab of the 
Project Settings window.)

If the options presented on this interface are correct, click Export Now.

The Microsoft Project file is created from the Mercury ITG project and 
displays as an icon on the Windows taskbar. The Finish interface displays in 
the Export from Microsoft Project Wizard. This interface informs you whether 
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or not the export was successful and if there are warnings in the 
Synchronization Report. 

8. To see the Synchronization Report, click Show Synchronization Report. 

The report displays in a separate browser window, as shown in the example 
below.

See “Available Reports” on page 290 for more information about the 
Synchronization Report.

9. (Optional) Go to the Messages section of the report to see any warnings 
created during the Export process. 

10. Click Finish to close the Export from Microsoft Project window. 

To see the most recent Synchronization Report after the Export from Microsoft 
Project window has been closed, select View > Latest Synchronization Report 
from the Project menu. 
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11. Verify the project data in both Project Management and Microsoft Project 
and either save or abandon the projects.

An example of a Microsoft Project file created by exporting a Mercury ITG 
project is shown below. 

Importing from Microsoft Project
The following procedure describes how to import a Microsoft Project file into 
Project Management. This creates a new project in Project Management using 
the imported project’s information.

When you import a large Microsoft Project (or a large number of projects) 
into Project Management, tables in the Mercury ITG database are updated to 
handle this new configuration. Because of the scope of database changes, 
you should re-run the Database Statistics on your Mercury ITG Database. 
Contact your application administrator for help with this procedure.
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To import a Microsoft Project file into Project Management:

1. Click the Project Mgmt screen group.

2. Click the Projects icon.

The Project Workbench opens.

3. Click Import From MSP.

The Import from Microsoft Project Wizard opens. 

The various steps of the Import process are shown in the Progress Indicator 
column on the left side of the Wizard. The current step of the Import 
process always displays in bold. Each step has its own interface that 
displays within the Import from Microsoft Project Wizard. After each step is 
completed, a check mark appears by the name of the step. At this point, you 
should be at the Select Source File step of the process.

You can click Next after completing each step of the Wizard or click Import 
Now. 
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• Click Next to go to the next interface for selecting options for the 
Import. 

• Click Import Now at any step to bypass the remaining steps and begin 
importing the Microsoft Project file. The Wizard uses the default 
settings the first time you import a project. For each subsequent Import, 
the Wizard uses the settings from the last time you imported a 
Microsoft Project file.

4. Select the appropriate drive/directory and choose the Microsoft Project file 
to be imported. 

The path and name of the Microsoft Project file to be imported appears in 
the File Chooser field.

5. Click Next.

The Enter Project Details interface displays in the Import from Microsoft Project 
Wizard. 

6. Enter a unique Project Name for the new Mercury ITG project in the Project 
Name field. 

7. Select a Project Manager (or Managers) for the new Mercury ITG project 
from the Project Manager auto-complete list.

8. Click Next.

The Select Control Mode interface displays in the Import from Microsoft Project 
Wizard.

9. Select the synchronization control mode for the new project by clicking the 
appropriate radio button.

Clicking a control mode’s radio button displays a description of the control 
mode in the Description information box. See “Synchronization Modes” on 
page 258 for more information about synchronization modes.

10. Click Next. 

The Verify Resources interface displays if there are Microsoft Project 
resources that could not be matched to Project Management users. The 
unmatched resources shown in the Wizard and their assignments will not 
be imported. To display the unmatched resources in a browser window, 
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click Show Printable Version. An example of the Unsuccessful Resources 
Match Report is shown below.

11. Click Next.

The Confirm Options interface displays the following information:

• The path and name of the Microsoft Project file to be imported.

• The Project Name and Project Manager of the new Mercury ITG 
project.

• The synchronization control mode selected by the user.

• Whether or not unmatched resources were found.

12. If the options presented on this interface are not correct, click the Back 
button, go to the appropriate step in the Import process and change the 
options.

If the options presented on this interface are correct, click Import Now.

The Microsoft Project file opens and is imported into Project Management. 
A new Mercury ITG project is created.
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The newly created Mercury ITG project opens. An example of the Mercury 
ITG project created by importing the Microsoft Project file 
Software_Release.mpp is shown below. Notice that it has the unique name 
Software_Release_1.

13. To view the Synchronization Report, click Show Synchronization Report. 

The report displays in a separate browser window. See “Available 
Reports” on page 290 for more information about the Synchronization 
Report.
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14. Click Finish to close the Import from Microsoft Project window.

15. Verify the project data in both Project Management and Microsoft Project 
and save the projects.

To see the most recent Synchronization Report after the Import from Microsoft 
Project window has been closed, select View > Latest Synchronization Report 
from the Project menu.
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Synchronizing Microsoft Project and Project 
Management

The following procedure describes how to synchronize projects in Project 
Management and Microsoft. Any information that is shared between them is 
updated during the synchronization.

To synchronize projects in Project Management and Microsoft Project:

1. Click the Project Mgmt screen group.

2. Click the Projects icon.

The Project Workbench opens.

During the import process, Project Management adds a hyperlink from each 
Microsoft Project task to the related page in the standard interface (such as a 
Task Detail, Subproject Summary or Project Summary page). This hyperlink is 
placed in the standard fields for task hyperlinks, and can overwrite existing 
hyperlinks. 

Existing hyperlinks can be moved to a Microsoft Project custom field of the 
type “Text.” 

Before exporting or synchronization, the Project Manager can select a 
synchronization mode from the MSP Synchronization tab in the Settings 
window or accept the default, Project Management controlled. See “Setting 
Up Microsoft Project Integration” on page 48 for more information about 
selecting a synchronization mode in the Settings window.
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3. Query for and open the project to be exported.

When the Project window opens, a menu option File > Export to Microsoft 
Project is available if the project was not originally imported from 
Microsoft Project or if it has never been exported to Microsoft Project. If 
the project does not meet these criteria, then the option displays as Synch 
with MSP.

4. Select Synch with MSP.

The Synchronize with Microsoft Project Wizard opens. 

The various steps of the Synchronization process are shown in the Progress 
Indicator column on the left side of the Wizard. The current step of the 
Synchronization process always displays in bold. Each step has its own 
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interface that displays within the Synchronize with Microsoft Project Wizard. 
After each step is completed, a check mark appears by the name of the step. 

5. The Confirm Options interface displays the following information:

• The path and name of the Microsoft Project file that the current 
Mercury ITG project will be synchronized with. This will be either a 
file that was originally imported from Microsoft Project or a file that 
was exported to Microsoft Project from the current Mercury ITG 
project.

• The properties selected by the user on the MSP Synchronization tab of 
the Project Settings window.

6. If the options presented on this interface are not correct, click the Cancel 
button and change the properties in the Settings window.

If the options presented on this interface are correct, click Synch Now.

The Mercury ITG project is synchronized with the Microsoft Project file.

7. To see the Synchronization Report, click Show Synchronization Report. 

See “Available Reports” on page 290 for more information about the 
Synchronization Report.

8. Click Finish to close the Synchronize with Microsoft Project window. 

9. Verify the project data in both Project Management and Microsoft Project 
and either save the projects or close them without saving.

Synchronization of Resources
In Project planning, the concept of “resources” can have multiple definitions. 
A resource can be a team member, time on a mainframe computer, or 
construction materials. A resource in Project Management is a Project 

To see the most recent Synchronization Report after the Synchronize with 
Microsoft Project window has been closed, select View > Latest 
Synchronization Report from the Project menu. 
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Management user or group of users capable of performing Tasks. Resources 
are chosen from the Project Team specified by a Project Manager. Microsoft 
Project supports tracking and costing of both human and material resources. 
Project Management supports only human resources.

A project can also contain resources that have not been assigned. In Microsoft 
Project, unassigned resources appear in some resource-centric project views 
but have little functional significance. In Project Management, unassigned 
resources are Project Management users listed in the Project Team who have 
no task assignments. During synchronization, all assigned human resources are 
synchronized. Unassigned human resources and unassigned material resources 
are not synchronized. 

After synchronization, there will be a Microsoft Project resource matching 
every Project Management resource. If a Project Management resource is 
missing from the Microsoft Project file, a matching resource will be created. 
Each Mercury ITG project has a configuration setting (in the MSP 
Synchronization tab of the Settings window) specifying whether Microsoft 
Project resources created during synchronization are labeled with the Project 
Management username or the Project Management first/last name. The default 
value is by Project Management username.

Because the two applications define resources differently, not every Microsoft 
Resource will be defined in Project Management. After synchronization, there 

Resource synchronization is based on either of two factors:

• A match between the Microsoft Project resource name and Project 
Management username.

Or

• A match between the Microsoft Project resource name and the 
concatenation of Project Management user’s first name and last name. 

This match is not case-sensitive. In Microsoft Project, it is possible to have 
two resources with the same name that vary only by which letters are 
uppercase or lower case. The synchronization mapping logic first checks for a 
match with the same upper/lower case. If no match with exact case is found, 
the first case-insensitive match is used. 

In Project Management, the synchronization does not guarantee that all 
assigned resources are part of the Project Team. If the Project Team needs to 
be maintained, then this must be done manually.
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can be some Microsoft Project resources with no matching Project 
Management resource, because new Project Management resources (which are 
always users) are not automatically created. These unmatched Microsoft 
Project resources are listed in the Microsoft Project Synchronization Report. 
See “Available Reports” on page 290 for more information on reports.

When the Import Wizard detects unmatched resources, the Wizard displays a 
list of these resources (in the Verify Resources step of the process) and offers 
the option of opening a printable version of this list in a browser window. This 
is in addition to listing the unmatched resources in the Microsoft Project 
Synchronization Report. The Project Manager can cancel the import at this 
point, create the missing users (or have the application administrator create the 
users) and run the import again. 

Impact of Microsoft Project Rules on Fields
Microsoft Project contains a number of internal rules that determine the way 
field values are calculated in planning and actuals fields. These rules affect the 
synchronization process between Microsoft Project and Project Management 
because calculations that work in one application do not necessarily carry over 
to the other application.

For example, reporting actuals in Microsoft Project is complicated due to its 
task reconciliation rules. Entering values into several actuals fields triggers 
automatic revisions of other planning and actuals fields. If you enter more than 
two or three actuals values, later entries start revising earlier entries in the 
Project. 

Another difference is the method of defaulting logic between Project 
Management and Microsoft Project. An example is the calculation of actual 
start date. Microsoft Project assumes that the task starts on the scheduled start 
date, unless the Project Manager specifically enters other data. This is because 
actuals are usually entered after-the-fact by the Project Manager. Project 
Management assumes that work starts when the participant changes the task 
state from Ready to In Progress. Project Management assumes that actuals are 
reported near real-time.

The most common Microsoft Project rules for planning and actuals fields are 
listed below.

Planning Fields

• Start + Duration = Finish
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• Effort = Duration * (sum of resources * units)

Actuals Fields

• Start = Actual Start (if known)

• Finish = Actual Finish (if known)

• Duration = Actual Duration + Remaining Duration

• % Complete = Actual Duration / Duration

• Remaining Duration is zero when task is 100% Complete

• Effort = Actual Effort  + Remaining Effort

Solutions for Project Managers
In order to give consistent behavior during synchronization, Mercury ITG 
Project Managers must:

• Synchronize only those actuals fields (such as % Complete, Actual Start and 
Actual Finish) that are enabled. See Enabling/Disabling Fields for more 
information about enabling fields.

• Synchronize these fields according to their defined priority order. See 
Priority Order for more information about the field priority order.

The Project Management - Microsoft Project interface ignores Project 
Management default values that are not enabled.

Enabling/Disabling Fields
To enable or disable actuals fields: 

1. In the Project Workbench, search for and open the project to be exported, 
imported or synchronized.

2. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.
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3. Click the Project Fields tab.

4. In the Activity Fields pane:

• Enable a field by selecting the appropriate check box in the Enabled 
column. 

• Disable a field by deselecting the appropriate check box in the Enabled 
column.

5. Click OK.

Priority Order
The following list of actual fields is ordered from the highest priority to the 
lowest priority for the purpose of synchronization.

• % Complete

• Actual Start

• Actual Finish

• Actual Duration

• Actual Effort

• Estimated Finish Date
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• Remaining Duration

• Remaining Effort

The priority order is the same for all projects. ‘% Complete’ is ranked highest 
because it is used prominently in the Dashboards and reports of both 
applications. Thereafter, fields that display actual measures take precedence 
over estimates, and dates take precedence over durations. Fields with the 
highest priorities should be enabled in a project more often than those fields 
with lower priorities.

Setting Up Projects
When setting up Mercury ITG projects for synchronization, Project Managers 
should:

• Enable as few fields as necessary that will accurately give visibility to the 
results of a synchronization, export or import.

• Not enable potentially conflicting sets of fields. (See below for potential 
conflicts.)

Avoiding Potential Conflicts When Setting Up Your Mercury ITG Project 
The following guidelines describe strategies for avoiding potential conflicts.

• Enable only two of the three Calendar actuals (Start, Finish and Duration) for 
a Mercury ITG project.

• Enable only two of the three Calendar estimates (% Complete, Estimated 
Finish and Remaining Duration) for a Mercury ITG project.

• If Actual Duration is enabled, then enable either % Complete or Remaining 
Duration.

• Do not enable all three duration actuals (% Complete, Duration and 
Remaining Duration) for a Mercury ITG project.

See “Troubleshooting” on page 294 for more information about unsupported 
fields and features in the Project Management - Microsoft Project interface.

Conditional Editing Allowed In Project Management
Depending on the synchronization mode that has been selected for a project, 
the project structure and task information will be controlled by either Project 
282 Integrating Project Management with Microsoft Project



Managing Your Projects (Project Management)
Management or Microsoft Project. Depending on the synchronization control 
mode selected for the project, some editing features in Project Management 
will be disabled. Information controlled by Microsoft Project cannot be edited 
in Project Management. The following sections describe allowed/restricted 
types of conditional editing in Project Management for each of the three 
synchronization modes.

• Editing Project Management Controlled Projects

• Editing Microsoft Project Controlled Projects

• Project Management Controls Actuals

Summaries of the conditional editing restrictions for each synchronization 
mode are listed in “Conditional Editing Summary Table” on page 285.

Editing Project Management Controlled Projects
When Project Management controls the project, the user is allowed to edit all 
information in Project Management. This includes changing the task structure, 
adding or deleting new Subprojects and tasks, and editing task scheduling and 
actual fields. 

Editing Microsoft Project Controlled Projects
When Microsoft Project controls all the project planning and tracking 
activities, the comparable editing functions in Project Management are 
disabled. The data that is distinct to Project Management and not shared with 
Microsoft Project can still be edited. This includes User Data, custom project 
fields and task references.

Workbench Interface
In the Workbench, Subprojects and tasks can be edited in the Project Plan 
panel in the Project Detail window, the Subproject Detail window, and the Task 
Detail window (when it is opened in the Project window or the Task 
Workbench). All the shared fields are disabled in these windows. 

Any function that could change the project and task structure is disabled. This 
includes the following components:

• Add Task button

• Delete button

• Indent/Outdent buttons
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• Move up/Move down buttons

Since scheduling can change dates and durations, the Schedule Project button 
is disabled. The state of the Mercury ITG Project cannot be changed in this 
synchronization mode; therefore the Change State is also disabled. The key 
shortcuts for these buttons are disabled as well.

Standard Interface
In the standard Project Management interface, the My Tasks Portlet and the 
Task Detail page will not allow users to enter task actuals. The My Tasks Portlets 
and the Task Search page still return the current incomplete tasks assigned to a 
user regardless of the control mode. This provides visibility to the project’s 
participants. The actuals collected in Microsoft Project are visible through the 
My Task Portlet.

Roll-up calculations are disabled through Project Management, whether 
triggered by actions in the Workbench, the standard interface or any other 
method.

Project Management Controls Actuals 
The ‘Project Management controls actuals’ mode is more complex than the 
other two modes when disabling fields. This mode allows users to change the 
actual fields while keeping the planning fields unchanged.

In the Project Plan panel, Project Detail window, and Task Detail window, only 
actual fields are editable. The planning fields are disabled. In the Project Detail 
Window, planning fields in the Subproject/Task table are also not editable. 

Similar to the Microsoft Project control mode, any function that could change 
the project and task structure is disabled. This includes the following 
components:

• Add Task button

• Delete button

• Indent/Outdent buttons

• Move up/Move down buttons

Some roll-up operations are disabled. Roll-up of actuals fields still occurs, but 
schedule fields will not roll-up. The imported values from Microsoft Project 
are retained. 
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The functionality allowed in the Shared control mode is very similar to the 
functionality allowed to a user who has been given only the Update Tasks 
Access Grant.

Conditional Editing Summary Table
Table 12-1 summarizes the allowed or restricted conditional editing in Project 
Management for each of the three synchronization modes.

Table 12-1. Conditional Editing Allowed in Project Management 

 Fields in Project Management Project 
Management 

controlled 

MSP controlled Project Management 
controls actuals

Project Plan

Structure fields Yes No No

Planning fields Yes No No

Actual fields Yes No Yes

Subproject Detail Window

Structure fields Yes No No

Planning fields Yes No No

Actual fields Yes No Yes

Other non-shared fields Yes Yes Yes

Task Detail Window

Structure fields Yes No No

Planning fields Yes No No

Actual fields Yes No Yes

Other non-shared fields Yes Yes Yes

Project Window

Add/Delete Task button Yes No No

Indent/Outdent Task button Yes No No

Move up/Move down Task 
button

Yes No No

Schedule Project button Yes No No

Change State button Yes No No
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Summary of Synchronization Behavior 
The following sections describe the behavior of a Mercury ITG project after a 
successful export to Microsoft Project.

The task structure and task names for the project in Project Management and 
the project in Microsoft Project will be identical. There will be a 1-to-1 
relationship between tasks, and tasks will appear in the same sequence in both 
projects. The exception to this rule is that the Microsoft Project project might 
not have a Master Project row. The synchronization will not create a Master 
Project row.

The resources assigned to each task will be identical. The predecessors and 
constraints will be identical, for the types of predecessors and constraints 
supported by Project Management.

If Project Management is collecting actual start and finish dates, then these 
dates will be exported to Microsoft Project. Actual dates take precedence over 
Project Management scheduled dates. Time information will also be 
synchronized.

If Project Management is collecting “estimated actuals” then this information 
will be exported to Microsoft Project. Estimated actuals fields deal with 
estimated time to completion and estimated time of completion. Examples are 
the % Complete, Estimated Finish Date and Remaining Effort fields. These 

Roll-up

Schedule fields Yes No No

Actuals fields Yes No Yes

My Tasks Portlet

Actuals fields Yes No Yes

Task Detail Page

Actuals fields Yes No Yes

Table 12-1. Conditional Editing Allowed in Project Management  [continued]

 Fields in Project Management Project 
Management 

controlled 

MSP controlled Project Management 
controls actuals
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estimates can cause Microsoft Project to revise the Task duration or schedule 
dates.

Scheduled start and finish dates for tasks without actuals will be identical in 
Project Management and Microsoft Project. Roll-up dates are automatically 
calculated in Microsoft Project, and can not be identical to those in Project 
Management. Time information will also be synchronized.

If Project Management is tracking task effort, then this will be exported to 
Microsoft Project. Microsoft Project will infer resource assignment units based 
on the task duration, effort and number of resources. Roll-up effort is 
calculated by Microsoft Project, but will be identical.

Duration is calculated by Microsoft Project based both on the start and finish 
dates and the resource calendars in Microsoft Project. Task durations and roll-
up durations will sometimes differ slightly between the two applications.

Integration with Other Mercury ITG Products
Tasks in Mercury ITG projects can include additional references to other 
Mercury ITG entities (such as Requests and Packages) or points of 
information, allowing easy access and visibility to data related to the current 
Task. Summary information for references is viewed as part of the Task. (See 
“Attaching References to Tasks” on page 100 for more information about 
attaching references to Tasks.) The following sections describe using reference 
types in Mercury ITG projects.

• Limitations on References

• Allowed Types of References During a Synchronization

• References Summary Table

Limitations on References
The Project Management - Microsoft Project interface supports most of the 
task-related reference types. Any limitations to supporting those references are 
described below.

• Creating New Tasks while Adding a Reference

• Task Updated by Request/Request Updates Task

• Task-Successor References
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Creating New Tasks while Adding a Reference
Normally, when a user adds a reference to a Mercury ITG project, that user can 
either attach the reference to an existing task, or the user might create a new 
task. (The user must also have the right security permissions to do so.) 
However, in the two synchronization modes where Microsoft Project controls 
the task structure, this is not allowed. References to existing tasks can still be 
created.

Task Updated by Request/Request Updates Task
A reference can be configured so that the % Complete of the Request updates 
the % Complete of the referenced task. In the synchronization mode where 
Microsoft Project controls the entire project, a reference of this type cannot be 
created.

Task-Successor References
References can also be created where a Request is the predecessor of a task. 
This can be either a finish-to-start predecessor or a finish-to-finish predecessor. 
In the first case, the task could not start (or could not progress if already 
started) until the request predecessor is completed. In the second case, this 
means that the task could be 100% complete but cannot reach the “Completed” 
state until the request predecessor is completed. Both types of references are 
allowed, but are not visible in the synchronized Microsoft Project project.

Allowed Types of References During a Synchronization
The reference types that are allowed during a synchronization are described 
below, along with their limitations:

• Microsoft Project control mode

• Shared control mode

Microsoft Project control mode
All types of references are allowed in this mode except for ‘Task Updated by 
Request/Request Updates Task.’

If a task that has a reference is marked as 100% complete but the request 
predecessor is not complete, the potential problem will be flagged as a warning 
in the Microsoft Project Synchronization Report.

Dependent references will not stop Project Management actuals from being 
updated by synchronization.
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References cannot be created during synchronization.

Shared control mode
All types of references are allowed in this mode.

When a task is 100% complete in Project Management but is pending a finish-
finish predecessor, it will be synchronized out to Microsoft Project as only 
99% complete. This ensures that any milestone successors of the task will not 
incorrectly be shown as complete. This correction will be noted as an 
informational message in the Microsoft Project Synchronization Report.

References cannot be created during synchronization. 

References Summary Table
Table 12-2 lists the allowed references during synchronization for each control 
mode.

Table 12-2. Allowed References During Synchronization 

Type of Reference Project 
Management 

controlled 

Project 
Management 

controls actuals

MSP controlled

Informational Yes Yes Yes

Task is the predecessor of a 
Request or Package

Yes Yes Yes

Task is the finish-to-start 
successor of a Request or 
Package

Yes Yes Yes, but not enforced in 
Microsoft Project. 
Detected during 
synchronization.

Task is the finish-to-finish 
successor of a Request or 
Package 

Yes Yes, but is 
sometimes 
synchronized as 
99% complete

Task Updated by 
Request/Request Updates Task

Yes Yes No
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Available Reports
Project Management features three reports that contain information about the 
Project Management - Microsoft Project interface:

• Microsoft Project Synchronization Report

• Unsuccessful Resource Matches Report

• Project Detail Report

Only the Project Detail Report is available from the Project Management 
Report Submission Workbench interface. The other two reports are created 
automatically during an import, export or synchronization. 

Microsoft Project Synchronization Report
The Microsoft Project Synchronization Report is created during an import, 
export or synchronization. The report displays in a separate browser window 
when requested by the user. 

Figure 12-1 Microsoft Project Synchronization Report
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Table 12-3. Microsoft Project Synchronization Report Parameters 

Sections/Fields Description

Synchronization Settings

Run Date The date and time the report was run.

Project Name The name of the Project.

Last Update Date The date and time the Project was last 
updated.

Project Manager The name of the Project Manager who 
performed the synchronization.

Microsoft Project File Location The drive and path of the Microsoft Project 
file.

Microsoft Project File Name The name of the Microsoft Project file.

Synchronization control mode The synchronization behavior selected by the 
Project Manager.

Resource Identification The type of name (either full name or 
username) given to new Resources created 
during synchronization.

Synchronization Summary 

Result Whether the synchronization was successful 
or unsuccessful.

Messages Information, warning or error about the 
export, import or synchronization process. 
Messages include a Message Source, 
Message Type and Description.

Unsuccessful Resource Matches Resources that were unsuccessfully matched 
during export, import or synchronization.

Successful Resource Matches Resources that were successfully matched 
during export, import or synchronization.

Trace Log A log of successful/unsuccessful processes 
that occurred during the export, import or 
synchronization.
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Unsuccessful Resource Matches Report
The Unsuccessful Resource Matches Report is created during an import, 
export or synchronization. It lists any resources that were not successfully 
matched between the Project Management and Microsoft Project projects. The 
report displays in a separate browser window when requested by the user. 

Figure 12-2 Unsuccessful Resource Matches Report

Table 12-4. Unsuccessful Resource Matches Report Parameters

Sections/Fields Description

Synchronization Settings

Run Date The date and time the report was run.

Project Manager The name of the Project Manager who 
performed the synchronization.

Microsoft Project File Location The drive and path of the Microsoft Project 
file.

Microsoft Project File Name The name of the Microsoft Project file.
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Project Detail Report
This report lets you query projects by their header fields. You can specify 
whether to include the following aspects of the Project:

• Custom fields

• Status

• Notes

• Activities 

• Packages

• Requests 

• References

• Transaction History

The Show Project Settings radio button must be set to ‘Yes’ to display 
synchronization-related information.

The Project Detail Report parameters are shown in Figure 12-3. 

Synchronization control mode The synchronization behavior selected by the 
Project Manager.

Resource Identification The type of name (either full name or 
username) given to new Resources created 
during synchronization.

Unsuccessful Resource Matches Resources that were unsuccessfully matched 
during export, import or synchronization.

Sections/Fields Description
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Figure 12-3 Project Detail Report - Parameter Fields

Troubleshooting
Microsoft Project supports many features that are not duplicated in Project 
Management. Some of these unsupported features relate to information that 
Project Management does not track or support, such as cost calculation, 
baseline tracking and earned-value calculations. When a Microsoft Project 
project is imported into Project Management, this information is not 
represented.

Information of these types is not affected by the interface. Importing the 
Microsoft Project project into Project Management does not remove this data 
from Microsoft Project. Exporting from Project Management does not create 
or default this data.

Other Microsoft Project features deal with the scheduling and tracking 
information that is synchronized between the two applications. In these cases, 
the interface converts the Microsoft Project data into information that Project 
Management can represent. The interface attempts to maintain the intent of the 
original Project Plan as closely as possible. 

The following sections describe problems that users might encounter while 
using the Project Management - Microsoft Project interface.

• Resource Calendars

• Units

• Advanced Predecessors
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• Advanced Constraints

• Calculation of Roll-up Values

• Microsoft Project’s Manual Scheduling Mode

• Scheduling Your Project in Microsoft Project

Resource Calendars
Resource calendars are not synchronized between the two applications. Since 
both duration and effort are a function of both start/finish dates and Resource 
calendars, the duration and effort values in Project Management and Microsoft 
Project might not match.

Units
Units are also referred to as resource load percentages. In Microsoft Project, 
each resource can be assigned to a task with a different load percentage (from 
zero percent to one hundred percent.) For example, the same resource could be 
assigned to two different tasks and have a resource load percentage of fifty 
percent for each one.

Since Project Management does not track assignment units, the load 
percentage of any resource imported into Project Management will not be 
recognized.

Advanced Predecessors
Microsoft Project has several advanced predecessor types not available in 
Project Management: start-to-start (SS), start-to-finish (SF) and finish-to-finish 
(FF).

Project Management cannot represent these advanced predecessors, but it will 
represent the scheduled start and finish dates resulting from them. During 
synchronization, these types of predecessors will be omitted from the Mercury 
ITG Project Plan. This can cause successor tasks in Project Management to 
incorrectly appear in a “Ready” state. 

To convert a project from Microsoft Project to Project Management, a Project 
Manager needs to replace unsupported predecessor types with a supported 
alternative - a constraint, for instance. 
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Advanced Constraints
Microsoft Project supports several advanced constraint types not available in 
Project Management: as late as possible (ALAP), must finish on (MFO), finish 
no earlier than (FNE), and task deadlines.

Project Management cannot represent these advanced constraints, but it will 
represent the scheduled start and finish dates resulting from them. During 
synchronization, these types of constraints are omitted from the Mercury ITG 
Project Plan.

Calculation of Roll-up Values
Microsoft Project allows you to choose between ‘automatic’ and ‘manual’ 
scheduling modes. The default mode is ‘automatic,’ and many users can not be 
aware another mode is available. When Microsoft Project is in manual 
scheduling mode, the F9 button must be pressed to recalculate Task grouping 
roll-up values and reschedule tasks. 

Microsoft Project’s Manual Scheduling Mode
If your Microsoft Project file is in manual scheduling mode and you did not 
select this option, it could be because:

• You created this project by exporting a Mercury ITG project from Project 
Management. The Export Wizard turns off automatic scheduling mode in 
order to have the task dates in Microsoft Project match those in Project 
Management.

• You opened a project that was in manual mode and then created the new 
Microsoft Project file. This caused the new project to inherit the manual 
mode setting as a default.

Scheduling Your Project in Microsoft Project
The synchronization process can sometimes stop in mid-operation because 
Microsoft Project displays a warning dialog. Microsoft Project is not 
completely consistent about when it will respond to a COM call with a warning 
dialog, so this cannot always be avoided.

When the synchronization process stops and the warning dialog appears, the 
Microsoft Project button in the Windows task bar flashes as a signal that the 
application needs attention. To continue the synchronization process, go to the 
Microsoft Project file and dismiss the warning dialog.
296 Integrating Project Management with Microsoft Project



Managing Your Projects (Project Management)
The best way to prevent the warning dialog from appearing during 
synchronization is to resolve all planning problems in Microsoft Project (such 
as violated constraints) prior to synchronization. You might need to manually 
recalculate the project’s schedule by pressing the F9 key before you attempt 
synchronization.
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 Appendix

Integrating Requests and Projects

Mercury IT Governance Center integrates issue tracking with project 
management using Mercury Demand Management and Mercury Project 
Management. Mercury Demand Management Requests and Mercury Project 
Management Projects and Tasks can be linked to each other through a variety 
of dependent and informational relationships. Utilizing these relationships, 
Requests can be folded seamlessly into a scalable framework of interlocking 
initiatives. Linking Tasks to Requests from Mercury Demand Management 
also gives instant visibility to detailed activities supporting an overall project.

This appendix covers the following topics:

• Referencing Requests from Projects

• Creating Tasks from Requests

• Dependencies Between Tasks and Requests

• Visibility into Tasks and Requests

Integrating Requests and Projects Overview
This section lists the components required to integrate Requests and Projects. 
These components are:

• Mercury Project Management, A Project Management System
Mercury Project Management enables collaborative project management 
for both repetitive projects, such as installing a new release of your HRMS 
applications, and one-time projects, such as developing a new e-commerce 
capability. With Mercury ITG, you accelerate project delivery while 
reducing your project costs.
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• Mercury Demand Management - A Request Resolution System
Mercury Demand Management is a Workflow-driven Request resolution 
system for business applications. It allows you to effectively capture, route 
and resolve business Requests. 

• Integration
Companies with both Mercury Demand Management and Mercury Project 
Management can create processes that take advantage of each product’s 
functionality. 

Referencing Requests from Projects
Requests can be linked to Projects through an informational Reference 
relationship. This is done from the References tab in the Project Information 
window in the Workbench, or from the References section of the Project Detail 
page. 

Figure A-1  References tab

Creating Tasks from Requests
Occasionally, a Request can be filed by a user that would be desirable to make 
into its own Task in a Mercury Project Management Project, creating for it 
deliverable dates and track-able actuals. Tasks can be created from Requests in 
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the Project Management Workbench. A Task created from a Request behaves 
like any other Task in the Project, save for that the Tasks’s % Complete and 
State are automatically updated by the originating Request as it moves through 
its Workflow. The new Task has the dependency relationship Task Updated by 
Request.

To create a Task from a Request:

1. Open the Project.

2. From the Project window, select Task Created From Request from the drop 
down list at the bottom left corner of the window.

A manager in a software company wants to create a Project that will track all 
of the bugs currently logged against a particular product. In the Workbench, 
the manager can search for bug Requests related to the product, and turn them 
into Tasks in the Project Plan. From there, the manager can perform any 
typical Project action, such as tracking the completion dates for each Task or 
monitoring triggered Exceptions.

You must be in the Project Management Workbench in order to create a Task 
from a Request.
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3. Click Add. 

The New Task From Request window opens.

4. To select the Request to attach, use one of the following methods:

• Select a Request number from the Request No. field.

• Click Search to search for Requests to add in a separate query window.

5. Click OK to create the new Task and close the window. 
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The new Task has been created from the selected Request and is part of the 
current Project. The Task is linked to the Request. 

Dependencies Between Tasks and Requests
The dependencies that can be created between Requests and Tasks are 
described in Table A-1.

For more detailed information on using these dependencies, see “Making 
Tasks Dependent on Requests” on page 303 and “Making Requests Dependent 
on Tasks” on page 307.

Making Tasks Dependent on Requests
When selecting dependencies between Tasks and Requests, there are many 
relationships to choose from. These relationships are set by attaching a Request 
to a Task as a Reference. This is done from the References tab in the Task 
Information window in the Workbench, or from the References section of the 
Task Detail page in the standard interface. 

Table A-1. Dependency Relationships - Requests to Tasks 

Relationship Description

Related to this Task (Informational) - Selected Request is related to the 
Task.

Successor (Blocking) - Action not allowed on selected Request 
until the Task closes.

Predecessor (Blocking) - Action not allowed on the Task until the 
selected Request closes.

FF Predecessor (Finish Finish Predecessor: Blocking) - The Task and 
Request complete together.

Task Updated by 
Request

(Auto-Updating) The Task is automatically updated by 
the selected Request. 
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Figure A-2  References Tab and References Section for Tasks

The following sections contain more detailed information on dependencies for 
Tasks created from Requests. 

This section covers the following topics:

• “Task Waits on Request Closure (Successor Relationship)” on page 304

• “Task Can’t Complete Until Request Closes (FF Predecessor)” on 
page 305

• “Task Auto-Updated by Request” on page 306

Task Waits on Request Closure (Successor Relationship)
This Relationship dictates that the Task state cannot change until the 
associated Request is closed. The Task will immediately move into a "Pending 
Request" state. When the Request is closed, the Task can be acted upon once 
more. This does not stop other fields from being edited. 
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Task Can’t Complete Until Request Closes (FF Predecessor)
This Relationship dictates that the Task state cannot change to Complete until 
the associated Request is closed. When the Resource working on the Task is 
finished with it, and the State is set to Completed (% Complete will be set to 
100%), this Task will move into a Completed (Pending Request) state. When the 
Request is closed, the Task is then set to ‘Completed.’ This does not stop other 
fields from being edited.

A software company’s Support Division makes the decision that no patches 
will be released without accompanying documentation. The company has an 
unfortunate history, however, of changing its mind about patches that are to 
be released, and numerous times there have been documentation changes 
made to accommodate patches that were cancelled after being initially 
approved. Patch A’s approval Request is moving through its resolution 
process in Mercury Demand Management. The Documentation team is ready 
to begin making changes to all documents to account for Patch A, and has 
created a Project in Project Management. The Project includes the Task Begin 
Doc Changes for Patch A. 

The Documentation Team’s manager creates a Reference to Patch A’s 
Request from the Begin Doc Changes for Patch A Task, with the relationship 
Successor. This way, the Task cannot be moved from its status of Ready to In 
Progress until Patch A’s approval Request is closed, ensuring that the 
documentation changes are valid and needed.
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Task Auto-Updated by Request
This Relationship is for Tasks created from Requests. As the Request moves 
through its process, it will update the Task with its status information. When 
the Request is submitted, the Tasks moves to In Progress. When the Request is 
completed, the Task is Complete. When the Request is cancelled or deleted, the 
Task is cancelled. A single Request can drive multiple tasks. If the Request’s 
Workflow has % Complete values defined, the Request will also update the 
Task with % Complete information.

A software company’s Support Division makes the decision that no patches 
will be released without accompanying documentation, including bug fixes. 
The Documentation Team wants to make sure that its documentation is 
accurate and complete for every bug fix that takes place. The last step in the 
company’s bug fix resolution process is a review by the person who 
originally filed the bug. A Request to fix Bug 62547 has been filed and nearly 
completed, necessitating changes to the documentation. 

The Documentation Team has a Project in Project Management, one of 
whose Tasks is Doc Changes Complete. The Documentation Team manager 
creates a Reference to Bug 62547’s Request, with the relationship FF 
Predecessor. This way, the Task cannot be fully completed until Bug 62547’s 
fix has been approved by the Requestor, closing the Request

.

Request Resolution Process

Final
Approval

Documentation Team Project

(Task Completed)
(Task Completed - Pending Request)

Bug
Fixed

Bug Fix
Request
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Making Requests Dependent on Tasks
Requests can be made dependent on Tasks. This is done from the References 
section of the Request page in the HTML interface.

Figure A-3  References Tab and References Section for Requests

The section, “Request Waits on Task Closure (Predecessor)” on page 307, 
contains more detailed information on dependencies for Requests set by Tasks:

Request Waits on Task Closure (Predecessor)
This Relationship dictates that the Request’s user cannot perform any 
Workflow Actions until the associated Task is closed (completed, bypassed, or 
cancelled). The Request will immediately move into a ‘Pending Task’ status. 
When the Task is closed, the Request can be acted upon once more. This does 
not stop other fields from being edited.

Since % Complete and Task State are automatically updated by the driving 
Request(s), users cannot update these two fields. The text “(Updated by 
Request)” will be appended to the Ready and In Progress states to indicate 
this.

A software company’s Support Division makes the decision that no patches 
will be released without accompanying documentation. The Documentation 
Team wants to make sure that any patch Request won’t close until the patch 
documentation is finished. A Mercury Demand Management user is assigned 
a Request going through the company’s patch approval/release process. At 
the same time, the Documentation Team has a Project in Project 
Management, one of whose Tasks is ‘Patch Docs Completed.’ The user creates 
a Reference to that Task, with the dependency ‘FF Predecessor.’ This way, 
the patch Request will not close until the ‘Patch Docs Completed’ Task is 
complete.
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Visibility into Tasks and Requests
Mercury ITG Center provides the following for enabling visibility into 
Request and Task integration.

• “Requests Holding Up Progress” on page 308

• “Project References Portlet” on page 308

Requests Holding Up Progress
You can search for Requests that are holding up progress on your projects. 
Each Portlet in the Dashboard that deals with Requests includes the field 
Preventing Action on Requests/Tasks. This field can be set to display Requests 
that are preventing action on other Requests or Tasks.

Figure A-4  Request Portlet Filter Page Showing ‘Preventing Action On’ Field

Project References Portlet
You can also view References related to your Tasks and Projects using the 
Project References Portlet on your Dashboard. Add the Portlet to your 
Dashboard and then personalize it to show the References that are relevant to 
your activities. The Portlet can be personalized to display References based on 
the following information: Reference Types, Relationship, time period when 
they were added, and whether or not they are preventing actions on Tasks.

Figure A-5  Project References Portlet
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